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Semester 1 

Modern Operating Environment and MS Office 

Learning Objective  

- The students will be able to understand the basic concepts of computer and related 
peripherals.  

- Develop the proficiency in routine use of a computer and all the related components of the 
same in terms of computer language, programming, etc.  

- The objective of this Course is also making the student understand the functioning of 
operating systems and network related components.  

-  

The course aims to train them in communicating efficiently in the workplace and professional 
contexts. 

Unit 1 
Introduction, what is a computer? History of Computers, Characteristics of Computers, Concepts 
of Hardware and Software, Types of Software, Evolution and Generation of Computers, Types of 
Computers, Limitations of Computers, Application Areas of Computers, Block Diagram of a 
Computer, CPU (Central Processing Unit, Bus Structure, input / Output Devices, Input Devices, 
Output Devices  
Unit 2 
Computer Memory, Primary (Semiconductor) Memory, Secondary Memory and Storage Devices, 
Computer Language and Software 
Unit 3 
Algorithm, Flowchart, Types of Programming Lan, Compilers and Interpreters, Characteristics of 
a Good Programming Language, Software,  
Unit 4 
Operating system, Functions of Operating System, Types of Operating Systems, Windows 
Operating System, Components of the Windows O.S., Running Windows Applications, Switching 
between Applications, Windows Accessories. 
Unit 5 
Networking, Introduction, Computer Network, Communication Modes, Data Transmission, 
Direction of Transmission, Data Transmission Media, Network Structure, Network Topologies, 
Internet, MS-Office, Modern Operating.  
References 

- How to solve it by Computer – R. G. Dromy  
- Fundamentals of Data Structures – Horowitz and Sahani  
- Introduction to algorithms – Cormen, Leiserson, Rivest, Stein 
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Introduction

As this is the era of information technology, it has brought a great revolution and impact in our lives.
Nowadays, Technology has played a massive role in solving social ills. Every technology has been
created for a purpose. Computer is one such technological innovation, which were invented in the
process of coming up with a faster calculating device, with each being better than the previous one.
Today computer has taken deep root in every individual's life. This is an era of computers because
computer brings revolution in almost all the fields.

,Imagining our lives without computers is next to impossible. Ubiquity of these machines goes to
lshow our incorrigible dependence on them. When computers were supplemented by Intemet, it
caused a great shift in the way we functioned. It ironed out several creases in long distance
communication. This gave an impetus to globalization, bringing the world closer and opening new
avenues to explore the human reach. As technology progressed, simple things such as shopping,
booking tickets, buying a new house, searching for schools and colleges, applying to the same,
researching for projects and medical information became a lot easier with entry of computers in

i"u.ry 
household.
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Computer being an indispensable tool in our lives, which has changed the way we think in many

more ways. Today, all you have to do to find answers is, just 'Google it'! The online world of
blogging, instant messaging, chatting and social networking not only leaves virtual traces, but unites

the world in a completely unimagined way. This powerful medium is a great mode of mass

communication which affects out thinking by allowing people a platform to voice their opinions and

discussions that have brought about a change in the world.

2. What is a Gomputer?

The word computer comes from the word compute which means to calculate. Hence, a computer is

nonnally considered to be a calculating device that can perform arithmetic operations at an enormous

speed. It carr be defined as:

A computer is an electronic device which processes raw-data to give meaningful information.

In the above statement, raw-data is the source data which needs to be worked upon to make it
informative or usable for the user. In the IT jargon it is called as Input. Meaningful Information is
the result obtained after the data is worked upon. It is called as Output. The term process implies the

work done upon the Input to get the Output. The computer processes the data as per the instructions
given by the user.

Computers can manipulate large volumes of data at very high speed and with great accuracy

according to a predefined set of instructions.

All computers perform the following five basic functions.

i. Inputting: The process of entering data and instructions into the computer system.

ii. Storing: Storing data and instructions to make them easily available for initial or additional
processing, as and when required.

iii. Processing: Performing arithmetic operations (add, subtract, multiply, divide, etc.) or logical

. operations (like equal to, less than, greater than, etc.) on data, to convert them into output.

iv. Outputting: The process of producing useful results for the user.

v. Controlling: Directing and controlling the sequence in which all the above operations are

performed.

Figure 1.1
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A computer system is a combination of dffirent elements which are as follows:

Hardware: Hardware is the term, which refers to all physical devices that the computer ls

made of (Electronic Circuits, Cables, etc.)

ii. Software: Software is the term used to describe the instructions that tell the hardware how to

perform a task.

iii. Data: Data are individual facts like first name, price, quantity ordered.

iv. Information: Data which has been messaged into a useful form, like a complete mailing

address.

3. History of GomPuters

The history of computers can be traced back thousands of years, to a device still used in many

villages and sometimes, to teach children to count.It was the Abacus, which was probably developed

between 5000 BC and 2000 BC in Asia. It was used extensively in China and Japan, and consists of

beads strung on wires or thin rods to aid counting. Experl Abacus users can perform stupendous

calculations with the Abacus, which explains why it remained virtually unchanged for thousands of

years. In historical terms, it is probably the most robust and most scalable version of the computer'

In 1614, John Napier developed a system of multiplication and division using addition and

subtraction. These were the famous 'Log Tables', a tabular representation of numbers that could be

used to perform calculations like multiplication and division on large numbers quickly. Using the

system of log tables, Napier devised a simple calculation tool called 'Napier's Bones' in 1617, which

consisted of specially marked rods that, when placed side by side in specific combinations, could

give the quotients of large numbers.

Using this system of logarithms or log tables, Witliam Oughtred developed the Slide Rule in the

1620s. The Slide Rule consisted of two movable rulers that could be adjusted to perform

calculations. The slide rule made a handy pocket calculator and was used well into the 1960s until

the development of small electronic calculators.

In the Seventeenth Century, two significant developments took place on the computing scene' In

I64j, Btaise pascaL developed a mechanical calculator to help his father, a tax collector. The

calculator used gears and cogs that could be rotated to perform simple addition. In 1694, Gotfied

Leibnitzdeveloped a better calculator that could perform multiplication and division as well. These

mechanical devices, while very useful, required precision engineering and therefore could not be

produced on a mass scale at those times.



ln 1821, Charles Babbage developed the 'Difference Engine' and in 1832, the 'Analytical Engine'.
These were significant developments in computing and the Analytical Engine is considered as a
milestone signifying the start of the computer age. To input data into the machine, Babbage used a
system of punch cards initially developed by Joseph Jacquard as a means of automating weaving.

The same input system was used by Herman Hollerith in his own tabulating machine, developed in
1883. He entered the machine into a competition to determine the best way to analyse data in the

1890 US census and won top spot in the competition. He began to develop the machine for
commercial use, putting his company through a series of mergers with other companies. The
company created by Herman Hollerith ultimately became "International Business Machines", better
known as IBM.

Figure 1.2: Time Scale in Developrnent ol Computers

2000 BC ---->The Abacus

1614 Logarithms Napier

1620 The Slide Rule Oughtried

1642 Mechanical Calculator Pascal

1694 Repeated Addition Leibnitz

1820 Automated Loom Jacquard

1842 Analytical Engine Babbage

1883 Punched Cards Hollerith

1945 Electronic Stored Program Computer



Gharacteristics of Gomputers

N Hertz), GHz (Giga Hertz).

Speed: This is the most important 
"f,"r*toiJi" of

l,f,:Tl_r]9. Computers can work at a speed of
m i | | isecon ds, m icroseconds ano nan o."ioii'o-r]' i. 

".,it is capabte of processing mirrions oi-iiii'ri,-"tion"
fl:'":?":11 Lg_"p:"9 is measured in MHzlMega

b. Accuracy: The resultsproor"J oy *ffio "[very accurate. Errors, if any, are produced due to
.l11t1v,oa1a 

or wrons set of instru&i",,r-ii,il r 
"y:::9 lpll .F siven, the output wirr' oewrong - GtGO (Garbige rn caruag;i5ui).

c. Versatility: Computers arelery -,rersatlle
machines, i.e., they can be used to perform a
::l"jtl^.:f tasks rangins rrom very siip['i;';",y
comptex..

Jhey can be used to perform calculations, typeletters, play music and movies, go.;u;;ai;, *itnother computers qcross the world,

d. Retiability: Computers consistently proouce
accurate results and hence are very retiabre.

!t9raO9; .Computers can store a large amount ofdata which can be accessed very fist whenever
i:lyigd .Data tike characters, nurbers, graphicat
rmages, etc. can be stored.

Diligence: Diligence is the ability of a computer toperform repetitive tasks with the same 
"i"riu"yconsistently, without tiredness. Untike humansl"l

::mputer doe-s not get tired, lack concentr"iion o,str_ow signs of fatigue. lf the same t"rr.-ii-E:uln tothe computer over and over again, it will 6xecute
the task with the same speed 

",iO "ir"-"""r*v.
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Goncepts of Hardware and Software

The term hardware generally refers to all the electronic and
mechanical components of the computer that we can see or touch,
i.e., all physical devices of a computer system that user can use to
manage and control the computer's operation, input and output. But
software comprises that instruction that tells the computer what to
do with the help of its hardware.

Computer is an electronic-device which does what the program asks it to do. Hence, it is important
to note that a computer cannot do anything on its own. It must be instructed to do a desired job.
Hence it is necessary to specify a sequence of instructions that a computer must perform to solve a
problem. Such a sequence of instructions written in a language that can be understood by a computer
is called a computer-program.

Here an instruction can be defined as a command given to a computer to perform certain operations
on the given data. Set of programs written for the computer is known as software. Software is the
general term describing programs, instructions (commands), languages or routines that makes it
possible for an individual to use the computer.

In a short way, we can say that software mectns a collection of programs which is used to perform an
intended task and whose objective is to enhance the capabilities of the hardware machine.

5.1 Relationship between Hardware and Software

Figure 1.3

In order to do any task, both hardware and software are necessary and they must work together.
Thus, there is a special relationship between hardware and software. Both are complementary to each
other. Without hardware the role of software is nothing and without software we cannot utilize
hardware. That's why this proverb is true that "Both the terms Hardware and Software are like the
two sides of a coin", which is very essential for using computer system properly. Thefigure 1.3 is
very much helpful to explain the relationship of Hardware, Software and the user. The user can
interact with computer with the help of software.

t-t"'d-""1
Software

User



6. Types of Software

As already seen, software consists of the instructions to the computer. These instructions specify

functions to be performed by CPU when it is executed. A set of such instructions is called as a

program and the process of preparing such programs is called as programming. A program is written

using a language. The language could be lowlevel language or high level language. If a program is

writien using trigh-level language, it must be translated to machine language before it can be

executed.

The nature and purpose of various programs written divide software into two categories, viz. System

software and Application software.

It is a set of programs used to operate and maintain a computer system. The development of such

software requires a thorough knowledge of programming and specific hardware.

Example: Operating system, Utility programs, Language translators, etc.

It is a set of programs, which perform specific tasks required by the user. Such programs are

developed for satisfying requirements of a specific user or an organization'

Example Word Processors, Spreadsheets, Accounting and Database packages, Desktop publishing

softwares. etc.

Word processor rating systems

Soreadsheets Assemblers

Database systems Compilers

lmage processor Utilities

Figure 1.4

:lTwo 
types of computer. -

i- System software
ii. Application software
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Evolution and Generation of Gomputers

' 7.1 Evolution of Gomputers

The evolution of computers can be better understood by discussing some of the early known
computers:

i. Mark-I Computer (1937-1944): It was developed in collaboration with IBI\,I by lloward A.
Ailien of Harvard University. This machine was also known as Automatic Sequence
Controlled Calculator as this was the first fully automatic calculating machine.

It was an electro-mechanical device, i.e., used both mechanical and electrical components. It
was 50 feet long and 8 feet high and used over 3000 electrically actuated switches to control
its operations. The machine could perform five basic arithmetic operations including table
reference on numbers as big as 23 decimal digits.

The machine was very reliable, but very complex in design and huge in size.

ii. BNIAC (1943-1946): ENIAC or Electronic Numerical Integrator and Calculator was the first
among all electronic computers developed at the University of Pennsylvania, U.S.A. by John
Mrutchly and his team. ENIAC was developed because of military needs and was used for
many years to solve ballistic related problems.

ENIAC had a size that occupied the wall of 20X40 square feet room and used 18,000 vacuum
tubes. It was much faster than its previous machines taking only about 200 microseconds to
multiply two numbers.

iii. BDVAC (1946-1952): EDVAC or Electronic Discrete Variable Automatic Computer was
developed using the new concept of stored programs. This concept was introdtced by Von
Neumann. He also introduced the concept of storing data and instructions in the binary form
instead of decimal numbers or human readable forms.

The motive of developing this machine was to overcome the shortcoming of ENIAC. ENIAC
had programs wired on its board which made it difficult to change the programs. But Dr. John
Von Neumann's concept helped in overcoming this problem. His idea suggested that a
sequence of instructions and data can be stored in the memory of a computer for automatically
directing the flow of operations. His idea greatly influenced the development of modern
digital computers as it provides the ease with which different programs can be loaded and
executed in the same computer.

iv BDSAC (1947-1949): EDSAC or Electronic Delay Storage Automatic Calculator (EDSAC)
was developed by British almost at the same time of the development of ENIAC of U.S. It



took 1500 mieroseconds fr.r addiliiw. o1lrr:1.i.:ns md mr-rltiplication took almost 4000
lnie rosecclrc:.

flhe maciune was devcleiiled at l.he Ciiulhnidg€ [-ir.i;i,r,:l':,,ii"t ny [,rofesscr Msurice Wilkes and his
6saxr1.

v" UNII/AC I (1951.): {,'}lMC crr Tl-le i-l'niversal Autonratir. Computer, as its name suggests,
was the first digital eo'rnputer to ire prr:duo;e'J universal}"S,. It was not the "one of a kind"
rnachine. It mark"ed tlre amival of i':ntmerciiiliy available iigital cornputers fbr scientific and
business applications. UNIVAC I was the first computer to be used for business by General
Electric Corporation (better known a:l Cil Corp} in i954. The firsr {jNIVAC I was installed in
the Census Bureau in l9-5 I and was continuousl.'/ usecl for l0 veans.

In i952, IBM introduced the IBN{-71)1 cornrnercial cornpN.rter, I-ater on, rnany
versions of UNIVAC tr and other 70O-series machines ,,rrerc il.i.tri.rduce{i.

improved

+"*q'i2
7.2 Generations of GomprEters

The term 'Generations' in cornputer inclustry ref'ers tc the :t:i.1i;;
developments in technology {both hardware and software). ;tr. hiiei
discussion regarding the First to Fif{h Celr*raiioils cf c,:l-t'lFl;l.:iii
foilows:

i. First Generation: The first generati,:n *f coilipuierl w:ls ';harir:terized by us* of vacuum
tubes for electronic components anci use of euher Llathode ll.ay Tubes (CRT), acoustic delay
lines or ferrite core ftlemory" Assernbly language was used for programming and fixed-point
arithmetic for calculation. The input output media were the Card Reader and the Punch Card
respectively.

Professors Mauchly and Eckert developed the ENIAC (Electronic Numerical Iritegrator and
Calculator) in 1940. This first 'all-electronic' computer with 18,000 vacuum tubes, occupying
15,000 sq. ft. of floor space and weighting 3C ton was a thousand times faster than it's electro-
mechanical predecessor. Its specific application was for ballistics in the U.S" Army ENIAC
which was followed by UNIVAC 1 (Universal Automatic Cornputer) developed by the same
team in 1951, which proved its capability during vote counting in the Presidential elections"
IBM 650 was designed as a logical upgrade to the existing punch card machines, in 1954.
Other exarnples of first generation computers are IBM 700 series. tsDVAC, etc.

Disadvantages

i. Too bulky in size with each computer using more than ten thousand of vacuum tubes.
Hence, these machines require large space for installation.

ii. Air conditioning required as vacuum tubes emit large amount of heat.
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Power consurnption too high.

Frequent hardware fa l lure, constar f in;t i fl tq:rlar l',:e

Non portable.

Manual assemfil -r- of i nd i "o rt'l tr iil,;lrul$lnfl ri l$ "

r':eJrrited

Figure 1"5: Vacalurn Tuhe

Second Generation: The second generati<;'n of computers was characterized by the use of
transistors for electronrc components, feirite cores for main mernory and rnagnetic
disks/drums/tapes for secondary memory. HighJevel languages like FORTRAN (1955),
COBOL (1960), ALGOL(i960) were used for programming and floating-point arithmetic for
calculations. VO processors contrrrlled inpuf - output operations and relieved the CPI-I
(Central Processing Unit) from time consurning routine tasks. Since the computers couirl
handle only one task at a time, they were used as Stand Alone computers.

Some exarnples are lBlvt 1620, IBM 1790I & il, Control Data Corp's CDC 1604, Digital anc{
Data General Corp's PDP - 1,5 and 8 (Frog,r'ammed Data Processor) series of rnini,
computers.

Advantages

i. Smaller in sizc arrd less cx[rr31s11g as conrpared to i" gerreration computers.
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ii" lv{oi:e reiiable, less }le:ai _Eenerar*rl.

iii. .l.,ess hat iio';,: ri.'{; ; lr,i1',-:, be,o.{.*r pi,ir:i r-rii rtl,'.

iv. W,:re ffiore ihan tel riiT;r,s i::.s;er thail tn; flri.,i g:n'.:,reiion ;raciunes.

'1. 'i.r'A.iiSiSilitlt C(itr:iatrne{i i,irite;S'* ('}iir:: 'ipflth t]te or:,tret ,-,,;: i,l.t :.:,i{..ii b}, "l tUbe.

vi. T'he secondary storage was mticii iarger and taster rhan ihat or their predecessors.
vii. These were eilsier io plcll]{aln ,i,irj ri.s"? a.rrr,i hsnaa haci ,r wl,jer reach cornrnerciallv.

ilisedvantages

i. Air conditir:rning required.

ii. Frequeni ii'rr;tnlijriilnce requitil.
iii. Manual as;ieunbly of rndividual r:i:irip.or;rl;;ts.

l:'- a.'.

Figurn i.S: fremsistcr

Third Gener"ation: T'he third gcneraticl ot' courpurers was characterized by the use of
Integrated Circuits (Itl) as CPLT componenrs and RAM/R0$,I seiniconductor rnemories of
(Srnall Scale trntegraticn (SSI): 1OfJ Cornponentsrchip, Msdiurn Scale Inr.eglarion (MSI): 1000
components,1chip and LSI: L.arge Scale Integation). h{agnetic disks / drum / tapes were used
as secondary memory. Cache mernory and virtual mem.lry were introdr-lcecl to further improve
the efficiency of the CPU. Conrprehen:sive Operatrng Systern that ir:clucled support for
multiprograrrrming, multiprocessiag anC rnultipror:essors as well as tirne-sharing, lvere
introduced. The einphasis shifted to sqftw'are and punch card s,vsterns were totally eliminated.
High performance printers were intrcduced, on-line and data enfv terminals and usase of
large on--iine stc,rage, larger fixed disks flourjshed.

Sorne exa:nples are IBM 3?0 scne:i, {jf_}i ".- "i rjO{}, FDp - I i " eic.

Adv*nwgcs

i. Smaller in size and more powerful as compared to 1" and 2nd generation computers.



lv.

More reliable and easily affordable than 2no generatiolr.

Less heat generarcd, iess hardrvare failurc"

Less maintenance cost.

Easily portable.

Had faster and larger- primary and s*canda.r"y i\to{ap;e as "r'.imFi.r-ed to its prccl*cessors.

Disadvantage

Highly sophisticated technology is re.quired frrl lhe i*iarilif?cturiilg of l{,1 chips.

Figure t.7: lC Chip

Fourth Generation: The fourth generation of computers is characterized by VLSI (Very
Large Scale Integration: > 6,000 components I chip) for CFU a.nd memory, cache memory on
CPU chip, highJevel programming languages like BASIC, PASCAL. This generation also
offers extensive support for networking and database management systems for organizing and
accessing large collections of interrelated data. However, tllese computers cannot 'speak or
listen'. They have to be programmed and can process only structure tasks. This is an improved
version of the third generation computer.

Some examples are IBMI PS -- 2, WIPRO I-ANDMARK 860, HCL MAGNUM with 68030
CPU, CRAY - Y - MPC, HP - 9000 series, etc. fhese are the present day computers.

The characteristics features of fourth generation computers are as follows:
i. They consumed much less power than third generation computers.

ii. They were more reliable and less hardware failure than tliird generation compnters.

iii. They were totaliy general-purpose machines.

iv. During the fourth generation period, the LINIX operating system and the C
programming language became popular.

v. They had faster and larger primary and secondary storage as compared to third
generation computers.

vi. Graphical User Interface (GUI) enabled new uses to quickly learn how to use
computers.



vii. [.lel'.r,:t :i c,.trrip;,rcr's *nabied i;hi,iirrg ;:f r;;iti,lrces iike ciiskg, printers, etc.

viii. The PCs of the iburth Seneratinrn made cornputers affordable even by individuals for
rheir personal use,

v. Fifth Generation: The fifth seneratiorr cornpriters characterized by ULSI
(Ultra I-arge Scale *:regr*tro::: cile rrriilicur corrlpor"lents I u[ilp) chips are still under

cievelopment in USA anci Japan. This generatron will differ from [tte eariier four generations

of cornputers in the basrc ituuctrrre aiLr1 *slgrr, 1.e., the earller generetions tlsed the Neumann?s

sfmcture where li1 e pioccs$or exijcutes si.:r',1:ii,,$ ri:ls:nretic;trs ttl a sequenee, while in case of tbe

fiftli generation ot- c&mpurers, dai,il wil! f[**: :iri",jrrr"]i gfuL: pred:*sstng units (distributed in the

c{!mp*ter) activating eaeh of them as and wherl requlred"

'fkr* appllcations ,ir,i'rtiis generation includes Simulation, multirnedia, Virtual Rezrlity.

Chara$eristic leatures of fifth-generation are as follows:

i. fleskt,:rp Ft--s arc several times more powerful than the PCs of fcrurth generation.

ii. Portat*le P{-s {rrctebook computep-c) are rnuch srnaller and handy than the PCs of founh
generation.

iii. T'hey consurlrr. mnch less power than fourth generation computers'

iv. They are totalF-v p.eneral purpose computers.

v. fhey are more reliable and less hardu,are failure than fourth generation computers.

vi. Use of standard high level languages allows programs written for one computer to be

easily ported to and executed on another computer.

vii. They have faster and larger main rnemory and hard disk than fourth generation

computers.

viii. Newer and more powerful applications, including multimedia applications, make the

systems rnore useful everywhere.

ix. Many of the systems of fifth generation have hot-pluggable feature.

x. Today, we have a computer for almost any type of user due to so many types of
computers in all price ranges.

The swb systems of this computer would' be

a. The hardware system consisting of the CPU, memory, etc.

b. The software system consisting of the operating system (written in PROLOG language

which is an intelligent software using artificial intelligence (AI) to make logical

inferences).

c. The user interface wherein the cornputer will interacUtalk to the user in a natural

lahguage (like English) and listen to tle commands in English.
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Types of Gomrputens

,i ',irr;rrrters can be classified based c,r, tt'ietr 7it wtciyi,es af op'trtttirttt

t,,, rh*:ir canfiguration. By r;onfiguretiofi, we rneiln urc srze, speed

.' , 'ir,,ii cor/iFutation and storage capacity of a comput,:r.

: ,,;,1:;i.l of- Computers based on Frirlciples rif Operation

"{'*'Lrxe are three different types of co{nputers according to the

;,,' rrreriples of operation. Those three types crf computers are:

Digilal

Figure 1.&

Analog Computer: This is a computer that can process analog quantities/data. Analog

computer recognizes data as a continuous measurement of a physical property. It performs

computations (like suinmation, multiplication, ini:gration, solving of differential equations.

etc.) by manipulating continuorrs physical variables. The results grven by the analog

ccrmputers wiil only be approximate since they deal with quantities that 'rary continuously. Il
generally deais with physical variables such as voltage, pressure, temperature, speed, etc. Th€

output is graphically represented (usually on a plotter.)

tligitat Computer: This is a. computer that can process discrete quantities I data. Digital

Computer represents data as numbers. The computation is done in a finite number system with

rlata in the form of biriary digits (bits) 0 or 1. A group of 8 bits is called a byte. Most of the

present day computers are digital. Digital Conrputers can give more accurate and faster results.

Digital cgmputer is well suited for solving complex problems in engineering and technology

Hence cligital computers have an increasing use in the field of design, research and datz

processing.

Based on the purpose, Digital computers can be further classified as,

a. General Purpose Computers: General purpose computers are used for any type or

applications. They can store different programs and do the jobs as per the instructioru

specified on those programs. They can process business data as readily as they procest

cr(
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complex mathernatical formulas. As they are so vensatile, most business today use
general purpose computers.

b. Special Purpose Computers: Special purposc c{.\rnp!.rter is one that is designed and buili
for a specific application. The program for solving the problems is built right into the
cornputer. For example, special purpose computers may be designed to process oniy
numeric data or to completely control automated rnanr.lfacturing processes. They often
used as training simulators.

Hybrid Computers: This ls a compulter system that corrlbines the desirable features of both
analog and digital cornputers. The digital computer acts as a controller and provides logical
operations while the analog computer generally solves difterential equations" It is rnostly used
for autornatic operations of complicated ph;;sical procc:sses and machines. Hybrid cornputers
are mainly used for specialized tasks. Such a system finds application in areas of missile guide
system, space-crafts and scientific research applications.

Types of Gonnpqters based on Gnnfiguration

There are four different types of computers when we classify thern
based on their performance and computing power. The four types
are

Micro computers Mini computers Mainframe computers Super computers

Figure 1.9

Micm Computers: A micro cornputer is a low cost, small, digital computer. Micro computers
are considered to be of two types -
a. Personal Computers (PC): They are desktop or portable computers that can run simple

programs such as word processing or spreadsheets" Personal Cornputers come in several
. sizes, such as laptops, notebook computer. poeket computer, PDAs, etc.

A laptop is a portable computer and looks like a briefcase. Their portability and capacity
to operate on battery power have proven ro be of great help to mobile users.

8.{
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A notebook comput€.r is also a portable cornputer th:li ir ror:ghl,v the size of a fhiek

i not*book. They fall in the categ<;,ry of laptop.c, hllt ar: !r!i.:;'rensir,e anct relatively
smaller in size.

Persi:,nal digital ns,sistants {PDAs}, or personal comrrunrr"!i,-,:3, ar}f;ularly krlown as a
palmtop are srnall, pen-controlled, handled computers.

b" Workststfows"' 'Fhese e"re more expensive, powerfl;l .rirorhic*:, '*,'riih ;.helr processor
speeds almost lC times that of PCs. These are the type lf ,ri.]firp.rr'rers used for
el:ginei:ning applications, desktop publishing, sof,trvare deveit',tr,r+r:t.., ,:,:ij other rypes of
applications that require a moderate amount of compufing pc't\.;r .rn;i relaiively high
q.r:;ility graphics capabilities. Workstations are desklop cr-;mp:i{.crii, burr rnore powerful
than pe:,:sonal connputers.

"['he ieading ruaqufacr"urers of workstations are f{F, n}NI, -s"tJNi Micrc,:y,:tr':ii; ;end {Jonapaq.

Wfu
ifforkslati0n Laptop

F!g*r*'!"'10

IVlinicomputers: Minicnlmputers are also known as nrirlirrrrge cornputers as their cost and

computing powers lie in the middle of micro computers and mainframe computers. They are

special purpose computers with a powerful processor. These types of computers are widely
used in large rn:nrfnccuring organizations for Distributed Data Processing. They are

expensive and with a iarge data storage capability. In multiuser environment, a mini computer

cail ;iupport, ilpt* 6"1. ro 1{}0 tr:rninals. Mini computers are used for mnltiuser and interactive

applii;tiors in universities, research organizations, banks, government organizations and

industries, etc. Their application areas are very wide including payroll preparation, accounting
ir:trs aud ".cicntific conrputations.

Example: VAX by Digital Equipments Corporation (DEC).

hlainframes: Mainframe computers are more powerful and faster -computers than mini
computers. They are general purpose computers with a large area of applications. The word
"mainframe" probably comes from the metal frames, housed in big cabinets, on which
computer's electronic circuits were mounted. Such machines are typically operated by
professional programmers and technicians. Mainframes can process several million

rahNeiDesktop FEA
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iltsiit*ir',licuts p'e:r secOr,rl. I-arge Olgmrrzations nse fht:S:: Sy:ctelns tr: L:andle a llrg,er ruri,nbc,: if
insr':uctiorrs and a large amount of i.iata '"llhese niaohines trc v'er! uig in slze i:is .!i-.,uc t: 

"roolil);.1'r:i.lre rr;irinl',: ttsed. for cxtensive applications hke rrr aio:'ll'rre,q!;tirr,s, r")iuri-i. jr:[t';{,,.rnL
{lern:parfies ete.

firaruplc: IBll"s 5/390 rnachine.

Figure 1.11

ij,:l;:'.,rr,',.'.1r 1'r;lttrsi'fhcse, are, tlte most powerful c<lmpuuers wfrieh rr r.rt, [n]c r;apatriti{y ti
L,t{}cess!,fi; {ila{ly Erograms concurrently (Parallel prcce:,silr59)" Thesc l;.r.rrputt.c;l; ,qon.cist c,i
l,|rrrusaqi,i.; r,i lntr:griateci uricroprocessors which operate in palrr.]ni:l rro {riilkt ltl faster" T'frey are
'rtsed firi 161"g5s;8 dara processing arrd solving very snphisticatecl pintll;ic,ru.s. iiuL,j-,Ln ctrnuoultr-,r

il!*is atij rirosc w[ro ri*t---rl to model complex phenomena. A stlpc,r'corrrpu'ier ls typrc:liL'y ,irsl'..{i fo,r
srier'ititjr: aud enqineerir"lg applications that must handle r,,ery ilrge ,ciaiirh.i.qes !,rr tc, a. gr{,fl1
:lmollrrt {if'r:ontplrtation or both, as weapons research and devt;krprlrftr-{!t, $iird.litri.r Jr;ri;.1 ;.;iir.g.
qric:ke{iqig, in a.erodynarnics, seismology, atomic and nrrcletr reseiirr:h, err: ji'he lirst t-rav
silpercf,rTiputer was introcueed in l9'76 - the cray-1.

Exutnple; Y * MP/ C_90 by cray Research Inc., PARAM supercomputer by C-DAC (In<iia)

Figure 1.11
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I! frl itpltter is not an "intelligent" devlce, i.e,, i[ hras no []rinFitr or ,Cecislon making
rapahilitv" Hence, it has to be given each and every instruction in onrer tl *e$lirnr a r:rsk.

A comuuter cannot detect and recti{y effoneotrs instroctjo:ls c,fi ns *wn. Hence, erlery
instruetinir must be correctly specified.

"["hr'rr-peliilicies of a eomputer, if put to gnod use, r:;ln Lre vei.v ]rerrci'rr,;':i- i:ilwei,er ii:ey uun
('ilLr: i r lot ofr danrage if used unwrselv.

:,r-. ui i 6 ; $ t,i; a & $.qx I t Ar erx gi w'f €, m rqn p e.# $, # tr i:;

i omputers are alnt:,sl ;.lletul in all areas" Few of the areas wherc eomputers areplr,i;rrninanil-y' fJ{.lxity

r'sed are: as fbllows.

i" Iltmks ii" Compani*:r

rii Insurance cr:mtranies ir'. ()ffic,e'::

,,{, S.l*:,Fs vi Railwayi

\i!!. ,:'rfp{}111t ,'tH .-rcfiiteCtrtfe 4

ix" Educaticrr x, Spar:e researr:lr

xi" Scientitic research xii. Share rnarkets

xiii. All pure and applied sciences xiv. Electricity offices, etc.

"fhe viu ier1, af funttions, wkich tan bc rnanagetl smoothl;t using a conxputer, are os Jbllows.

i" Accounting ir. Costing

iii" lhrdgct"rnl iv. Planning

v. Scheduli'r! r,'r, Staffing

vii. On line prccessing viii. Typing and Editing

ix. Calcuiations x. Reports generation and preseutatiorr

xi. Data analysis and comparison
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fAaLAqll_.?M l. What is mean by Hardware and Software?
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[gqf.t!.4pr-1-r -:4Ml l. Explain thecharacteristics of Computer.

IQqt.?CIlgi-*4-[dl 2, Explain Generation of Compurers.
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S. f;mtrsduction

Ccrnputers bi' now are ublquitous and are userl in almost all spheres of life. Computers chech otir
your grcrceries, pump your gas, tlispense rrtoney at the A"Ilv{, tum the lieat on and off, anci collti-ol the
wity your car runs. They're everywherel It is ctrear that computers affect our lives in rnany warr,s Lt]'
increasing ailn efficiency and enhancilrg our abliities. Cornputers have become an integral part of olrr
life antl society, their applications ranging tiom business transacticrns to personal ccrrnniun;catiurns"
As we have discussed a lot of computer in previous chapter lets stuciy the functional biock diagram
of colnputer in this section:

t?t" tr$lock Diagi-am eif a Gonrputer

{luurputer catr tre defined as an electronic device which acceBts data as input, process it, and gives
back rneaningiutr inforrnation as output. A Computer consists of nurnber of cornponents ol units
u'hich are inter-connected to each other and corninunicate am$ng themselves to accomplish a task,
Tklr. various components are as shoi,vn in the followirrE diagram.
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Figure 2.1: Basic biock diagrarn of digital cornputer

Digital Cnmputer consists of tcllowiltp-; rnain components

{. Input unit

The lrLput urtit perJbrrns the fitik,tving inajor functions:

a. trt accepts ihe data and instructions from ttre outside world.

b" These instructions and data are convei'ted into ttie form acceptable by the cornputer.

c. it supplies the conve'rted ir.rstructions and data to the syster-n for further processing

Far etxsvnple" Keybi;ard, Inouse" jtystick.

ii. Outpurt unit

The Output unit pe(orms tlrc jollowing rnai*rfuft('ti{in:r:

a. it accepts the ;esuirs prr.rduced by tiie compriler whiclr are in cocied form and hence caru

not tre easiiy urrdersto.Jd by us.

b. lt converts ther;e coCed resuits into ihe human reaclabie form.

c. ll supplies the convefied results to the outside world.

i:.or example, Vrsuai Disptay Unit (VDiJ) or inonit,:;:, printer, plotter.

T--;.:;;."-.i

" i',ara _j 'jll;' l-_Programs *"-'--i---- -
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,'li Storare Briit

Th-:;'-tea of the cufirputer which is responslrble to receive. hcld and de;ver rlata as ne,
ili.-.;.ii.l,1orrs" It stores cata in trinary forinat, i.e., iu the sequen,:e ci 0 ann [.

Tkt .tih:tege wtit pe$ornts tlae follow:fi.g rn$ar Junctions:
a. .Lt stores the data to he processed and the .instnlcrions requue<i fbr the prrrcessiug.
pt. dt :;torr:s interuneCiaie Eesuiis of processing.

c. trt:;tcrr:s fjn;rj rr',ults c[pri"oce*esipg Lr*fore these i,_r:,q]lis are 1ctcaseC tf ?it oiiii.]ut rle,iir,f,.

,:rorage tinii arc of two types: Primary Storage and Secondary Storage.

ilri,pmor I 1ltrtrage

a" rl ,r: r-itliC i-o sil).[e prieces ufl prcrgra:li rnstrur:tro'.rs ancl d;lht, in{.erm-:i]iatc res;u1s *r
Frucessing, and iecently produced results on which computer is currently working.

{}' },i'riirmry Storage can hold infonnation only while compurer system is on. As soon as the
aoffnputer system switclrcs off or resets, the inlbrmation held in primary storage 1s
n:riilleel"

(,, I'[le sire of this rnein,']ry is cornpaiiatircil,nlucil slri;r,ilier than thaf of s*con<iiuy i]leiftdir,
bart tlre cF{-I cor-nmunicates direr:tly with tliis menrory a.t a. high speed.

, lt is l.:r'y e;(perlsive.

'.' {t rs cf two types: RA}VI and ROM.

I. ROM (Reod Cniy fvfemory): Tke LIF{.I can on.ly rcad its c*ntentu;. Ferinanenrr
informatiol"i es str:led here It is non-v';'latile. The i:rrost ir.nu*rtant pnlglra.;r:n cr{'
ROM is the Basic Input Output Svsrtern (B{OS} which actiyates rhe laidvy;ra"e {.r.r

cornmunicate with the system and the appliaa.tir:rr sof.iivare.

2" RAM (Random Access MemorT):"lhis is read/wri'"e mernory, wtrich is used fo,:
user data and programs. lt is volatiie. i.e., ciata is lost as sclorl as tiie pclwer is
switched off. 'fernpor:iry rnforrnati*n i:, 1;1n6qrj, [,i.-re

',1.' 
. 
1 r',':, px,la,s v S ttt rc g e

a' {t ls aiso ilnown as Auxiliary storage which ls used to store data permaneptiy, iiqr,-.ll thc
data wtiicir the corliputel systetn is not s'"nreirily working oll, but irec{is tt ii;l}d ttre,tli ir:i.
i;r.ocessing trater.

l:. it can retain inf<rrm.rtinn even rvhen a com.r)uter system switches off or rcscts.
.. {t is less expen;ive {har; prirnary rnemory.

cl. 'l-his mernory oper.ttes itl. a .omparatively siovu speccl but is capable of s{oring- large
volumes of data.
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e, F'or example, trlcippy disks, rnagnetic disks, magneti(r tapes and compact disks, DVD,

'i'he krpur. Gutpr,l t,iiiils i:i;d Sec*liiar:/ in,{eillor''f are ca}leul prriph.r:r* tlevitcs

Ai'itlimetic iln$.|-,tr,gic iurdii 1Lrr,t)i: tierc tlie rctuai processilig tlf instructions iokes place
during ttrr proces,rur; or r-i:1* liltr-r lnfor.rr;a,ticrn" Ai-,U is designed t': perfilrm calcuiatitns like
a,iiditiori" sui;iracri,t'1,. iirrr ili'!r-allir:rir. auq-! i!iilision anr,i logical operatlt:ns or c+mparistuls iuch
as less rh.an. great,:r i.h.r"n crr rqusl to.

Control unit: This unit co-ordinates and controls the activities of all units of ihr: computer"
Aithough rt does nl":t pedofin any actuai processing on the data, it acts as a 'Centrol n€rvous
system' for other components of the computer system. trt manages and co-ordinates the entire
computer syliteril.'ille inain f,i.ulctioris performed by the control unii are:ls follows:

a. lt obtains the instiuctions stored in the inen;.cry unit.

b. trt understands the received instructiens

c. It ensures that data.reaches the correct place at the correct time.

d. It brings the next instruction after the previous instruction has been executed.

"lrJr GPU (Gemtnafr Frocess&mg Uuttrt)

Control Unit and ALU of ccruput{:r system are jointly larown as the CPU. The CPU is the brain of
oOmputer sy$tem.

The computer system receives the data and instructions through the input device. It transfers them to

the prirnary storage througtr the cr:ntioi urrit. Control unit fetches the data and instruction from RAM,
determines if it needs to be processed upon, sends it tc the ALU for processing, fetches the result and

stores them back into RAivd. The output stored in the primary storage is displayed to the user through

the output device as dilected by the c:ontro.{ unit.

Although the control unit does not perforrn any actuai processing of data, it works as the controi

nervous system for all the components ot computer. It has some special purpose registers and a

decoder to perfornr these activities.

Regtsters: The instruction registers and progrant control registers holtl the cunent instruction and

the next instruction, to be executed respectively. Hence these help the unit in instruction selection.

Ilecoder: it has the required circuitry to decode and interpret the meaning of every instruction

supponed by the CPU"
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3.{ Types of Processors

i. CISC Processors: CISC stands fbr Complex lnstruction Set

Computer architecture. CPUs with CISC can handle large

instruction set, variable-length instructions and a variety of

addressing modes.

Employing more and more instructions in the CPU makes it easier to translate high-levt

language programs to machine language and ensures their execution more effective. Additio

of more instructions makes the hardware circuitry more complex'

Also, to optimize the CPU memory, designers packed more instructions in memory by usin

instructions of variable length. If it was possible to include an instruction with lesser bits,

was done so. Thirdly, CPUs were designed to support a variety of addressing modes. As state

above, addition of these three features led to a new technology of processors called CISC.

RISC Processors: RISC or Reducerj lnstruction Set Computer architecture was designt

when it was found that many instructions supported by a CISC processor were not us(

effectively. Thus, a new processor was designed which implemented only basic set 
'

instructions and some of the more frequently used instructions in the CPU circuitry. Oth

complex set of instructions could always be implemented in software. Also, it was decided

make all the instructions of uniform length which made the decoding and execution of all tl

instructions fast and simple. Funhermore, the address modes were designed so as to retrie'

operands stored in registers in CPU rather than from memory. All these changes produced le

expensive, less complex and faster processors.

EpIC processors: EPIC or Explicitly Parallel lnstruction Computing technology allows t

software to communicate explicitly to the processor when operations can be done in parallel.

requires tighter coupling between the compiler and the processor. This technology makes t

compiler extract maximum parallelism in the original code and explicitly describe it to t

processor.

EpIC processors are simpler and more powerful than traditional CISC or RISC processo

They are designed for 64-bit, high-end server and workstation market. These are not design

for personal computers.

Math Co-processor assists the CPU in performing its mathematical operations if the program

designed to ur. it. But computers above '486 grade do not have a separate math co-processor as n

it is already built-in the CPU chip'

lu.
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A bus is a collection of wires that connect several devices within a computer system. A bus can bedefined as an electronic pathway through which bits are transmitted within the cpu and betweencPU and other devices in the system unit. The larger the system bus, the faster it operates. Here theterm larger refers to the width of the bus, that is, how many bits it can transmit at a time. Forexample' in modern computers, usually 32'64 bitbuses are ur"d *hi"h are four to eight times fasterthan those earlier computers using g_bit buses.

There are mainly three types of buses

i' Data Bus: This is used to carry data from CPU to memory or vice- versa. It is bi-directional.
ii' 

fi:ffi:: 
Bus: This is a unidirectional bus that carries the addresses of various memory

iii" control Bus: control bus is also bi-directional and used to transmit control signals generatedduring any processing' It indicates the direction of data transfer and coordinatJs the timing ofevents during the transfer.

All units are connected to a single bus, so it provides the sole means of interconnection. single busstructure has advantages of simplicity and low cost.

single bus structure has disadvantages of limited speed since usually only two units can participatein a data transfer at any one time. This means that an arbitration system is required and that units willbe forced to wait.

only two units can actively use the bus at any given time. Bus control lines are used to arbitratemultiple requests for the use of the bus.

Buffer Registers are used to hold information during transfers.

Figure2.2



Conliguration 1

Configuration 2

Input

F-+l Memory K->lprocessorOutput Memory
bus

t/O bus

Figure 2.3

In the first configuration, the processor is placed between the VO unit and the memory unit. The
processor is responsible for any data transfer between the VO unit and the memory unit. The
processor acts as a "messenger." In this structure, the processor performance and capability is not
being maximized. Most of the time, the processor is doing data transfer between these units instead
of performing more complex applications. Also, the processor is idle most of the time waitins for
these slow devices.

In the second configuration, VO transfers are made directly to or from the memory. A special
purpose processor called peripheral processor or VO channel is needed as part of the VO equipment
to control and facilitate such transfers. This special processor is the Direct Memory Access(DMA)
controller. It allows main memory to perform data transfer between Uo units.

Input
.1-----.h\l 

^ 3=+l Memory
Output Memory

bus

l/O bus



1.

2.

3.

4.

Exergsge

Explain the functional block diagram of a computer?

What is memory? Explain different types of nremory.

Explain the Central Processing Unit in detail.

Explain the bus structure of Digital Computer.
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1. lntroduction

A computer system interacts with the outside world through the input/output devices. While input

devices are used to take in data into the primary storage, the output devices are used to give the

results from the primary storage to the outside world.

Together input and output devices are called peripheral devices as these are at the periphery of the

cPU. *S'o-ir:
2. Input Devices

The input devices are those peripheral devices that are used to enter

data and instructions into the computer for processing. Input devices

translate data to be fed in computer in binary form.
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i.

ii.

Types of Input

Data is therawfacts given to the computer.

Programs are the sets of instructions that clirect the computer.

Commands are special codes or keywortl.r that the user inputs to perform a task, like RUN"ACCOLINTS". These can be selected from a menu of commandi like "open" on the File
menu. They may also be chosen by clicking on a command button.

v' User response is the user's answer to the computer's question, such as choosing OK, yES, or
NO or by typing in text,for example, the name of a file.

'he keyboard is the most comrnon input device. Some of the other input devices are explained
elow.

r.1 Keyboa rd

he keyboard is one of the earliest and the most commonly used input device for entering data and
:mmands into the computer system.

is a collection of different switches or keys.

ach key has a different code/character associated with it.

)me represent alphabets, digits and symbols whereas some keys represent non-printable characters
rd are responsible for some function.

Keyboard Layout: The most commonly used keyboard is the IBM-l0l key keyboard. The
keys are arranged in different groups as shown.

o' Alphanumeric Keys: This set contains alphabetic, numbers and special characters.
b' Numertc Keypad: This set of keys act as numeric keys when Num Lock (a key on the

keyboard) is oN and act as cursor movement keys when Num Lock is oFF.
c' Cursor Movement Keys: The four keys (up, down, left and right arrow keys) are used

for moving the cursor to a desired location.
d' Function Keys: The 12 keys Fl to Fl2 represent a function. The purpose of each key

depends on the application being used. Thise keys can be programrio fo1. use as per
each application.

e' Special Purpose Keys; These keys perform specialized functions. They are Esc, pause,
lnsert, Delete. etc.



ll.

Modifier Keys: They are used to modify the input of other keys. They are used by
holding down the modifier key while pressing another. They are Shift, Ctrl and Alt.

Escape key
Function keys

Cursor
Modifier keys movement keys Numeric keys

Figure 3.1: Keyboard

Process of accepting input from the keyboard

a. When a key is pressed, a computer circuit called keyboard controller puts a code (scan

code of the key) into a memory called keyboard buffer.

b. The keyboard controller signals the computer's system softuiare that a key has been
pressed by sending an intemrpt request.

c. The system software then reads the keyboa:d buffer and sends the key's scan code to
the CPU.

Figure 3.2

Keyboard



2.2 Pointing Devices (Graphical User
lnterface)

These devices are specially used for Graphical User lnterface (GUI)
based applications where some sort of selection has to be made or in
applications, where a user has to input a free-hand input like a
signature.

Mouse

This is one of the most popular and effective pointing device for GUI applications. It allows the user
to move a cursor or pointer on the screen to any desired location; It is held in one hand and moved
across the flat surface. Its movement and the direction of the movement are detected by two rotating
wheels which are present on the underside of the mouse. These wheels have axes ai right anglesl
Each wheel is connected to the 'shaft encoder' which emits an electrical signal for every incremJntal
movement of the wheel. The pulses transmitted by the mouse determine the distance moved.

Encoder
wheel

Rollers

Mouse (standard)

Figure 3.3

The operations can be performed using a mouse in two steps:

i. Pointing

ii. clicking, Double-clicking, Dragging or Right-clicking rhe burtons, which
These points are explained below:

clicking: Pointing to an item and quickry pressing and releasing the mouse
as clicking.

are on the mouse.

button is called

Mouse



Left clicking: Clicking the
on the screen will select it.

left button while the pointer is over something

Right clicking: Clicking the right burton while the pointer is over
something on the screen will bring up a menu of options. This menu list
things that can be done with that object (example: copy and paste).

Double clicking:
mouse button verv

Double-clicking means clicking twice with your
fast. This is used to begin programs.

left

Dragging: Holding down the mouse button while over an object will grab on to it. If you
move the mouse while holding down the mouse button you will be able to move (drag) the
object to a new place on the screen.

Droppittg: After dragging an item, releasing the mouse blrtton will leave (drop) the object at
the new place on the screen.

Types of Mouse i pointing,Devices . ,

i. Mechanical Mouse: The mouse has a ball on irs underside. i: I?:hliitalMouse 
:'

whichrollswhenthemouseismovedoVeraflatsurf||'Upt|ca|MoUse.
There are rwo rollers, which are placed at 90 degreer," it? iii' wilelessMout:,,., 

.*,+
other. One roller responds to the vertical movements and other
to the horizontal movements.

These rollers are attached to a wheel which spins as the rollers roll and relays information
about how much each roller spins. The information is sent in the form of electrical signals by
the cord attached to the mouse.

The electrical signals are created either by using an opto mechanical method consisting of
LED and light sensor or by using metal contacts which generate electrical signals when the
wheel spins.

This electrical signal is then converted into the corresponding mouse position on the screen.

ii. Optical Mouse: This mouse does not have a ball and wheel arrangement. It uses a small LED
that bounces light off the flat surface. This light is detected by a CMOS sensor which sends
signals to a Digital Signal Processor (DSP). The DSP compares the previous images with the
current to measure movement. It then sends the corresponding coordinates to the computer,
which then moves the cursor on the screen.

This mouse does not have any moving parts and hence there is less wear and tear. It is capable
of higher resolution but is expensive.



iii. Wireless Mouse: This can either be a mechanical or optical mouse except that it does not
have a cord. It is powered by batteries and sends information to the computer using radio or
infrared signals.

These signals are detected by an infrared detector or receiver, which is connected to the
computer.

Advantage

The Mouse moves the cursor around the screen faster than using keystrokes.

Disadvantages

l. Requires moving hand from keyboard to mouse and back.

2. Repeated motion can lead to carpal tunnel syndrome.

P, Trackball

This is a ball inserted in a small external box adjacent to and in the same unit as the keyboard of
some notebook computers (laptops). Instead of moving the whole mouse around, the user rolls the
trackball (which is on the top or side) with fingers to move the graphic cursor (as the electronic
circuitry detects the direction and speed of the spin and passes the information to the processor).

Figure 3.4: Trackball

Advantages

Does not need as much desk space as a mouse.

Is not as tiring since less motion is needed.

Disadvantages

1. Requires fine control of the ball with just one finger or thumb.

2. A repeated motion of the same muscles is tiring and can cause carpal tunnel syndrome.

1.

2.



It uses a touch sensitive pad for controlling cursor. The user slides finger across the pad and the
cursor follows the finger movement. For clicking there are buttons, or you can tap on the pad with a
finger. The glide pad is a popular alternate pointing device for laptops.

Figure 3.5: Glide pad

Advantages

l. Does not need as much desk space as a mouse.

2. Can readily be built into the keyboard.

3. Has fine resolution. Hence, to achieve the same cursor movement on screen takes less
movement of the finger on the glide pad than it does mouse movement.

4. Can use either buttons or taps of the pad for clicking.

Disadvantages

1. The hand tires faster than with a mouse since there is no support.

2. Some people don't find the motion as natural as a mouse.

This is a pointing device used with hand-held computers and digital assistants. This penJike device
(also called stylus) is held in the hand and is used to write on a special pad or directly on the screen.
It can also be used like a mouse for selecting commands.

Pen based computers are not generally used to enter large amount of text but for selection of a menu
or icon, inputting signatures or messages.
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Figure 3.6: Light Pen

Working of Light Pen: A light pen sysrem comprises of the lighr
pen itself, the computer and the light-pen driver software.

The light pen contains a lens, aperture and photo diode, which acquires and magnifies the light fi-om
the monitor.

This information is relayed to the computer, which determines the position of the light pen and
illuminates the underlying pixels.

The light pen can also be used as a stylus to input text and signatures. It has to be moved on a special
surface, which converts the movements of the pen into a digital image.

Pen Input: Used especially in Personal Digital Assisrants (pDA).

Stylus
(pen)

Holder

the screen and clicking by

Figure 3.7: pen lnput

Pen Input is usedfor

a. Data Input: By writing, PDA recognizes your handwriting.
b. Pointing Device: Functions like a mouse in moving a cursor around

tapping the screen.

Slate (touch pad)

Apr.2p09-Jlyl ;,,,,.,,.
Eiplain *o*ing of Lightl



c. Command Gestures: You can issue commands by moving pen in patterns. So a certain kind of
swirl would mean to save the file and a different kind of swirl could mean to open a new file.

Advantages of Pen Input

1. Can use handwriting insread of typing.
2. Can use gestures instead of typing commands.

3. Small size.

Disadvantages of Pen Input

1. Must train device to recognize handwriting.

2. Must learn gestures or train device to recognize the ones you create.

3. Can lose the pen which is not usually attached to the device.

Touch screens accept input by allowing the user to place a fingertip directly on the computer screen,
usually to make a selection from a menu. 

, . ,
They use sensors in or near the computer's screen to detect the touch of a finger. When the sehsor
detects the touch of a finger, it sends the information to the CPU ancl the CPU illuminates the
underlying pixels. Further action may then be taken depending upon which part was selected (like
displaying a new screen, etc).

Figure 3.8: Touch Screen

Advantages

1. Its natural to do - reach out and touch something.
2. They are well suited for automatic teller machines, supermarkets, departmental stores, public

information systems (kiosks), etc.



Disadvantages

1. Its tiring if many choices must be made.
2. It takes a lot of screen space for each choice since fingers are bigger than cursors.

Digitizer is an input device which is used for inputting free'hand drawing or text into the computer
and storing it in a digital format. The image may be stored as information about X, Y coordinates of
each point.

It consists of a flat surface called graphic tablet which may be kept on a table. The graphic tablet has
an associated or connected stylus or cursor. Most digitizers use an electrical sensing mechanism to
measure the position of the stylus on the tablet. This position is converted into a set of X and Y
coordinates data.

In one method, a fine grid of current carrying wires is placed below the tablet sudace. When the
stylus is placed at any point on the sur{ace, a connection is made which causes current to flow. The
strength of the picked up current indicates the X, Y position. When the stylus is moved, a cursor on
the CRT screen moves simultaneously to provide visual feedback. Some digitizers also have a
Liquid Crystal Display below the surface of the graphic tablet so as to display the stylus movement
on the tablet.

Digitizers are commonly used in CAD by architects and engineers to design buildings, machines and
many other things. They are also used in Geographical Information System (GIS) for digitizing of
maps that are available in paper form.

Cursor

Stylus

Graphic tablet

Conducting layer

Figure 3.9: Digitizer

Advantage

Don't have to redraw graphics already created.

Disadvantage

Expensive.



Cursor motion is also controlled by vertical stick (oystick) or arrow buttons (game pad). In case ofjoystick, a lever that moves in all directions and controls the movement of a pointei or some other
display symbols. A joystick is similar to a mouse except that with a mouse the cursor stops moving
as soon as you stop moving the mouse. While with a joystick, the pointer continues rnouing in th6
direction the joystick-is.pointing. To stop the pointer, you must return the joystick to its upright
position. Most joysticks include two buttons called triggers. Joysticks u." *ortty used for.o*pui*.
games, but they are also used occasionally for CAD/CAM system and other applications.

Game pad

Figure 3.10

Advantages

. I. A joystick gives a more natural-feeling control for
you are flying a plane or spaceship.

2. Both have more buttons for special functions than a
more actions.

Disadvantages

Joystick

motion in games, especially those where

mouse and can cornbine buttons for even

1 More expensive and bulky.
2. Better ones require an additional peripheral card for best performance.

2.3 Scanning Devices

This category of devices provides faster and more accurate method
of giving input data to the computer. They are used when some data
is already printed/written and it has to be read/recognized and then
fed to the computer. Some of the Scanning devices are:



t. Magnetic Ink Character Reader (MICR): In this method, human readable characters are

printed on documents using special magnetic ink. A magnetic ink character reader can

recognize these characters. The MICR devices use the El3B font, which contains digits 0-9

and 4 special syrnbols as shown infigure 3.11.

MICR is especially used in banking. A bank cheque contains branch code, cheque number and

account number preprinted in magnetic ink(iron oxide particles). The MICR reader can read

data directly from the cheque into the computer system. This eliminates manual data entry and

ensures accurate data entry.

Figure 3.11: Magnetic Ink Character Reader

Optical Bar Code Reader (OBCR): Bar Coding is a method of printing bars of varying
thickness and spacing. They are printed on items like books, packages, etc. The bar codes
provide information like manufacturer, product code, price, etc. A sample bar code is as

follows.

lsBN 8'r -87575-50-6

lllljllllljlllililLlffilill illttiltltilir

Figure 3.12: Optical Bar Code Reader

In order to read the bar code, a bar code scanner has to be used. This scanner consists of an

optical device which analyses the bars for width and spacing and converts this information
into electrical pulses for the computer. The bar code reader emits a beam of light frequently, a

laser beam, that is reflected by the bars. A detector detects the reflected light and generates

corresponding electrical pulses.

ll.
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Bar Code Scanners are of two types

a. Hand Held Scanner: The bar code reader is held in the hand and moved over the bar
code image. It is mainly used by courier and delivery agents.

b. Flat Bed Scanner: The flatbed model is most commonly used in supermarkets and
departmental stores. The products are placed over the flat rectangular scanner surface
with the bar code image in contact with the surface.

The standard coding convention used is the Universal Product Code (IIPC).

After the reader has identified the bar code, it converts the individual bar patterns into an
alphanumeric value.

Hand held scanner Flat bed scanner

Figure 3.13

Optical Character Reader (OCR): An optical scanner is a device, which reads an image and
converts it into a set of 0s and ls which can be stored in computer memory. The image may be
handwritten, typed or printed document.

In order to speed up the process, American National Standards Institute (ANSI) adopted a
standard style of text to be used with Optical Character Reading Devices which converts the
characters into a set of 1s and 0s.This is called the 'Bitmap'.

These scanners can be either hand held or flat bed scanners. These scanners emit light pulses.
Black areas of the text do not reflect the light as white areas do.

The reflected light is sensed by photo-diodes, which generate electronic pulses corresponding
to the light intensity.

In some applications, software is used which converts the bitmaps into text if the scanned
document is a text document. It does it by matching the characteiwith a nurnber of possible
ways that the character could be written. Example: The character 'g' written in different ways.
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Figure 3.14: Optical Character Reader

Optical l\Iark Reader (OMR): In this method, special preprinted forms are designed with
boxes or circles which can be marked with ink or pencil. The optical mark riader can
recognize these marks by converting them into electrical pulses and transmitting to the
computer. Based on the information received and the pre-fed information, the computer can
evaluate the response as correct or wrong. They are used for objective type examinations,
surveys, order forms, etc.

A

1l

Figure 3.15: Optical Mark Reader

Scanner: A scanner or an image scanner translates paper documents into the digital format
that can be stored in a computer. The documents of all types can be converted using this
device. The digital format of the documents helps in preserving them for a long time.

Two types of scanners are:

a. Hand-held Scanner: It holds LEDs (Light Emitting Diodes) inside a small case. The
scanner can be held in hand as per convenience. The scanner is dragged very carefully
and .steadily over the document. Hence, they are used where high accuracy is not
required, and where volume of conversion is also low.
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Figure 3.16: A hand held scanner

F.latbed Scanner: It looks like a copier and has a glass plate on its top which is covered
by a lid. The document to be scanned is placed upside down on the glass plate. A light
source, from below the glass plate moves horizontally on activation. It scans one line at
a time, with light beam moving up a little to scan the next one. It continues till all the
lines are scanned. A 21 cm x 28 cm document is scanned in approximately 20 seconds.

Figure 3.17: A flatbed scanner

3. Output devices

The computer processes data accepted from all the input devices to
generate useful information. The information, unless presented to the
user, is of no use. Output devices are those peripheral devices that
are used to translate the information processed by the computer into

a human readable form and gives to the user. Monitors and sound

systems allow us to see and hear information; printers enable us to

have a physical document. In this section, we shall be studying some

commonly used output devices.

b.



3.{ Monitors

This is the most commonly used output device on most personal
computers. It is also called as Visual Display Unit (VDU) or
Cathode Ray Tube (CRT) display.

Monitors are of following types:

i. Monochrome: Display only one color against a contrasting
background.

ii. Grayscale: Display varying intensities of grey against white
background

iii. Color: Display from 16 colors to 16 million colors.

Monitors also used with PCs are of following types:

a. CRT monitors

b. Flat-Panel monitors (LCD monitors) used with portable computers

c. Plasma display

i. CRT Monitors: These monitors have a Cathode Ray Tube (CRT). This tube contains an

electron gun at the back, which generates an electron beam, which is guided by magnetic coils
to the front of the CRT where there is a screen. The guiding assembly consists of a control
gnd (to regulate beam intensity), focus grid (to control beam width), an accelerating grid,
horizontal and vertical deflection coils to move the beam across the screen. The back of the

screen is coated with phosphor, which glows when the electron beam strikes it. A shadow
mask is placed very close to the phosphor coating. It is a metal plate with holes. This mask

blocks the beam detracting from the brightness of the resulting image.

The electron gun scans the entire screen starting at the top left corner and scanning to the right
edge, comes to the start of the next line and continues. Once it reaches the bottom, the process

continues from the start (Refreshing).

A color monitor also works in the same way but has three electron guns (Red, Green, and

Blue).

The smallest phosphor dot which can be illuminated is called a 'pixel'. Each character is
displayed by a matrix of 5 dots along horizontal and 7 dots in vertical direction. A display
normally has 80 characters in a horizontal line and24 such lines vertically.

The CRT consists of a small memory called as buffer, the size of the buffer is normally equal
to the total number of characters (usually 1920 - 24 rows and 80 columns) that can be

displayed at a time on the CRT screen. Each character entered through the keyboard is stored

in the buffer and is also displayed simultaneously on the CRT screen. The data is not sent to
the processor until the operator presses an enter-key on the keyboard.
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Figure 3.18: Internal CRT

QualiA of Monitor

The quality of the image produced depends upon:

a. Resolution: Number of pixels on the screen expressed as a matrix.
Example:640 x 480 (VGA) monitor, 800 x 600, 1024x 768 (SVGA).

b. Monitor size.' Screen size measured diagonally in inches. Examples: 17 inches,
21 inches,25 inches.

c. Refresh rdte.' Number of times per second that the electron guns scan every pixel on
screen (measured in Hz).

Display Modes

The mode refers to the characteristics of the computer display, which are.

1. Maximum number of colors

2. Image resolution



PCs have several d a modes

" i: ,; .: . Modg '; ; i,l,i*;"-r1;' , Maximt"ni,colois' Resotuli<inl'
CGA Color Graphics Adaoter 4 320 x 200
EGA Enhanced Graohics Adaoter 16 640 x 350

VGA Video Graphics Array
to

256
640 x 480
320 x 200

XGA Extended Graphics Array
16 million
65,536

800 x 600
1024 x768

SVGA Super Video Graphics Array 16 million 800 x 600
SXGA Super Extended Graphics Arrav 16 million 1280 x 1024
UXGA Ultra Extended Graphics Arrav 16 million 1600 x 1200

ii. Liquid Crystal Display (LCD): The Liquid Crystal Display is most commonly used in
calculators and is now beine used for monitors too.

Figure 3.19: Liquid Crystal Display

Mechanism

The LCD consists of a special polymer called Liquid Crystal. The Liquid Crystal is
sandwiched between two transparent electrodes or conductors using which an electric field can
be applied. On both sides, polarizing filters are placed which polarize the light entering and
leaving the crystal. Usually, these polarizers are crossed, i.e., no light will be able to pass
through. However, by applying electric field, the liquid crystal will modify the polarization so
that light can pass through some areas.

Thus, it is possible to dynamically create tiny spots where light will pass and spots where it
will not; thereby creating an image. The electrodes are in the form of a matrix of thin film
transistors (one for each pixel) that electrically activate each pixel.

This display can be of two types:

a. Passive matrix LCD: There is a transistor for each row and column and the color
displayed by a pixel is determined by the electricity coming from the row and column
transistor of the pixel.



They are less expensive but they have a nalrow viewing angle.

Active matrix LCD: There is a transistor for each pixel which can be turned on and off
individually. They can be refreshed rapidly thus giving better and lasting images.

However, they are complicated, more expensive and require more power.

Transparent conductor Polarising filter

Figure 3.20

iii. Plasma Display: This dispiay device uses specialized

technology and are used in specific applications.

Mechanisnt

These are thin displays created by sandwiching a gas (neon and xenon) in thousands of tiny cells

between two sheets of glass. The address electrodes are placed behind the cells along the rear glass

plate in vertical columns. The display electrodes are placed above the cells along the front glass

plate in horizontal rows. They both form a grrd.

The intersecting electrodes, when charged, ionize the gas within the cell, which emits photons.

This acts as a pixel. By controlling the amount of voltage applied to each grid point, an image can

be displayed. Phosphor is coated on the cell walls for enhanced images'

b.

Inert gas

Address
electrodes

Display
electrodes

Glass sheet

Display
electrodes

Address electrodes

Figure 3.21: Plasma DisPlaY

Liquid crystal



Features

This display is expensive but provides high quality images and can be much larger than LCDs.
Some are as big enough to be hung on a wall and used as large-screen televisions.

3.2 Printers

A printer is a peripheral output device designed to get a hard copy of
the output.

Impact printers create an image by pressing an ink ribbon against the paper using pins or hammers.

Example: Dot marix printer

Non-Impact printers do not use the impact technique but use spray technique or use heat method to
form an image on paper.

Example: Inkjet, Laser printers

Depending on their speed and approach of printing, printers are also classified as Character prtfiers,
line printers and page printers.

i.

ii.

lll.

Features of Printers

Image quality: It is measured in dots per inch (dpi). More the dpi, better is the image.

Speed: It is measured in pages per minute (ppm). Different printers have different ppm.

Cost: The cost depends upon the resolution, technique used for printing, color or black and
white, etc. Laser printers are the most expensive.

Operational cost: This determines the cost of printing a page (which depends upon the cost of
ink cartridges).

tv.



Types of Printers

Dot Matrix Printer

It is an impact printer most commonly
where physical impact with the paper
when the document has carbon-copies.

used in offices, etc.

is important, such as

Figure 3.22:Dol matrix printer

Mechanism

It has a print head, which contains a matrix of pins arranged in one or more columns. The head

comprises a matrix of tiny needles, typically (9 x 7) seven rows with nine needles in each

which hammer out characters in the form of patterns of tiny dots. It may contain

9 pins or 24 pins.

Depending upon the character or image to be created, the CPU gives instructions to the printer

to activate certain pins of the print head. These pins are pushed out in various combinations.

When they strike the ink ribbon, the ink is transferred onto the paper.

The image is in the form of dots and hence the name - dot matrix.

The print head keeps moiing left to right line-by-line in synchronization by a roller-feed

mechanism, which moves up the paper line by line.

Figure 3.23
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These printers have a speed of about 30 cps to 600 cps (characters per second). However,
being impact printers they are noisy and print quality is not very good. Since they cost less,
they are widely used for daily and bulky printing jobs.

Inkjet Printer

Mechanism

These are non impact character printers based on a new technology. They print characters by
spraying small drops of ink on the paper.

Its print head has up to 64 tiny nozzles that are selectively heated up within microseconds. Due
to heat the ink vaporizes and is ejected through thenozzle.

The droplets are electrically charged after leaving the nozzle which is then guided to the proper
position on the paper by electrically charged deflection plates.

Inkjet printers produce high quality output because the characters are formed by dozens of tiny
ink dots. Inkjet printers are the high speed printers.

Drop generator (600)

Charge
electrode

Vibrating crystals
(1,17,000 drops

per second)

Figure 3.24: Function of Inkjet printer

The print head is attached to an ink cartridge(s) such as separate black and color cartridge or
both in a single canridge.

The cartridges of some inkjet printers include the print head itself. The carrridge has an ink
reservoir, which has one or more nozzles. Color inkjet printers have four nozzles (cyan, red,
yellow and black).

Horizontal
plales

Inkjet printer Inkiet printer mechanism
Figure 3.25: Inkjet Printer Mechanism

Deflection
plates

Inkjet Vertical Nozzle
plates



A stepper motor moves the print head assembly (print head and ink cartridge) back and forth

u"tor.lh" paper. A roller-feed mechanism moves the paper up one line at a time'

Features

Inkjet printers generate higher quality output than dot-matrix printers.

They are extensively used for printing graphics.

The resolution is about 360 dpi (dots per inch).

Speed is about 2 to 4 pPm.

Initial cost is less but operational cost is high as compared to dot matrix printers.

4.

b.

c.

d.

llt. Daisy Wheel Printer

This printer uses a print wheel font known as a daisy wheel. Each petal of the daisy wheel has

a character embossed on it. A motor spins the wheel at a rapid rate. When a desired character

spins to the correct position, a print hammer strikes it to produce the output. Thus daisy wheel

printers are the impact printers. The speed range norrnally ranges from 10-50 characters per

second.

Ribbon

Characters embossed
on tio of arm

Figure 3.26: DaisY wheel Printer

Laser Printer

These printers are more expensive than inkjet printers, faster and give better print quality.

These print"tr have a LASER which is controlled by a processor within the printer. It is a page

printer as it scans the entire page to print.

tv.



Figure 3.27: Laser printer

Mechanism

The laser when aimed at the electro statically charged drum by the spinning multi-sided mirror
creates an electrical charge. Toner which consists of tiny particles of oppositely charged ink,
sticks to the drum on the places that are charged.

Then, the toner is transferred to the paper by pressure and heat. The drum is continuously
rotated sg as to form the full imaee.

e H"' o
Mirror,
lenses etc.

@
Fusing
section

Figure 3.28: Laser printer mechanism
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Features

a. They have a resolution from 600 dpi to 1200 dpi.

b. They can print 4 - 16 pages per minute.

c. They are very expensive.

Line Printers

Line printers are impact printers used with most medium and large computers for producing
high volume paper output. They are fast printers having speeds in the range of 300 to 3000
lines per minute.

a. Drum Printers: A drum printer consists of solid, cylindrical drum that has raised
characters in bands on its surface. There are as many bands as there are printing
positions. Each band contains all possible characters. The drum rotates at a rapid speed.
For each possible print position, that is opposite to each band, there is a print hammer
located behind the paper.

These print hammers strike the paper, along with the inked ribbon, against the proper
character on the drum as it passes. One revolution ofdrum is required to print each line,
it is an impact printer and the speed ranges from 300 lines to 2000 lines per minute.

Rbbon -@ r n n'ff il"r I'ii r r n n,,-,"*,\

Figure 3.29: Drum printer

Chain Printers: They uses a rapidly moving chain called as a print chain.

Each link of the chain is a character font. For each possible print position, there is a
print hammer located behind the paper. As the print chain or band rotates, the properly
timed print hammers strikes the paper along with the inked ribbon, against the proper
character on the chain/band as it passes. It is an impact printer and speed ranges from
400 to 3000lines per minute.

b.

Print cylinder



Comolete chain
composed of five One section of 48 characters

132 orintino oositions

Figure 3.30: Chain printer

Differentiate lmpact Printer and Non-impact
Printer
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In impact printers, the characters or
images are formed by striking a
mechanism such as print hammer or
wheel against an inked ribbon,
leaving an image on paper.

In non-impact printers,. the
characters and images are
formed without making direct
physical contact with paper.

N

$
.W

lmpact printers are relatively noisy.
Non impact printers are less
noisv.

Since the paper is struck, interleaved
carbon paper can be used to create
multiple copies of pages in a report.

Non lmpact printers cannot
create carbon copies.

the examples of impact printers are
dot matrix printer, daisy wheel
printer, chain printer, etc.

The examples of non-impact
printers are laser printers, inkjet
printers and thermal printers.

lmpact printers are comparatively
less quiet and produce less good
quality print than non-impact printers.

Non-impact printers are quieter
and produce better quality print
than impact printers.

lmpact printers are usually less
expensive than non-impact printers.

Non-impact printers are usually
more expensive than impact
printers.



3.3 Plotters

A plotter is a special kind of output device used to print large-format
images such as engineering drawings, maps, chalts, architectural
drawings, etc.

They differ from printers in that they draw lines using a pen as a
result of which they can produce continuous lines.

Plotters are of two types.

Table or Flatbed Plotters: It consists of two robotic arms
which holds a set of colored ink pens or pencils. They work in
coordination at right angles and draw on a stationary piece of
paper.

Spare pen in
different colours

Figure 3.31: Flatbed plotter

Roller or Drum Plotter: It uses only one drawing arm but moves the paper. The drawing arm
moves side to side as the paper is rolled back and forth by the roller. It can draw geometric
shapes and lines of different colours and thickness.

Figure 3.32: Drum plotter

It.
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l. Differentiate Impact Printer and Non-impact Printer.

2. List output devices. Explain any one output device.

3. Explain Plotter in detail.

4. Explain different types of Printers in detail.

5. Define Output Device? Discuss Monitor as an Output Device.

6. Explain working of Light Pen.

7. List different input devices. Explain any two in detail.

8. Explain the working of plasma display.
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GoMPUTER MEMoRY
ffi.

1. What is Memory?

Memory is an essential component of a digital computer. Its function is to store data, programs /
instructions, intermediate and final results of computations, or any other kind of information in the
form of binary codes. The main memory of the computer is divided into several locations each with a
specific address and data is stored in these locations in the form of words (8 bit/ 16 bitt 32 bit). The
memory cap"acity decides the number of locations available. An 8-bit address bus is capable of
addressins 2" = 256 locations/cells.

1.1 Units of Measurement for Storage

Memory is measured in terms of bytes. A byte is a basic unit to measure memory and it contains
eight bits, which is the smallest unit. The total number of bytes in main memory is referred to as the
computer's memory size.



Computer memory sizes are measured as follows:

i. Bit: In binary number system, each 0 or 1 is called a bit, which is short for 'binary digit'.
ii. Byte: Bits are combined into groups to represent different characters, digits or special

symbols. A combination of eight bits is known as a byte.

iii. Kilobyte: A kilobyte is abbreviated as KB and is equivalent to 1024 bytes.

iv. Megabyte: A megabyte is abbreviated as MB and is equivalent to 1024 kilobytes.

v. Gigabyte: A gigabyte is abbreviated as GB and is equivalent to 1024 megabytes.

vi. TeraByte: A TeraByte is abbreviated as TB and is equivalent to 1024 gigabytes.

A memory cell is the smallest part of a computer memory.

A memory cell records a number written in binary form. This number is called the content of the
memory cell.

Thefigure below indicates that the cell has conrent 110100112.

Memory Cell

11010011

Figure 4.1

A RAM (random access memory) cell can have different numbers recorded in it at different times. It
is like a cassette tape that can be rerecorded with different songs. However, when a new number is
recorded in a RAM memory cell, the old number is FOREVER LOST.

A ROM (read only memory) cell has a number permanently recorded in it. It is like a message.
chiseled in stone. It cannot be lost, even if the power is tumed off.

All the numbers recorded in a memory cell always have the same number of bits. Thus if a memory
cell has an 8 bit content then:

i. content 0 decimal is really 000000002 = 00ro

ii. content 167 decimal is really 101001112 = A7 rc

Since a memory consists of a large number of memory cells, there has to be a way to keep track of
which cell is which.

Thus each cell in a memory has an index number called its address which is a sort of "chiseled" into
the "edge" ofthe cell.



The cell pictured below has a content of 1101.00112 and an address of 001101012.

??//?,/ZZ
11010011

Figure 4.2

A cell address CANNOT be changed. The address numbers start at 0 and go 1,2,3, etc. The address

of a cell is usually different than its content - although they can be the same.

Classification of Memory

In computers, there are two types of memories.

i. Primary Memory

ii. Secondary Memory

These memories are explained below in detail.

2. Primary (Semiconductor) Memory

ftris is called the main memory of the computer. This memory stores

'immediate access and use by the CPU.

The main memory is directly connected to the CPU by the address, data

signal lines for sending addresses, data and control signals. Since the

connected to the CPU, access is much faster.

Physically, the main memory consists of chips either on the motherboard (the main circuit board) or

on a small board attached to the motherboard.

data and instructions for

and control bus which are

main memory is directly



ROM (nonvolatile)

Figure 4.3

2.1 Types of Primary Memory

.TypeF of primary memory
* .jRead'Only Memory

"ii.,r.flanO6mRccessMemory 
stored contents on the power supply being interrupted / switched

r '-(RAM} i 'OFF'. However, the user cannot write to the ROM. It's contents are
written at the time of manufacture.

Hence it is used to store the system BIOS (Basic Input Output System), permanent programs /
information required by the computer to execute the user programs. They are also called Mask
ROMs. (The components used are diodes and emitter of transistors (BJT / MOSFET).

Types ot ROM

i. PROM: This is Programmabte Read Only Memory. User can program it according to their
needs. An equipment called PROM programmer or PROM burner is used for the
programming. The disadvantage of PROM is that it can be programmed only once. Thus user
cannot change its contents after it iis programmed once.

+"*'* ii. BPROM: This is Erasable Programmable Read Only
Memory. User can program its contents more than once. Thus
EPROM's are used to store permanent data that may need
updating after sometime. The contents of EPROM can be
erased by the exposure of high intensity ultraviolet (UV) light.

i21^
Api.09;



There are some limitations of EpROM as follows:

a. The EPROM chip is removed from the computer's board to erase its contents, thus
making the whole process a bit complicated.

b. The complete data is erased in this process. User can not erase only some particular data
stored in EPROM.

iii. EEPROM: This is Electrically Erasable Programmable Read Only Memory. This memory
can be electrically programmed and electrically erased any number of times by the user. The
disadvantages of EPROM are removed in it. The chip need not to be rernoved from the
computer for erasing. The complete data can be erased in one operation, if desired. Otherwise
only selected data can also be erased and reprogrammed on the board on a byte by byte basis.

Semiconductor RAM is generally used as main memory. The access time of RAM is of the order of
80 - 100 nanosec. This is a read/write memory where data can be written into and read from a RAM.
It is a volatile memory (i.e., its contents are erased when the power supply is switched
off/intemrpted. It is called Random Access Memory because any of the locationJ on a chip can be
randomly selected and used to directly store and retrieve data and instructions. The components used
are CMOS/BJT i'e., Complementary Metal Oxide Semiconductor / Bipolar Junction Transistor).

It is measured in Megabytes (MB). Most commonly, pCs have 64 MB - 256MB of RAM.

The amount of RAM affects the processing speed. More the RAM, more data and programs can be
loaded and accessed faster. RAM is also used along with video and sound cards.

Figure 4.4: RAM Chip
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Types ot RAM

DRAM(Dynamic Random Access Memory): This type of RAM uses the MOS technology

where data is stored in minute MOS capacitors. Thus their capacities are very large and they

are cheaper. However, the capacitors tend to lose charge and hence they have to be recharged

or refreshed every few milliseconds. They work at moderate speed (Comes in 80, 70, or 60

nanosecond (ns) speed) and consume less power. The lower the number, the faster the memory.

SRAM(Static RAM): This RAM is made of flip flops to store data in a static form, i.e., data

is retained as long as there is power. They are however bulky and have less capacity. SRAMs

are more expensive and consume more power but are faster than DRAMs.

CDRAM(Cached RAM): lnvented by Mitsubishi Electronics. It combines an SRAM cache

with 4 or 16 MB of DRAM within a single chip. This onboard SRAM can be used as both a

cache or a buffer and gives the RAM an approximate 15 ns access time.

EDRAM(Enhaneed DRAM): Developed by Ramtron International Corp. of Colorado

Springs. Like CDRAM also incorporates an on-chip SRAM cache'

EDO RAM(Extended Data Out RAM): It is a form of DRAM that works by extending the

time during which data can be read from memory. Provide from 4 to 15 percent greater

performance than standard DRAM.

SDRAM (Synchronous DRAM): Developed from Texas Instruments has its timing

synchronized to the system clock. Is about 10 percent faster than EDO RAM.

vii. RDRAM(Rambus DRAM): Developed by Toshiba and Samsung. It's similar to SDRAM,

but faster, saYs Rambus.

Video Memory Types

SGRAM(Synchronous Graphics RAM): It is a form of DRAM for graphics controllers and

printers. According to Fujitsu, produces data bandwidth up to five times that of standard DRAM.

VRAM(Video RAM): So-called "dual port" memory types that allow the graphics processor

to read from memory and redraw the screen simultaneously.

WRAM(Window RAM): Developed by Samsung Electronics. It is faster (50 percent

performance increase) and less expensive than VRAM.

Buffer (To move data into a temporary storage area)

A temporary storage area, usually in RAM. The purpose of most buffers is to act as a holding area,

enabling the CPU to manipulate data before transferring it to a device. Because the processes of

lt.

llt.

lv.
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reading and writing data to a disk are relatively slow, many programs keep track of data changes in a
buffer and then copy the buffer to a disk. For example, word processors employ a buffer to keep

track of changes to files. When you save the file, the word processor updates the disk file with the

contents of the buffer. This is much more efficient than accessing the file on the disk each time you

make a change to the file.

Note that because your changes are initially stored in a buffer, not on the disk, all of them will be lost
if the computer fails during an editing session. For this reason, it is a good idea to save your file
periodically. Most word processors automatically save files at regular intervals.

Another common use of buffers is for printing documents. When you enter a PRINT command, the

operating system copies your document to a print buffer (a free area in memory or on a disk) from
which the printer can draw characters at its own pace. This frees the computer to perform other tasls
while the printer is running in the background. Print buffering is called spooling.

Cache

Pronounced Cache, a special high-speed storage mechanism. It can be either a reserved section of
main memory or an independent high-speed storage device. Two types of caching are commonly
used in personal computers: Memory caching and disk caching.

A memory cache, sometimes called a cache store or RAM cache, is a portion of memory made of
high-speed Static RAM (SRAM) instead of the slower and cheaper Dynamic RAM (DRAM) used

for main memory. Memory caching is effective beceuse most programs access the same data or

instructions over and over. By keeping as much of this information as possible in SRAM, the

computer avoids accessing the slower DRAM.

Some memory caches are built into the architecture of microprocessors. The Intel 80486

microprocessor,for exnmple, contains an 8K memory cache, and the Pentium has a 16K cache. Such

internal caches are often called Level I (L1) caches. Most modern PCs also come with external

cache memory, called Level2 (L2) caches. These caches sit between the CPU and the DRAM. Like
Ll caches, L2 caches are composed of SRAM but they are much larger.

Disk caching works under the same principle as memory caching, but instead of using high-speed

SRAM, a disk cache uses conventional main memory. The most recently accessed data from the disk
(as well as adjacent sectors) is stored in a memory buffer. When a proglam needs to access data

from the disk, it first checks the disk cache to see if the data is there. Disk caching can dramatically
improve the performance of applications, because accessing a byte of data in RAM can be thousands

of times faster than accessing a byte on a hard disk.

When data is found in the cache, it is called a cache hit, and the effectiveness of a cache is judged by

its hit rate. Many cache systems use a technique known as smart caching, in which the system can

rccognize certain types of frequently used data. The strategies for determining which information

slrnuld be kept in the cache constitute some of the more interesting problems in computer science.



3. Secondary Memory and Storage Devices

The secondary memories are generally magnetic memories, which
retain data even when the power supply is switched .OFF,, i.e.,
permanent, non-volatile memories. Secondary storage is also called
as Auxiliary Storage.

The secondary storage devices are used for bulk storage. The main
memory receives data required by the processor for current
processing, from the secondary storage unit. The size of the main
memory is much lesser as compared to the secondary memory but
access times are much beuer (higher speeds RAM/ROM
semiconductor memories).

Various devices can be used as a secondary storage device but the one selected for a particular
application depends upon how the stored information needs to be accessed. There are two methods
of accessing information:

A sequential or serial access storage device is one in which information can only be retrieved in the
same sequence in which it is stored. Therefore data is searched in a sequential order, i.e., data stored
in the last but one location cannot be accessed unless the preceding applications are accessed. Hence,
the access time varies according to the location. For example: Punched card, Paper tape, Magnetic
tape. This type of processing is suitable for applications where the data records need to 

-be 
processed

one after another. For example.' preparation of monthly pay slips, monthly electricity bills, ind many
more of such types.

In serial access if only a particular data needs to be accessed, then the access time is too hieh
(depending upon the location of the data).

A random or direct access storage device is one in which access to any stored information is direct,
and approximately equal access time is required for accessing any information irrespective of its
location. Hence, use of direct access storage devices is more efficient wherein any location in the
device can be randomly accessed and the required data can be retrieved almost instantaneouslv.
For example: Floppy Disk, Hard Disk.

This type of processing is suitable for applications where direct and fast access of any specific
information is needed.

For example: ln a bank, at any point in time, it may be required to determine the balance in the
savings account of a customer. Also, for airline reservation system immediate access to any
particular flight is necessary for making bookings.



3.1 Types of Secondary Storage Devices

These devices use magretic media to store data. Data is recorded by
magnetizing the magnetic material that is coated over some base
material.

i. Magnetic Tape: Magnetic tape is a magnetically coated strip of plastic on which the data can
be encoded. Tapes for computers are similar to the tapes used to store music. Storing data on
tapes is considerably cheaper than storing data on disks. Tapes also have large storage
capacities, ranging from a few hundred kilobytes to several gigabytes.

' Accessing data on tapes, however, is much slower than accessing data on disks. Tapes are
sequential-access media, which means that to get to a particular point on the tape, the tape
must go through all the preceding points. In contrast, disks are random-access media because a
disk drive can access any point at random without passing through intervening points. Because
tapes are so slow, they are generally used only for long-term storage and backup. Data to be
used regularly is almost always kept on a disk. Tapes are also used for transponing large
amount of data.

Tapes come in a variety of sizes and formats. Tapes are sometimes called streamers or
streaming tapes.

Figure 4.5: Magnetic Tape

Mechanism

Magnetic tape is one of the most popular secondary storage medium for large volume of data
that are sequentially accessed and processed.

The tape is a plastic ribbon usually Il2" or l/4" in width and coated with an
iron-oxide or chromium dioxide material, which can be masnetized.



The tape ribbon itself is stored in reels of 50 to 2400 feet or a small cartridge or cassette.
Information is recorded on the tape in the form of tiny visible magnetized and non-magnetized
spots (representing l's and 0's) on the coated side of the tape. Before the tape unit can
perform read or write operation, it must be prepared for the operation. This involves loading
the tape along with a take up spool and threading the tape through the read./write mechanism.
Vacuum columns are provided to provide rapid acceleration and deceleration of the tape.

Commonly used data recording densities are 400, 556, 600, 1600 or 6250 characters per inch.
The tape speed is nearly 35 inch per second. The starting portion of the tape as well as end
portion of the tape is kept blank for spooling known as header and tailer respectively.

Tape is divided into blocks and each block stores 250 bytes ofdata, the recording on rhe tape
is done record by record, in the mean time due to mechanical pull, some portion of the tape
gets wounds up on the spool. This portion of the tape is called as Inter Block Gap (lBG).

If the specific instruction is given for writing more than one
records on block, the gaps kept between records on the block
are called Inter Record Gap (IRG) and process is called as
Blocking of records. Most of the modern tapes have '9' tracks
(parallel) and they use the 8-bit EBCDIC (Extended Binary
Coded Decimal Interchange Code) code format for data
recording.

File marker
Block of records

9 paralleltracks
(Uses 8-bit EBCDIC
code for data recording)

Figure 4.6: Magnetic tape

Suppose tape has data recording density of 1600 characters per inch and length oftape is 2400
feet than total data storing capacity of tape will be 1600 x 12x2400 characters.

IBG 250
bytes

Trailer
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Advantages

1. Storage capacity high.

2. Cost per bit storage is very low.

3. Easily portable.

4. Tape can be erased and reused many times.

Disadvantages

l. Sequential access makes the accessing of data slow, if only a particular data is needed.

2. Dust can cause tape-reading errors.

Uses of Magnetic Tapes

l. These are used for storing application files based on sequential data processing.

2. For taking backups of data of an on-line storage device such as a disk. This backup is
used for offJine storage.

3. To transfer data between two non-connected computers.

4. For distribution of original software by the vendors.

Magnetic Disk: Magnetic disk is the most popular direct access secondary storage
medium/device. A magnetic disk is a thin, circular aluminum plate coated on both sides with a
magnetic material like iron oxide. It is very similar in appearance like LP gramophone record
plate. ln a disk pack information is stored on both the surfaces of each disk plate except the
upper surface of upper plate and lower surface of bottom plate. Each surface of disk consists
of number of invisible concentric circles called as "tracks" and each track is further divided
into number of "sectors". A set of corresponding tracks from all surfaces is called as cylinder.
Thus a disk pack having 10 disk plates will have 18 surfaces and hence it will have 18 tracks
per cylinder. Information is recorded on the tracks of disk surface in the form of invisible tiny
magnetic spots. Magnetized spot represent I and non magnetized spot represent 0.

A standard binary code, usually 8-bit EBCDIC code is used for data recording.

The storage capacity of hard disk, i.e., total number of bytes that can be stored in disk pack is
equal to number of recording surfaces * no. of uacks/surface * no. of sectors/track x no. of
bytes/sectors. For example, disk pack has 10 disk plates, each plate has 200 tracks and
suppose there are 40 sectors per track and each sector can store 256 bytes of data then total
capacity ofhard diskpackis 18x200x40*256 = 36864000 bytes.

ll.



Surface 1

Surface 2

3

Read/write head

Arm

Figure 4.7: Magnetic Disk

Types of Magnetic Disk

a. Hard Disk: This is the most commonly used and the primary secondary
It is called hard disk to distinguish it from a soft or floppy diskette. It is a
device, i.e., data can be directlv read.

storage device.
random access

Figure 4.8: Hard Disk and Hard Drive

Construction: Hard disks contain one or more circular metal platters (made of
aluminum) mounted on a central spindle. Each platter is covered with a magnetic
coating. Data is read and written on the platter by a read-write head, one per surface.

The hard disk spins about the spindle at a very high rate of about 3600 rpm to
7200 rpm. The read/write head is moved in order to position it on a specific track. The
entire unit is encased in a sealed chamber and mounted on a disk drive. Such a disk
drive is known as Winchester disk drive.



b.

Data Organization: Disks can store data on both sides of the disk. The organization of
the disk in tracks and sectors is as discussed above under Magnetic disk. Each sector
can store up to 512 bytes. All sectors on the disk are numbered in a sequence.

Hard disk capacity is currently in Gigabytes (GB). Example: SeaGate, Quantum are
popular Hard Disk manufacturers.

Advantages

1. Direct access to data. Hence. can be used for
wide range of applications.

2. Makes data readily accessible at all times.

3. Cost per bit of storage low.
4. Can be erased and reused many times.

5. Date transfer rate is higher than the tapes.

6. Suitable for both on line and off line storage.

Disadvantages

1. Not ponable.

2. A disk crash or drive failure can result in complete data lost.

Floppy Disk: A floppy disk (also called diskette) is a
portable magnetic disk. It can be removed from the
drive which contains the read/write mechanism. Some
kinds of new computers come without a floppy disk
drive at all.

It is available in two varieties which are as follows:

1. 5Va inchz Storage capacities 360K and 1.2 MB.

2. 3Yz inch: Currently used, they have a capacity of
plastic cover.

1.44 MB and encased in a risid

@W
3Vz" Floppydriveof 57+" Floppy diveof3Yz"

Figure 4.9: Floppy disks and floppy drives
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Construction.' It contains a circular disk made of a soft plastic material (mylar). This
plastic substrate is coated with magnetic iron oxide. The disk is enclosed in a square
jacket which protects the magnetic surface.

The surface of the disk is divided into number of concentric circles called as tracks and
each track is divided into number of sectors. Information can be recorded in the form of
tiny invisible magnetized (1) and non magnetized (0) spots. It uses standard 8-bit binary
code, i.e., EBCDIC for data recording. The disk is rotated at about 300 revolutions per
minute (rpm) and the read/write head is positioned to the appropriate track in order to
read or write data.

There is read/write window to provide read and write operation. On 3.5" floppy disk,
read/write window is covered by sliding metallic cover called as metallic shield. There
is write protect notch to protect the stored data. ln 3.5" disk, plastic button is used for
this purpose which can slide into either of two positions. One position permits reading,
writing and also deleting/erasing and other position permits only reading. The index
hole is used to locate the first sector of each track. A metallic diskette hub ring is fitted
at the center offloppy disk, used to protect the inner edge ofthe disk from spindle drive.

There is a hole at the center of disk called drive hole used by spindle drive which rotates
the diskette.

Inthe3Vz" floppy, there are 80 tracks and 18 sectors per track.

With 5 12 bytes per sector, the total bytes on both sides = 80 x 18 x 5I2 x 2

= 14,74,560, i.e., 1.44 MB.

High-capacity hole

Write-protect
hole

3.5 inches



Alignment
notches

Write protect
notch

Plastic hub
ring

Drive hole

Index hole

Read / write
window

Figure 4.10

Advantages
1 Since they are small and portable, they are easy to carry.
2. They can be used to take backups.
3. Used to transfer data between non-connected computers.
Disadvantages
l. They are very prone to dust and moisture and hence get damaged easily.
2. Cannot be used for storing large volumes of data.

Zip Disk

Figure 4.11:. Zip Disk and Zip Drive

5.25"
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Several other kinds of removable magnetic media are in use, such as the popular
Zip disk. All of these have a much higher capacity than floppy disks (A single ZIP disk
has the capacity of 70 floppy diskettes, that is 100 Mb). Larger files that are too big for
a floppy are now easily stored and transported via the ZIP disk. Zip disks come in two
capacities: 100 MB and 250 MB.

Uses of Magnetic Disks

1. These are used for storing application files based on random data processing.

2. For taking backups of data for off-line storage.

3. To transfer data between two non-connected computers.

4. It can be used as a shared on-line storage device.

For distribution of original software by the vendors. For this generally floppy disks and zip
disks are preferred.

Optical Storage Device

Compact Disk: It is an optical disk. The disk is made up of a resin such as polycarbonate.
It is coated with a material which will change its property when high intensity laser beams are
focused on it. The coating material is highly reflective, usually aluminum.

It uses laser beam technology for storing/retrieval of data and hence are also known as laser
disks or optical laser disks. For recording data, high intensity laser beams are used (25mW)
whereas for reading the data low/less intensity laser beams are used (5mW). In some cases,
separate laser beams are employed one for reading and other for writing.

To record data, laser beam at varying rate is tumed ON and OFF. As a result, tiny pits are
burnt into the metal coating of the disk surface along its tracks. The burnt pits are visible only
through a powerful microscope.

The beam is strongly reflected by land (the coated surface) and weakly reflected by the burnt
surface (pit). Pit bit represents '0' and land bit represents '1'. The reflected laser beams are
sensed by photodiode/sensor to read the data. Intensity of the reflected laser beams changes as

it encounters pits.

A pit spreads the light so that the sensor receives little reflected light. But the surface without
pit bit, i.e., land bit reflects sufficient light to the sensor. Thus change in reflected light is
sensed by sensor and converts it into electrical signals for reading the data.

CDs use long spiral track to store data serially. The track is divided into blocks of same size.

Storage capacity of a CD = Number of sectors * Number of bytes/sector



Advantages

i. High sroring capaciry, i.e., 650 / 700 MB.

ii. Removable from the computer.

iii. Cost-per-bit of storage is very lorv.

iv. More reliable than magnetic tapes or disks as its drive does not rub against the surface
of the disk.

v. Easy to handle.

The main disadvantage is longer access time as compared to that of magnetic disk.

Uses of Opticai Di,sks

l. These are used for storing application files based on raudom data processing.

2. For taking backups of data for offline storage.

3. For distributir,n of large amounts of data at low costs. Fbr exantple: original software by
the vendors, a complete encyclopedia or a dictionary.

4. For distribution of audio and vidco or both together. For excunpLe: songs, films. DVDs
are mainly used for distribution of mouics.

5. For distribution of multimedia like video sames.

Tl'te types rf optical disk are

i. CD-RON{ (Compact Disk Read Only Memory)

ii. WORM Disk/CD-Recordable disk: WORM is write-once-reacl-ruuny. These are often
used by banks to make a pennanent record of their applications.

iii. CD-RW - CD ReadAVrite Disk: It is similar to WORM disk except that the disk can be
written on rnultiple times. These are a great cost saver as they can be reused many
times.

iv. DVD - Digital Video (Versatile) Disk. It has a storage capacity of either 4.7 GB or 8.5

GB. it also supporls CPPM or Content Protection for Prerecorded Media security
technique to safeguard against copying.

In principle, botli CDS and DVDs are same but a DVD is denser in recording media.

DVD is of two types - single layer disk which has a storage capacity of 4.7G8 and double-
layer disk with storage capacity of 8.5 GB.

DVD also has many types like a CD.

These are DVD-R/I{W, DVD+R/RW, DVD-Video, and DVD-Audio.
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Figure 4.12: CDROM (Reading mechanism)

Figure 4.13: Spirat track of CDROM

Pen Drives/Flash Drives

USB flash drives are compact and easy-to-use devices that are similar in use like your computer hard
drive. USB flash drives slip into your pocket, conveniently around your neck o. on u keychain for
ultimate portable storage. USB flash drives finally fulfil the reai promise of the digital edge:
complete freedom and mobility.

Despite different brands and names available for USB flash drives - Jump drives, pocket drives, pen
drives and rhumb drives, they all pretty much operate the same way.

The difference is mostly.in price, capacity, design and functions and features (for example, some
have built in MP3 players).

;on
track



They are all pluggable, portable and powerful. USB flash drives share some other characteristics too.

i. Flash drives weigh about the same as a car key. In fact, some USB drives are so light weight
that hypothetically it could take 14 ants to carry one!

USB flash drives are about the size of a stick of gum.

USB flash drives currently can hold upto 2 GB of data, which is over 650 three-minute songs
(33 hrs), recorded as MP3s or about three times the content of a standard compact disk.

ff you share computer, USB flash drives are a great way to store personal information - Use
them instead of the computer's hard drive.

According to some manufacture's specifications, USB flash drives can maintain data for 10 years; in
that same period you will probably have to replace your computer hard drive three times.

Figure 4.14: USB Flash / Pen drive

3.2 Differentiate between Primary and
Secondary Memory

This is also known as Auxiliary memory.

The size of Secondary memory is comparatively
larger than that ol Primary memory.

It is slower than that of primary memory.

It is a permanent memory.

The data must be retrieved from a secondary
storage device and placed into RAM before
processing can begin.

Examples are magnetic tapes, lloppy disks, hard
disks and optical disks etc.

This is also known as Main memory or
Semiconductor memory.

The size of main memory is comparatively much
smaller than that of secondary memory.

It is very fast working memory.

It is a temporary memory.

CPU communicates directly with main memory,
because of less storage capacity, only the data
required for current processing is kept in main
memory.

Primary memory can be classified into RAM and
ROM.
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l. Write full forms of- EPROM, EBCDIC.

2. List Secondary Storage Devices and define any one device.

3" Write full forms of: i. ROM ii. PROM.

4 fuIarl*
: :::]::::: ;:i'.'1. !] ' '. l ll::]il:::::

l. Write a note on Hard Disk.

2. What is memory? Explain diff-erent types of Memory.

-?. Write a nore on Floppy Disk.

1. Dilferentiate between Primary and Secondary Memory.
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1. lmtrsduction

Ever since the invention of the computer was made. the study of "what" can be done and "how" it
can be done has been going on. This study has led to the discovery of rnany important design

methods.

ln order to perform a specific task, a sequence of actions have to be perfotmed in a logical order so

as to get the desired results.

This logical sequence of steps need to be followed, taking into consideration all possible occurrences

and events. An algorithm, which is the fundamental tool in Computer Science for writing a program,

is the focus of this chapter. We will study the concept of an "algorithm", its characteristics and its

use in detail.



2. Algorithm
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The word "algorithm" has a great significance in computer science'

It comes from the name of alersian author Abu Ja'far Mohammed

ibn Musa al Khowarizmi (825 A'D') who wrote a book on

mathematics.

It refers to a method that can be used by a computer for the sohrtion

of a problem. A lot of research has gone into developing different

utgo.irft-t for a variety of problems' ihe choice of a good algorithm

affects the efficiency of the program'

Detinition
An algorithm is a finite set of instructions that' if followed'

accomplishes a Particular task'

These instructions are written in a logical order' It is a method that

can be used by a computer for the solution of a problem'

1. Algorithm: To find the greater among two numbers'

Step L: Stat
Step 2: AccePt two numbers a and b

Step 3: If a > b, then

DisplaY "a is greater"

Else
Display "b is greater"

Step 4: StoP.

2. Algorithm: To find the average of 10 numbers'

Step 1: Start.

Step 2: Assign I to count.

Step 3: Assign 0 to sum.

Step 4: AccePt a number num.

Step 5: Add num to sum

Step 6: Increment count

Step 7: If count < = 10, then Go to Step 4'

Step 8: DisPIaY sum.

Step 9: StoP.



2.1 Gharacteristics of an Algorithm

All algorithms must satisfy the following criteria.

i. Finiteness: If we trace the steps of an algorithm, the
algorithm must terminate after a finite number of steps for all
cases. A related consideration is that the time for termination
must be reasonably short.

ii. Definiteness: Each step of an algorithm must be precisely
defined, i.e., each instruction must be clear and unambiguous,
i.e., it should have a unique meaning.

iii. Effectiveness: Each instruction must be sufficiently basic that it
exactly and in finite time by a person using only paper and pencil.

can in principle, be done

Example: Add numl to num2 is an effective operation if numl and num2 are integers, but if
they were real numbers with infinite decimal expansion, the instruction is ineffective.

iv. Input: An algorithm takes zero or more inputs; quantities that are given to it initially before
the algorithm begins or dynamically as the algorithm ru;rs.

v. Output: An algorithm generates one or more outputs; quantities that have a specified relation
to the inputs.

The first criterion states that an algorithm should contain a finite number of steps. This means that
the process must terminate at some point and that the time ror termination should be reasonably
short. For example,let us consider the popular game of chess. in this game, to find the winning
move, we have to consider all possible moves and counter moves. In such a case, even the fastest
computer will take billions of years to make the decision. Hence, the main concern is the efficiency
of the algorithm.

The second criterion is that of definiteness. This means that it must be perfectly clear whar should be
done. For example, steps such as "Multiply a or b with c" is not clear. To ensure this criterion,
algorithms are implemented using a programming language. Such languages are designed so that
each and every step has a unique meaning.

Criterion three requires the algorithm to be effective. This means that each step must be basic
enough. For example, integer arithmetic is an effective operation but operations on real numbers is
not effective since it may result in infinitely long decimal expansion. Criteria 4 and 5 require that an
algorithm should produce one or more outputs and have zero or more inputs that are "externally
supplied.

#o,
t
E
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F Sample Algorithm

Iluclids Alguritirin tu find CCD of trr.o positive iritegcrs m ancl n.

Stcp l: Start

Step 2: Divide nr by n and let r be the remaincler

Step 3: If r = 0, n is tlre answer, go to step 5

fitcp 4: Set nr +- n, n e- r, go to step 2

Stcp 5: Stop

Ana/3rsfs

!. iliuittncss: Tire abovc aigorithm tenriinates because after Step 2,r wtll be < n. If it is 0, the
proccss terminiltes. lf r * 0, n decreases in Step 4. This decreasing sequence will eveutuirlly
terrni|late.

2. Deliniteness: Since rn and n are positive integers, the division operation is sufliciently basic.
Tltc instructions will be definitc provideci that when Step 2 is executed, we must ensure that m
arrd n arc positive inLcgers.

3. Iil'i'cctivencss: Since integcrs can be representecl on paper in a finite nlanner and the division
opcration is kuown, the steps are ef'fective.

'9" Inputs: m and n are two inputs; both taken fi"om the set of positive integers.

5" Outputs: There is one outpltt, namely n, in Step 3.

g,A The lmportance cf Algorithm in program Design

'l'ht' itltportiince o1- algorithms in desigr-r of progranrs cannot be stressed enough. I1 orcler to solve a
cotnplex programtning problem, we canl'rot start writing the program directly. The flrst logical step
;r ould bc to pre pare an outline of how the problem can be solved.

'i'hc solution has to be specified as a sequence of actions, which have to be performed in a logical
()fdcr, to get the desired rcsults. These steps have to wrirten, taking into consideration all possible
{}ii-'rlll'ences and cvents. This can be written as an algorithm. The algorithm can then be tracecl to
r:irr.ili l'or errors and whother all possibilities of inputs have been considered or not.

\Vitt'ri ihis is dotte, it becomes easier to write the program based on the algorithm.
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2.3 The $tudy of Algorithms

The siudy of algorithms is very important branch of computer science. This study includes many

active areas of research in algorithms. There are four distinct aieas which can be considered:

1. How to devise algoriihrns?

2. How to validate aigorithms?

3. How to analyze algorithms?

4. How to test a program?

Let us consider each one of them in detail.

1. How to devise algorithms: Wdting algorithms is an art. There are several design techniques

rvhich help in designing good algorithms. These design strategies are extremely useful in
solving several complex engineering and mathematical problems. Some examples are divide

and conquer, backtracking, dynamic programming, etc-

2. How to validatc algorithms: The process of aigorithrn validation is the process by which it is
shown that the algorithm does yieid the corect answer for all possible legal inputs. C)nce the

validity of an algorithm has been proved, then the program can be written and the next phase

is called program verification.

3. How to analyze algorithms: Algorithm analysis is an extremely important aspect of writing
an algorithm. Algorithm analysis refers to the task of determining how much computing time

and storage an algorithm requires. This is a challenging area and requires mathematical skill.
Often, several algorithms can be written for the sante task. This study helps in making a
comparative study of the algorithms. It is also important to find out the petfonnance of the

algorithm in the best case, worst case and average case.

4. How to test a program: Once the program is writtcn on the basis of the algorithm, the

program has to be tested. Testing is done in two phases: Debugging and Performance
Measurement. Debugging is the process of removing the logical errors made irt a program.

This is done by executing the program for various sets of inputs and identifying the fault and

correcting it.

Perfonlance Measurement is the process of running a correct program on data sets and measuring

the time and space the program takes to give the results. This study is important to identity areas of
optimization so that the perlormaltce can be improved.



2,4 Relationship between Data Structures and
Algorithms

There is a very intimate relationship between data structures and algorithms. These two should be
considered as a unit; both are incomplete without the other.

The use of structured data makes it possible to use better algorithms. For example, if we have a list
of 'n' students, each having roll number and name, (Rr,Nr), (Rz,Nz), ,(Rn,Nn). If we want to
search for a specific roll number and display the corresponding name, then we would have to search
the entire list for the required roll number. This would obviously take a lot of time. However, if we
order the list according to roll numbers, then the searching process would be more efficient.

Another way of storing the information would be to have another list which told us where roll
numbers beginning with 1, 2, 3, . . ,9 respectively were. Thus, if we wanted to search for roll
number 753, we could directly start searching from the position where roll numbers beginning with 7
are stored, instead of searching the entire list. Thus, by changing the way data is organized, we can
use a different algorithm.

Thus, data structures and algorithms go hand-in-hand. For efficient programming, we have to gain
mastery of two techniques:

1. The ability to devise different forms of data representations.
2. The ability to write and analyze algorithms, which opeiate on that data structure.

We have to frst decide the data representation and then write the algorithm, which suits the data
structure.

2,5 Algorithm Design Tools

In the previous sections, we have seen what an algorithm it, what should be the characteristics every
algorithm must follow and we have also seen some examples. Let us now turn our attention to
different ways of writing algorithms and the design tools that can be used.

There are several ways to write an algorithm.

i. Use a natural language like English.

ii. Use graphical representations like Flowcharts.

iii. Use Pseudocode that resembles languages like C and Pascal.



Using a natural language like English is a universally accepted method. However care should be

taken to ensure that the instructions are definite. The algorithm design usually starts from general

statements which have to be refined subsequently into smaller, more definite instructions.

The use of graphical representations like flowcharts are also popular but they work well only if the

algorithm is simple and small.

Pseudocode is a combination of the free style algorithm and the structured nature of a program. It is
general purpose and does not depend on any programming language. However, it has a structure,

which has to be followed. Thus, the use of pseudocode closely models a program and hence,

developing programs from pseudocode is easier.

In the following sections, we will study the Flowchart in detail.

3. Flowchart rotl"'o-
1

The use of flowcharts is a very popular method of specifying the

solution to a programming problem.

It is a graphical representation of an algorithm. It is a diagrammatic
way of specifying the steps to be followed to achieve the desired

results.

It is a very effective method of showing the algorithm in a graphical

manner. From the flowchart it is very easy to understand the way the

process is carried out and to trace the sequence of operations for
various inputs. There are a large number of symbols used to depict

various instructions. These symbols are interconnected to each other

to form a single block of symbols. The process of drawing a

flowchart for an algorithm is known as flowcharting.

Definition

Flowchart is a pictorial or symbolic representation of an algorithm.
It shows the flow of the whole process, which includes the data

inputs, operations or computations performed, decisions taken and

the output generated.

Advantages of using Flowchart

1. The use of graphical symbols makes it easier to present the solution.

2. The process and data flow can be easily traced for all possible cases.
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3. Florvchafts are better way of communicating the logic of a system to all concerned.
4. With the help of flowchaft, probletn can be analyzecl in more c:ffbcilve way.
5' Program flowcharts serve as a good program documentation, which is neeclecl for various

pnlposes.

l"g*;

6. The flowcharrs act as a guide or blueprint during the systems
anaiysis and program development phase.

7. The flowchart heips in debugging process.

3.{ Flowchart $ymbols

The various symbols used in t-lowchar-ts are shown in the chart
bclow llong with their meaning.

s
Oct.11, AV 4Al/5M
Draw a symbols used in
Flowchart with their name
and purpose.

ocr.2CI10- 2M
Draw any four Flowchart
Symbols.

,.. ttipnte ;_,

Terminal lndicates start and stop of the process.

InpuVOutput Indicates an input or output task.

Process Contains Arithmetic or Assignment task.

Decision Indicates a condition and two or more
alternatives.

,nt
| | ----->
lJ<-- Flow lines Shows direction of flow of control.

Module call Used lor calling an external module.

Loop This indicates a loop strucrure.
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Let us study each one in detail with an exatnple.

1. Terminal Symbol

This syrnbol is used tr-r indicate the stafi and end of a l'lowchaft. Every f-lowchart has to have

one Start and one Stop s;"mbol.

To indicate the beginning of a flov;chart, we rvrite "STAld'f" within the oval as shown. To

indicate the end of'the flowchan, write "STOP" within the oval.

For a module. i.e.. function or sub-routine, instead of STOP, we write RETURN.

Example: e
T

Prooram code

I@
2. Input-outp ,, [-7

Any proglaln accepts certain infomation from the user when it runs, processes this

information lnd generates somc output.

This symbol is used for both, accepting information as well as displaying the output. In mriny

cases, we also have to clisplay certain nlessages. This symbol is also used display niessages for

the user.

Connector
It is used to connect different {lowlines o''

to show continuity of flowchart on set
pug*r' __

lndicates a block 0f statements.
I

I

I
Block

Multiway
selection

Ailows selection oi one out ol
alternatives.



3.

Acceot n numbers

t- 
-- 

r

Process i __ l
A program performs operations on data.

These operations are indicated using the above symbol. The operation is usually
assignment operation, which assigns the value of an expression to a program element.
Example:

Assign 1 to N

ComputeD=8"-4AC

4. Decision O
In a program, we may have to check for certain conditions and decide which operations are to
be performed if the condition is satisfied or not satisfied. This symbol is used to check for a
condition.

There are two paths, which the program may take.

One if the condition is True and the other if it is False. Thus, it is a two-way selection
statement. The condition is written within the diamond shaped symbol.
Example:

6* <#>*
Y,z 

rase \a,./ rarse

J 
rrue 

{ rrue



lfll5. Flowl,ines ll - ->
l0-

These alrows denote the flow of control. If we start from the START symbol and trace these
lines, they should lead to the STOP symbol.

6. Bxternal Module m
In many cases, a program may invoke or call extemal sub routines to perform certain
operations. The module can be called using this symbol. The name of the module is written
within this svmbol.

DISPLAY MAT

CALL FACTORIAL

7. Loop Statement

This symbol is used to indicate a loop or a reperitive structure.

It consists of three parts - the initial value, the termination condition and the action to be
performed. This followed by the block of statements are to be repeated. The block will be
repeated as long as the condition is True.

T---

The block of statements is enclosed in the svmbol: I

Examptei
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If rve have to choose between one of

8. Nlultiway Sclction

Let us now see some flowchafts using the above symbols

Program Flowchart

We have seeri tire t\r,.)-way selection synibol e:lrlier.
rnarry altelnatives, then we cln use this symbol.

All the choiccs are linaily joined using the connector symbol:

Exantple:

1. tr'lowchart to calculate area of a circle.

area=3.142 x radius x radius



Flowchart to check if a number is even or odd.

Flowchart to calculate sum of first N numbers, i.e., 1 + 2 + 3 +. . . + n



Adv a ntag e s of F lo w c harts

1. The use of graphical symbols makes it easier to present the
solution.

2. The process and data flow can be easily traced for ail possible
cases.

3. It is easy to understand the program rogic using a flowchart.
4. It is language independent and hence it is a generar-purpose toor.

5. Branching (Decision Making) and looping can be easily depicred.

Disadvantuges of Flow charts

1. Flowcharts are useful only if the algorithm is simple and small.
2. Usually the flowchart runs into several pages.
3. It is difficult ro make modifications in a flowchart.
4. The process is time consuming.

Solved Examples

1. To calculate roots of a quadratic equation.

A quadratic equation is ax2+ bx + c = 0.

The roots are calculated as

Case 1: If a = 0, invalid condition.
Case 2: bz - 4ac < 0, roots are imaginary.
Case 3: If b2-4ac = 0, roots are real and equal.
Case 4: If b2 - 4ac > 0, roots are real and distinct.

Algorithm

Step l: Start

Step 2: Input a, b, c

Step 3: If a = 0, then 
:

Display "Invalid"
goto step 8 

"
Step 4: Calculate d =bz - 4ac
Step 5: If d< 0 then

Display "Roots are imaginary,'
goto step 8



Step 6: If d= 0, then

rl = 12 =b/ 2a

Display rl and 12

Goto step 8

StepT: Ifd>0then

,1 _ 
_D+Vd

2a

'" - -b-Vd
2a

Display 11 and 12.

Step 8: Stop

d=b2-4ac

11 =-b+{E:
--'f_

r2 = -b -./A-_T



Write an algorithm and draw a flowchart to find the greatest
among three numbers a, b, c.

The greatest can be found by different methods, one of which is
given below.

Algorithm

Step 1: Start

Step 2: Input values of a,b,c

Step 3: If a is > b then

Assign a to max

Otherwise

Assign b to max

Step 4: If c is > max then

Assign c to max

Step 5: Display max

Step 6: Stop



3. To check whether a number is prime or not.

A number n is prime if it is divisible only by 1 and itself, i.e., it should not get divided by any
numberbetween Zton-I.

Algoithm

Step l: Start

Step 2: Accept number n

Step 3: Initialize prime to 1 (true)

Step 4: lnitialize i to 2

Step 5: If i > n-1, then

Go to step 7

otherwise

ffn is divisible by i

Assign 0 to prime (false)

goto step 7

Step 6: Increment i by I

goto step 5

Step 7: ffprime is 1

Display n is prime

else

Display n is not prime

Step 8: Stop



DisplayfirstnFibonaccinumbers: L l 2 3 5 9...
A Fibonacci number is obtained by adding the previous two Fibonacci numbers.

Algorithm

Step l: Start

Step 2: Accept N

Step 3: Assign 0 to fl
Step 4: Assign I to f2

Step5: If n= 1

display f2

goto step 14

Step 6: Assign 2 to counter

Step 7: Ifcounter > n, goto step 14

StepS: R=f2+fl
Step 9: Display f3

Step l0: Assign f2 to fl



Step I 1:

Step 12:

Step 13:

Step 14:

Assign R to f2

Increment counter by I

Go to step 7

Stop

t3=t2+t1

Counter=counter+1

Draw a flowchart to find factorial of a number.



6. Find the largest and smallest number from n numbers.
We will accept the n numbers one-by-one. The first number will be the maximum and
minimum. The remaining numbers will be compared with this to find the correct maximum
and minimum.

Step l: Start

Step 2: Accept n

Step 3: Accept num

Step 4: Assign num to max and min

Step 5: Assign 2 to counter

Step 6: If counter > n then

goto step 12

Step 7: Accept num

Step 8: If num > max then



Step 9:

Step 10:

Step 11:

Step 12:

Step 13:

Assign num to max

If num < rnin then

Assign num to min

Increment counter by I

Go to step 6

Display max and min

Stop

counter=counter+1
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Write an algorithm to print the sum of l to l0 numbers.

Start
Take variable A=l
Display A
A=A+ I
If A <= 10.

Then Go to Step 3

Stop

Draw a flowchart of print all odd numbers between 1 and
100.

Write an Algorithm to find factorial of a number.

Take a number as an input from the user.

Initialize a variable fact = l.

. Fact = fact * number.

. Number = number - 1.

Repeat step 3 to 5 if number >0.

. Print the value offact variable.

8.



Types of Programming Languages

A language is a system of communication. A computer language ts a

system of communication used for communication between
computer and people. With the help of computer language, a
programmer tells a computer what he wants it to do.

Computer languages are classified into following three categories:

4.1 Machine Language

These languages were the earliest languages developed. Features of Low Level Languages are

1. These languages are greatly hardware dependent, i.e., the code has to be written for specific
hardware.

2. Programs written on one machine will not run on another (Non-portable).

3. Programmers are required to have knowledge about the hardware as well.

It is one of the earliest language (1940s). All the computers use binary digits
(1 and 0) for performing internal operations. Hence, most computers' machine language instructions

consist of strings of binary numbers. ls and 0s indicate the on and off states of electronic circuit of
computer hardware. It is also called as low level programming language. These languages are

machine dependent or hardware dependent. This is the only language that the computer understands

without a translator. It is very difficult to remember the machine language instructions because they

are different combinations of l's and 0's. For programming in machine language, detailed

knowledge of hardware is essential.

Advantage

Since the computer circuits can directly interpret 0 and 1, execution of programs is very fast.



Disadvantages

l. Writing programs in binary is very difficult.

2. It is very easy to make errors during writing or data entry.

3. Debugging is very difficult.

4. There is no distinction between the instruction and operands or data.

5. It is difficult to understand the program logic by looking at the program.

4,2 Assembly Language

These were developed in the 1950s to remove the disadvantage of Machine Language. It is one of
the first step in improving the program preparation process. In these languages, small English like
words, called mnemonics were used for instructions (For example: ADD, SUB, etc) and
hexadecimal codes were used for data.

Assembly language provided pseudo-instructions in the instruction set for instructing the system how
the program needs to be assembled in computer's memory. With this feature, a programmer need not
keep track of storage locations of the data and instructions while writing an assembly language
program. Therefore, it is a language that allowed instructions and storage locations to be represented
by symbols and letters instead of binary numbers which is called symbolic language or assembly
language.

This is also machine dependent and vary from CPU to CPU. Programming using assembly language
also required detailed knowledge of hardware. The only advantage is its instruction set is in English
language like MOV, ADD, StlB, PUSH-----etc. Programs written in this language cannot be directly
executed by CPU.

+How this language is accepted by CPU as CPU only works on ls and 0s?

CPU cannot understand assembly language mnemonics. CPU only understands binary patterns.
Therefore Assembly language mnemonics are converted into corresponding binary patterns. This
conversion is done by using another program called as Assembler. Assembler is system software
supplied by computer manufacturers. The assembler is so called because besides translating, it also
assembles the machine language program in the main memory of the computer and makes it ready
for execution.

Figure shows use of assembler to convert Assembly language mnemonics into binary patterns.

Assembler takes assembly language mnemonics as input and provides corresponding binary patterns
to thb CPU.



Advantages

1. Writing of programs became easier.

2. Errors were reduced.

3. Identification and modification of errors became easy.

4. There was a distinction between instructions and data.

5. Programs could be easily understood.

6. Had the efficiency of machine language due to one-to-one correspondence between the
instructions of an assembly language program and its corresponding machine language
program. Hence, only the translation time required by the assembler would be extra.

Disadvantages

l. Because a computer does not understand symbolic language, it has to be translated to machine
language.

2. Like machine language, it is also machine dependent.

3. Knowledge of hardware required.

l/P assembly

Machine
language

instructions (Mnemonics) Binary pattern

Figure 5. 1

4.3 High-level Language

This language is machine independent or hardware independent.
languages does not require more knowledge of hardware and CPU.

HighJevel languages were developed to

1. Improve programmer efficiency.

2. Shift focus from the computer to problem solving.

3. Develop portable applications.

it-o,
I



Features of high-level languages

1. Do not require the programmers to know anything about the internal structure of the computer.
The programmer might even be completely unaware of the system on which his program will
actually run.

2. Use of English-like words for instructions.

3. Support to multiple data-types like characters, integers, real-numbers, etc.

4. Hardware independent instruction set (poftability).

5. Progmms have to be convetted from high-level language to machine language.

6. Conversion is done by special software (compiler or interpreter).

7. One high level language statement is translated into many machine language statements.
Therefore it is one-to-many translation.

Example: PASCAL, FORTRAN, COBOL, BASIC, JAVA, C, C++.

Advantages of High Level l-anguage

1. Machine independence: A program written in high level language can be executed on
different types of computers. Hence, the commercial software will have a larger market
because the software need not be restricted to one type of computer. Therefbre, the time and
effort spent on software development will fetch more results.

2. Easy: High level languages are easy to learn and use because of their similarity to natural
languages used by us. Also, usage of high level languages does not require the programmer ro
know the intemal details of a computer.

3. Few Errors: Since compilers and interpreters detect and indicate errors automatically, the
programs result in fewer errors and the programmer need not worry about other factors than to
concentrate on the logic of the program. The indicated errors can be corrected easily by the
programmer resulting in trror free programs in no time.

4. Low cost: All the phases of program preparation - coding, debugging, testing in high level
language require less time and effort than with a machine/assembly language.

5. Easy to maintain: Since programs written in high level language are easy to understand, it is
easy to locate, correct, and modify instructions whenever desired. Hence, major changes can
be incorporated with very little effort.

Disadvantages of High l*vel Innguage

l. Programs written in these type of languages have lower efficiency as compared to the
machine/assembly language. These programs result in multiple machine language instructions
taking more time to execute and also require more memory space. But with the advent of
efficient and optimizing compilers, this problem is almost non-existent now.



2' Most of the high level languages do not have instructions or mechanisms to control a
computer's memory, CPU, and registers. This lack of flexibility means that some tasks cannot
be done or can be done only with great difficulty.

As seen above, advantages of a
languages are used for writing
special tasks.

High levellanguage
program

(Source code)

HLL are much higher than its disadvantages. Therefore, high-level
most programs and assembly languages are used for doing only

5. Gompilers and Interpreters

Programs written in a high level language have to be converted into machine code in order to beexecuted' The software which does this translation is called a Compiler or Interpreter. Some high
level languages use a compiler whereas some use an interpreter.

Machine language
program
(Object code)

Figure 5.2: Language Translators for High- Level Language

5.{ Gompiler

A compiler is a program used to translate ahigh-level language program into machine language prior
to the execution of that program. The code 1or programmiig instructions) written in a highJevel
language is called the source code. The compiler-translates tliis source code into machine linguage
and the resulting code is known as the object iode. The object code produced by the compiler can be
executed or it can be saved. The saved object code can be executed liter as many times as desired.

A complier is a large program and requires more memory. It reads and translates the entire program
into machine codes rather than translating it line by line. it checks for syntax errors and some logical
errors before translating the source code into the object code.

Examples of high-level languages using compilers as PASCAL, coBol-, FoRTRAN, c, etc.

Compiler or interpreter



Object file

Figure 5.3

5.2 lnterpreter

An lnterpreter is also a system software. It is another type of language translator that is used to

translatei high level language program into its machine language equivalent. It translates the source

code into machine code line by line and immediately executes the translated line. It means that as

soon as first line of the code is translated by an interpreter the control unit executes the resulting

object code, then next line is translated and executed, and so on. It makes it a slow process as

compared to the compilation. But interpreters are simple to develop and require less memory. Thus it
can be used in a smaller system with less memory space.

The object code is not saved in this case. Therefore each and every time the source code is translated

and then executed line by line.
Examples of high-level languages using interpreter are BASIC, Smalltalk, etc.

so called as language processors since they are used

for processing language instructions.

1

A compiler takes the entire program and
generates the object code for the
orooram.

An interpreter takes a single instruction of the
program, converts it to object code and executes
ir.

2.
An intermediate object code file is

created.
No intermediate file is created.

3.
Once the object code is created,
the program need not be compiled every
time before execution.

every time a program is executed, conversion
from high level to machine code has to be
performed.

4.
A compiled program executes faster
especially if the program contains loops.

An interpreter is slower than a compiler.

5.
The compiler is not involved in

the execution of the program. An interpreter also executes the instruction.

6.
There is more memory requirement
since obiect files are created.

Memory requirements are less.

7.
A list of errors is generated after
the entire proqram is checked.

Errors are displayed for every instruction
interDreted. Therefore debugging is easier.

8. PASCAL. C use compilers. BASIC has an interpreter.



6. Gharacteristics of a Good Programming
Language

Several characteristics are needed to make a good programming
language:

i. Natural: A good programming language should be natural for
its use. For example, FORTRAN and COBOL are aptly
designed for use in scientific and business applications.

ii. Simple: Any good programming language should be simple
and easy to use and learn. But the power of the language
should not be given up for its simplicity.

iii. Bfficient: Programs written in a good language are translated
efficiently, and also execute efficiently. They also acquire less

space in the memory. Hence, a good programming language
comes with a good compiler/interpreter.

iv. Extensible: A good language should allow extensibility through subprogram definition
mechanisms

v. Abstract: A good programming language should allow for abstraction and reusability of the

code. Abstraction is the ability to define and then be able to use complex operations or

structures whereby allowing its details to be ignored. Higher the degree of abstraction, greater

is the ease in programming. For example, Object-oriented languages like C++.

vi. Compact: A good programming language is compact in style so that it is more concise in

nature and does not lose its readability.

vii. Environment suitable: Language defined for a particular type of application must also be

suitable to the environment of the application. For instance, a data-processing language should

be operative in batch-mode.

viii. Structured programming support: Programmers should be able to program in a good

programming language on the lines of structured programming concepts. This helps in
writing, testing and maintaining a program.



7. Software
Software is a general term for the various kinds of programs used to operate computers and related
devices. It is a set of programs that is used to operate on data. The term hardware describes the
physical aspects of computers and related devices.

A computer needs both, software and hardware for its functioning. Other than software and
hardware, there is something called firmware. These are the software (programs or data) that are
permanently stored on ROM. Firmware is thus combination of hardware and software.

7.1 Glassification of Software

Software is often divided into two categories

Application Software System Software

Word Processor

Spread Sheets

Database & Inventory
Management

Operating System

Language Translator

Utility Packages

Application Software: Includes programs that do real work for users. It is a software that has
been developed to solve a particular problem, to perform useful work on specific tasks, or to
provide entertainment.

For example, the commonly used application softwares are:

a. Editor: Notepad, Edit.

b. Word Processors: WordStar, WordPad, MS-Word, Lotus Word Pro

c. Spreadsheets.' Lotus - 123, MS- Excel

d. Database: dBase, Fox Pro, MS Access, Oracle, etc.

e. Presentation' Power point, free lance graphic

And apart of this the Desktop publishing software, Entertainment and education software also
fall under the category of applications software.



The applications such as Edit, WordStar, dbase, Fox Pro, etc, are DOS based softwares
Whereas the applications such as Notepad, WordPad, Ms- Word, Word Pro, Ms- Access are
Windows based software.

ii. System Software: System Software refers to all the programs which makes the computer
work. System software also controls the utilization of hardware resources and enables the
application software to run. Without system software, application packages cannot be run on
the computer system.

Well, it is the system software that enables the users and application software to interact with
the computer and helps the computer to manage its various resources. It acts as an intetface
betvveen the hardware of the computer and the application software that users need to run on
the computer.

The system software mainly includes the following:

i. Operating system: h is an integrated set of specialized programs, which is used to manage
resources and overall operations of a computer.

For example, DOS, Windows, UND( and Linux are operating systems.

ii. Utility program: It is a program, which assists in maintaining and improving the efficiency of
a computer system.

For example, Disk defragmenters, System Profilers, Network Managers and Virus Scanners.

iii. Language translator: It is a program which translates an Assembly Language Program or
high level language program into a machine language code and it also checks for language
syntax.

For example, Assembler, Compiler and Interpreter.

These are set of programs which are
written to perform a specific task (or a

System software is the code which makes
the computer work.

These programs are designed to suit the
needs of the user to perform a particular

programs are provided by the
manufacturers along with the computer
machine.

The performance of computer is not at all
concerned with application software.

The performance of computer system
depends to a large extend upon the system
software.

Application Softwares are easier to be
understood by normal users because they
directly deal with the normal real life

But the System Softwares are the software
which deals with the system or hardware.
For example, Disk Management Tools which
are used to partition or format the disk.

of system software Operating
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Draw a flowchart to find the largest of three'numbers.

Draw symbols used in Flowchart with their name and purpose.

Write an algorithm to print the sum of I to l0 numbers.

Draw a flowchart to find factorial of a number.

What is flowchart? Explain characteristics of Flowchart.
Explain Machine and High Level Language.

Write the definition of Algorithm.
Write the definition of Flowchart.

Draw any four Flowchart Symbols.

Define Algorithm.

l. Explain advantages and disadvantages ofFlowcharts.

2. Define an Algorithm. state any four characteristics of an Algorithm.
3. Draw a flowchart to print all odd numbers between 1 and 100. .

4. Write an Algorithm to find factorial of a number.

5. State advantages and disadvantages ofFlowchart.

6. Write an algorithm to print numbers in reverse order.

7. Draw a flowchart to check if given number is palindrome.

8. Explain different types of Programming Languages.

9. Describe the symbols used in Flow chart.

10. Define an Algorithm. state any four characteristics of an Algorithm.
11. Draw a flowchart to print sum of digits of a number.

12. write an Algorithm to print Multiplication Table of a given number.
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1. Introduction to O.S.

A computer system can be divided roughly into 4 components: hardware, operating system,

application programs and the users.

i. The hardware: CPU, memory, input output devices provide the computing resources.

ii. The application programs: Word processors, spreadsheets, and web browsers define the way
in which these resources are used to solve the computing problems of the users.

iii. The operating system: Controls and coordinates the use of the hardware among the various
application programs for the various users.

iv. Users: Include people, machines and other computers.

Definition

l. An operating system is a program that acts as an intermediary between a user of a computer
and the computer hardware. It manages the computer hardware.

2. An operating system is a layer of software whose job is to provide an environment in which a
user can execute desired program.



The main purpose of an operating system is thus to make the computer system convenient to the end
user.

Figure 6.1: Components of a Computer System

The hardware, the CPU (Central Processing Unit), the main memory, and the VO (Input/Output)
devices provide the main computing resources. The application programs such as database system,
business program define the ways in which these resources are used to solve the computing problems
of the users.

Operating system is the most important program that runs on a computer. Every general purpose
computer must have an operating system to run other programs. ff you have any hands-on experience
on a computer, you know the operating system must be loaded and activated before you can
accomplish other task. This emphasizes that operating systems are the most indispensable
component of the software interface between users and the hardware of their computer systems.

Operating systems perform basic tasks, such as recognizing input from the keyboard, sending output
to the display screen, keeping track of files and directories on the disk, and controlling peripheral
devices such as disk drives and printers.



The operating system controls and coordinates the use of the hardware among the various

applications programs for the end users. It plays an important role in managing CPU time, memory

space, files storage space, VO devices and many other resources and allocates them to specific
programs and users as necessary for tasks.

An operating system is a control program. A control program controls the execution'of user

programs to prevent errors and improper use of the computer. An operating system may be viewed
as an organized collection of software extension of hardware, consisting of control routines for
operating a computer and for providing an environment for execution of programs. Other programs

rely on facilities provided by the operating system to gain access to computer system resources, such

as files and VO devices.

The primary purpose of un op"ruting system is to maximize the productivity of a computer system by
operating it in the most effective manner and minimizing the amount of human intervention required.
An operating system also simplifies the job of computer programmer, since it includes programs that
perform common input/output and storage operations and other standard processing functions.

Many operating systems are designed as a collection of program modules, which can be organized in
combination with various capabilities around a central module, or kernel. Such operating systems
can be tailored to fit the processing power and memory capability of a cgmputer system and the type
of processing jobs that need to be done on it. For example, some operatfng sybtem package includes
a selected number of utility programs, language translator programs (compiler's and interpreters), and
even some application programs. Examples of poputir microcomputer4operating systems are

Ms-Windows, Ms-DOS, OS/2 for PCs and Mc OS for Apple computers,retc. Some examples of
operating systems for minicomputers are UND(, OS/400, etc. An example of an operating system for
a mainframe is MVS.

Operating systems vary in complexity from those that support single user inicrocomputers to those
that handle multi-user mainframes. Their complexity depends on the computer system's size and

scope, together with the type of performance provided to its users. A single stand-alone
microcomputer will have a relatively simple operating system, whereas a mainframe that supports
hundreds of users accessing the system simultaneously will have one that is far more complex. The
memory requirements and features included, however, very greatly across operating systems. Some

take up less than one I megabyte of space and lack even a full screen editor, whereas others require
hundreds of megabytes of space and include spell checkers and entire window system.

Hence, an O.S. can be summarized as an integrated set of programs that controls the resources of a
computer system and provides its users with an interface that is easier to use.



Evolution of Operating System

The first computers used batch operating systems, in which the computer ran batches of jobs without
stop. Programs were punched into cards that were usually copied to tape for processing. When the
computer finished one job, it would immediately start the next one on the tape.

Professional operators, not the users, interacted with the machine. Users dropped jobs off and then
returned to pick up the results after theirjobs had run.

This was inconvenient for the users, but the expensive computer was kept busy with a steady stream
ofjobs.

In the 1960s, time-shared operating systems began replacing batch systems. Users interacted directly
with the computer via a printing terminal like the Western Electric Teletype shown here.

Several users shared the computer at the same time and it spent a fraction of a second on each one's
job before moving on to the next. A fast computer could work on many user's jobs at the same time,
while creating the illusion that they were receiving its full attention.

Printing terminals required that programs had character or Command-Line User Interfaces (CLD, in
which the user typed responses to prompts or typed commands. The interaction scrolled down a roll
of paper.

Printing terminals were later replaced by video terminals that could only display fixed size
characters. Some could be used to create forms on the screen, but many simply scrolled like a "glass
teletype."

Personal computers became affordable in the mid 1970s. The Altair 8088, shown here, was the first
commercially viable personal computer marketed to individuals. Beginning in January 1975, the
Altair was sold to hobbyists in kit form. The Altair did not have an operating system, since it had
only toggle switches and light-emitting diodes for input and output.

People soon connected terminals and floppy disk drives to Altair's. ln 1976, Digital Research
introduced the CP/IvI operating system for the Altair and computers like it. CPA4 and later DOS had
CLIs that were similar to those of the time-shared operating systems, but the computer was dedicated
to a single user, not shared.

aA,s hardware prices fell, personal computers with birmapped displays that could control individual
pixels were developed. These made personal computer with graphical user interfaces (GUIs)
possible.

The first commercial success was the Apple Macintosh which was introduced in 1984. The initial
Macintosh pushed the state of the hardware art and was restricted to a small, monochrome display.

As hardware continued to evolve, larger, color Macs were developed and Microsoft introduced
Windows, their GUI operating system.



The Macintosh operating system was based on decades of research on graphically-oriented personal
computer operating systems and applications.

Ivan Sutherland's pioneering program Sketchpad in the early 1960s. Sketchpad foreshadowed many
of the characteristics of a modern GUI, but the hardware cost millions of dollars and filled a room.
After many generations of research projects on large computers and improvement in hardware, the
Macintosh became economically feasible.

Research prototypes like Sketchpad are still being developed at universities and in research labs.
They will form the basis of future products.

3.

1.

Functions of Operating System

User Interface: The most popular function of the O.S. is to
provide an environment for the user to work with the
computer. It acts as an interface between the user and ti t
computer. The O.S. should provide a User Interface witicir
could be Command Line or Graphical.

Command Interpretation: The O.S. interprets the user commands and directs sysrem
resources to execute the commands. The end-user, therefore, is not much concemed about the
basic hardware functioning of the system.

Resource Management: The operating system is a resource manager and has total control of
all resources. It controls the flow of data from input devices and to output devices. It also
manages the entire network and communication tools. It also manages the CPU time,
determines which resource is needed for which application, prioritizes it and allocates them to
keep a smooth flow of data and information.

When the user wants to run application programs, the O.S. should identify the priorities,
determine whether appropriate resources are available and allot the resources at the
appropriate time.

Memory Management: The Operating System has to manage the main (primary) as well as
the usage of the secondary memory devices like floppy, hard disk, CD-ROM, _q!9. It takes care
of allocation and de-allocation of memory space to programs in need of thlsiesotrrce.

File Management: The O.S. also manages filing activities like storage, retrieval, naming,
organization, sharing and even their protection.

J

3.

4.

5.



6.

7.

8.

9.

Process Management: The O.S. performs creation, deletion and scheduling of system
resources to different processes requesting them. It also synchronizes and communicates
between processes.

Security: The O.S. has to ensure that data and application are secure. This is done by user
logins and passwords, assigning rights to files. Making some files read-only or hidden files
providing appropriate warnings and security messages, etc.

Accounting Resource Usage: The O.S. logs memory usage so that the amount of free and
occupied memory can be known.

Providing Utilities and Services: The O.S. provides services that the user can use to control
the system' These services include File Services which enables the user to copy, move, delete,
rename files, system services to check the secondary disks for errors etc.

4. Types of Operating Systems

when operating system is viewed as resource manager, its functrons
include multiplexing or sharing resources in two ways: in time and
rn space.

l When a resource is time multiplexed, different programs or
users take turns or time slots using it. Determining how the
resource is time multiplexed - who goes next and for how
long - is the task of operating systems.

In space multiplexing, instead of customers taking turns, each
one gets part of resource. For example, main memory can be
divided into several running programs, so each one can be
resident at the same time. It is more efficient to hold several
programs in memory at once rather than give one of them all
of it, especially if it needs a small fraction of the total.

4,1 Batch Operating Systems

Running of several computer programs one after another without the need of human intervention to
run each program individually is called batch processing.

2.



A batch operating system accepts jobs and places them in a queue for execution. These jobs are

executed on a First-In-First-Out-basis. Jobs may also be assigned priorities in which case they will
be executed on the basis of their priorities. When the CPU time is available, these jobs are executed

serially. The O.S. has to keep track of the resources allocated to each job.

This method of execution is often time consuming since until one job is processed, the next has to

wait. This results in inefficient utilization of resources. To speed up processing, jobs with similar

needs were batched together and were run through the computer as a group-

Example

If a job is a printing job, the CPU will remain idle till the printing job is over'

To facilitate batch processing of control statements Job Control Languages (JCLs) were introduced.

Control statements were used by OS to identify a new job and its resources required, for execution.

These statements were written in JCL. Hence each program, besides the program itself has a set of
instructions called JCL instructions which help the user to identify the job.

Batch operating system was popular in mainframe computers of 1960s primarily used for
computations in science and engineering.

Spooling, an acronym for Simultaneous Peripheral Operation On-Iine, uses the disk as a huge

buffer, for reading as far ahead as possible on input devices and for storing output files until the

output devices are able to accept them. The Spooling is also used for processing data at remote sites.

The CPU sends the data via communications paths to a remote printer. The remote processing is

done at its own speed, with no CPU intervention. The CPU just needs to be notified when the

processing is completed, so that it can spool the next desired batch of data.

The Spooling overlaps the VO of one job with the computation of other jobs. Even in a simple
system, the spooler may be reading the input of one job while printing the output of a different job.

Spooling has a direct beneficial effect on the performance of the system. For the cost of some disk

space and a few tables, the computation of one job can overlap with the VO of the other jobs. Thus,

spooling can keep both the CPU and the VO devices working at much higher rates.

Figure 6.2: Spooling in Batch Processing



4.2 Multiprogramming

Multiprogramming is the capability of the CPU to execute more than one programs concunently.
Multiple programs are loaded into the main memory and the CPU allocates resources to each of them
(i.e., a different resource to each) and it monitors the activities. When any resource becomes free. it
is given to another program that requires it.

Multiprogramming operating systems succeeded batch operating systems. In this new O.S. a number
of programs belonging to different users are kept at the same time in distinct areas in the main
memory along with the monitor O.S.

This method requires more memory and extensive management. Appropriate security measures have
to be taken to prevent overwriting of data or wrong inputs to a program.

Example

The UNIX O.S supports multiprogramming.

All thejobs that enter the system are kept in thejob pool. This pool consists of all processes residing
on mass storage awaiting allocation of the main memory. ff several jobs are ready to be brought into
memory, and there is not enough room forall of them, then the O.S. must decide which of these
ready jobs should be allocated to CPU for execution. Making this decision is called job scheduling.
Multiple jobs running concurrently require that their ability to affect one another be limited in all
phases of the operating system; including process scheduling, disk storage and memory
management.

To increase resource utilization, actual multiprogramming system usually allows more than two
programs to compete for system resources at any time. The number of programs actively competing
for resources of a computer system is called the degree of multiprogrimming. Actually ttr" irigtr"i
degrees of multiprogramming should result in higher resource utilization.

A single user cannot, in general, keep either the CPU or the VO devices busy all times.
Multiprogramming increases CPU utilization by organizing jobs such that the CPU always has one
to execute. we can also display the multiprogramming in the followingfigure.

In multiprogramming system it is neeessary to prevent a process from writing in areas of memory
occupied by another program. For this reason, specific areas in memory are reserved for eacir
program. Also, the program is provided with a protection tockby the hardware. A process is allowed
to write in area of memory only if its key fits the protection lock. This hardware tie *"*ory prorcct
feature.



Figure 6.3: Memory Layout of Multiprogramming system

Multiprogramming systenls have better throughput as the CPU idle time is reduced considerably. But
this system requires following additional hiu'dware and software features:

1. Larger memory: Multiprogramming requires large rnain memory to accommodate large
number of user programs along with operating system.

2. Job status preservation: A multiprogramrning operating system maintains a process control
block (PCB) for each loaded process. Before taking away CPU from a running process and
giving to another job, its status is preserved in its PCB. The status is restored backbefore the
process resumes execution when CPU is given to it again later. Hence, the process can
continue execution without any problem.

3. Adequate job mix: There should be the right mix of VO-bound and CPU-bound jobs so as to
overlap the operations of CPU and VO devices effectively. The objective is to ensure that at
least one job is always available to utilize the CPU.

4. CPU scheduling: In a multiprogramming operating system, often there are many jobs waiting
for CPU allocation, but the O.S. must decide which of those ready jobs should be allocated to
the CPU for execution. CPU scheduler, a part of the operating system, takes this decision and
the algorithm used for it is called scheduling algorithm.

5. Memory protection: Multiprogramming should not allow a job in one memory partition to
change another job's programldata in another partition. This is called as memory protection
and is done with the help of hardware and software protection mechanism. This mechanism
restricts one job from addressing beyond the limits of its own allocated area.

4.3 Multitasking

Although multiprogramming and multitasking may look technically the same, the former is used for
multi-user .systems like mainframes and server-class systems; the latter is used for single-user
systems. Both multiprogramming and multitasking are performed by uniprocessor systems (having
only one CPU).



Under multitasking operating systems more than one task is loaded in the main memory' These tasks

share CPU time. Every program is assigned a fixed period of time called time slice. The CPU

allocates resources to a program for that period of time after which it switches to another program.

However, since switching is done very fast, it gives the feel of multiple programs running

concurrently.

The control is given to programs usually in a round robin manner. However priorities can be

assigned to each progum with the higher priority program being given more time slices.

Example

Windows 9x uses multitaskinq.

4.4 Multiprocessing

Multiprocessing involves simultaneous execution of several program segments of the same or

different programs.

Multiprocessing systems are of two types namely, tightly-coupled systems and loosely'coupled

systems.In tightly-coupled systems, there is a single primary memory shared by all processors while

in loosely-coupled systems, the processors do not share memory, and each processor has its own

local memory.

Multiprocessing systems are better performing, i.e., have a shorter response time and higher

throughput, and are more reliable than single-processor systems. If one of the processor breaks

down, the other processors take over the system workload automatically until the faulty processor is

repaired. Therefore, a complete breakdown of such systems can be avoided. But, these systems have

higher initial cost and their regular operation and maintenance is higher than the single-processor

systems.

Under multiprocessing, a single program is processed by multiple CPUs, called multiprocessor

systems. These systems execute multiple processes concurrently. These systems either process

instructions from different and independent programs or different instructions from the same

programs simultaneously.

Example

In the IBM PC, all mathematical computations are done by a math coprocessor. Similarly, in some

cases, graphics and multimedia is handled by a separate processor'



4.5 Multithreading

Under this scheme, different parts of a single program are run concurrently. The program is divided
into independent streams of execution called threads which are then run at the same time. All the
threads are owned by a single user.

Reasons for using a multithreaded process instead of single-threaded process are as follows:

1. The overheads involved (For example, creating address space) in creating a new process is
quiet higher than that for creating a thread within a process.

2. Due to the sharing of resources of O.S. and address space among the threads of a process, the
overheads involved in CPU switching among peer threads is much lesser than that in the case
of processes having their own address spaces. Therefore, the threads are called lightweight
processes and the processes are called as heavlweight processes.

Example

Window 9x uses multithreading

4.6 Real-Time

There are operations in which a computer is expected to control the operation of a physical system"
Hence, the control has to be exercised during the actual ftrnctioning of the system. Real-time O.S
have to work within strict time limits for critical jobs. Real time systems are required to be highly
reliable as any failure could be disastrous. Some real time applications are temperature controi, space
applications, monitoring systems, etc.

Examples

CTOS is a real time multitaskine O.S

4.7 Mu lti-user Operating System

Some systems allow multiple users to work at the same time. Usually, each user works at a terminal
connected to the main computer. The computer is usually mainframe or minicomputer.

The O.S assigns each user a portion of the RAM. Thus O.S switches between users in a time-sharing
manner.
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The O.S. has to have a very large RAM; it must keep track of the memory area of each user,
authenticate users and protect their data,

The advantage is that many users can gain access to central data.

Example

Staff of a company can access the central database of the company and view records.

4.8 Time Sharing System

It is a mechanism to provide simultaneous interactive use of a computer system by many users in
such a way that each one feels that he is the sole user of the svstem. This technique involves the use
of multiprogramming with a special CPU algorithm.

A time sharing system has many terminals connected to a single computer at the same time which
enables multiple users to connect to the system simultaneously. Multiprogramming allorvs multiple
programs to reside in the main memory simultaneously and the special CPU algorithm meant for
time sharing allocates a short period of CPU time to each user process. This time period is called as

time slice or quantum. The process'uses the CPU until the time slice expires, or it completes its
execution during this period.

A time sharing system needs a relatively large memory to perform multiprogramming. Although
time sharing systems are a little complex, they help reduce the CPU idle time and ensure quick
response time to all users.

1. A number of terminals should be connected to a system simultaneously for multiple users to
use it sirnultaneouslv in an interactive mode.

Large memory is required to support multiprogramming.

Memory protection mechanism to protect one job's instruction and data from the other.

Job's status information should be preserved when CPU is taken away from it, and restoring
this information back, when CPU is given to it again.

5. A CPU scheduling algorithm to allocate CPU for a short period to each user process in a
circular manner.

6. An alarm clock mechanism to send an intemrpt signal to CPU after every time slice.

2.

3.

4.
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1. These systems help in reducing CPU idle time and, in turn, provide increased system
throughput.

2. The special CPU scheduling algorithm used in a time-sharing system ensures quick response

time to all users. This helps in making interactive programming and debugging much simpler.

3. Small users can gain access to more sophisticated hardware and software then they could
otherwise afford.

5. Windows Operating System

5.{ Microsoft Windows

Hffi Microsoft

Figure 6.4

Microsoft Windows is a series of graphicat interface operating systems developed by Microsoft.

Windows based operating systems provide graphical user interface. It means that the user interacts

with the computer through graphical images (icons) rather than by typing commands. First Windows

3.X is developed by Windows O.S.



It was an operating environment, not an operating system. Windows 95 and 98 are later versions that
are true operating systems. The latest service packs for Microsoft Windows includes Windows 2000.
Windows XP, Windows Vista, Windows 7 and Windows 8.

5.2 Features of MS-Windows

l. Graphical User Interface: The Graphical-User Interface (GUI) is a type of user interface
which allows the users to interact with a computer system by the help -f graphical objects
(icons), menus, buttons, etc.

Clearly it is the easiest way to interact with the computers. GUIs relieve the user from
remembering and typing long and complex commands. They provide a more user-friendly
environment.

The Graphical-User lnterface (GUI) requires less amount of typing for routine jobs. A mouse
is more commonly used with the GUI. The user of the computei utilizes a pointing device, like
a mouse, to manipulate these icons and controls. This is considerably different from the
Command Line Interface (CLD in which the user types a series of text commands to the
computer (as in the case of DOS and tINDg.

2. Consistent User Interface: All the applications which run under the Windows environment
have the same look and feel. Hence it is easy to use different applications.

Multitasking: This O.S. provides the faci.lty of opening multiple applications at a time. The
O.S' manages the resources like CPU, memory, peripheral devices-fbr all the open tasks. A
user can switch from one task to another.

Data sharing between applications: The Windows O.S. provides a very important facility of
transferring data from one application to another.

This allows a user to insert pictures into a text based document, put graphs, charts in reports,
etc.

WYSIWYG (What You See Is What You Get): This means that the printed document will
look exactly as it is seen on the screen. This allows a user to create attractive documents,
reports, create graphical images, etc.

Other Utilities: The Windows O.S. provides a set of utilities which help the user in managing
files and hardware, provide help on all the features and applications, piovide accessories like
calculators, etc. to improve efficiency. These utilities are: WindowJ Explorer, Accessories,
and Control Panel, etc.

3.

4.

5.

6.,
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6. Gomponents of the Windows O.S.

6.{ Desktop

In the Windows O.S., a user sees and interacts with set.items on the screen. The desktop is the entire
screen area containing various objects (Icons, Windows, etc.)

Background
(with wallpaper)

Start button Application
button

Taskbar

Figure 6.5: Desktop

The user can change the desktop settings like background, color scheme, resolution, text appearance,
etc. It can be done by right clicking the mouse and selecting Properties or by selecting Start -+
Settings + Control Panel -+ Display.



This dialog box allows a user to customize the desktop and specify the rvay various components on

the desktop should look.

Backoround tab To set a wallpaper or a pattern as the background for th !99!Ap
Screen saver tab

A screensaver is a program that is activated when the computer is idle for

a lonq oeriod of time. This tab allows setting of a screensavqr' 

-

Appearance tab
To change the way items on the desktop look. Standard schemes can be used or

the user can soecifv his own color scheme for various elements on tle deg!!qp-
Effects tab

To change the appearance of a desktop icon, change visual settings for the
desktoo.

Web tab To add web content to the desktoP.
Settinos tab TochanqeScreenreso|ution,Screenarea,co|orsalo@

s
o?*2

r&.'s,

plK

ba
,es ttr

ss

Figure 6.6: Display Properties

6.2 lcons

Icons are pictures that represent

i. Parts of the computer like printers, files, directories, disk drives, etc.

ii. Software applications.



A user interacts with one of them by activating or selecting the coresponding icon with the help of a

mouse. Icons are displayed on the desktop as well as in tool bars, menus and taskbar.

Some o.f'the default icons are

.*.-..ICOO ':, .i

ffi My Computer Displays computer's contents.

w Recycle Bin
Recycle Bin is a storage place for deleted files.
They can be viewed or undeleted.

W Network Neighborhood
lf the comouter is connected to a network, networK

con{iguration and resources can be seen.

ffi CD ROM Drive Displays contents of CD-ROM disk.

Folder
Represents a directory which can contain files and
other folders.

lrilrn*llr{{lL{TEEI Program group Represents en executable file

Program File Represents an executable file

w Printer Represents Installed Printers

w Mouse Reoresents a mouse

IH File Represents a text file

ffiir:tT I

Word File Represents a Word Document

ffi DOS Application Represents a DOS executable file



6.3 Taskbars and Start Menu

When the Windows O.S. starts, the desktop contains a horizontal bar at the bottom (task bar).

This taskbar contains a button called Start which, when selected, displays a menu (list of choices)
called start menu.

The start menu contains an option called Programs. On selecting this option, a submenu is displayed.
This submenu contains a list of software applications

Note: An application can be started either by clouble clicking its icon from the desktop (if it is
present) or by selecting Start -> Programs -+ Application name.

Figure 6.7

Taskbar: Taskbar is horizontal bar appearing at the bottom of the screen and contains Buttons
representing programs cunently running on the computer. It contains a Start button on its
extreme left. On the right hand corner, it contains the icons of other utilities that are currentlv
running in the machines.

When an application is opened, a button for that program appears on the taskbar. This button
disappears when the application is closed.

Start Menu: This button is located on the extreme left of the taskbar. When you click the start
button, a cascading menu appears on the screen. Using this, we can begin using Windows.

1.

,



This menu consists of the following items.

Programs Displays a list of applications that can be opened.

Documents Displays a list of documents that have been recently accessed.

Settings Displays a list of system components for which settings can be changed.

Find Enables a user to find a file, folder, computer on the internet, mail message.

Help Starts the help application, which provides documentation about Windows.

Run . Starls a Program or opens a folder.

Shut Down . Shuts down or restarts the computer.

6.4 Application Window

Since Windows is a Multitasking O.S., many applications can be opened simultaneously.
Each application is represented on the desktop as a "window". The structure of the window is the
same for all applicatiorts.

Control box
Menu bar
Tool bars

Sizing
border

Left scroll
arrow

Status
bar

Minimize button
Title bar

ClienUuser area Horizontal scroll arrow

Minimize/restore
button

Close button

Up scroll
arrow

Scrollbox

Vertical scroll
bar
Down scroll
arrow

Right scroll
arrow

Figure 6.8

The various components are
i. Title Bar: This is at the top of the window and it displays the name of the application.

color suggests whether the application is currently active or inactive.
It's
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tu.

_Menu Bar: It is placed below the title bar and provides a horizontal list of options (which can
be selected using the mouse or the Alt button). on selection of a menu opti,on, a submenu is
displayed.
Control Box: This is on the top left corner of the window and provides a menu when clicked.

Figure 6.9: Control Box

Its options are

1. Restore: To bring the window to its original size if the window is enlarged.

2. Move: To move the window to any location on the desktop.

3. Size: The size of the window can be changed as per the requirements.
The sizing border can be used for this purpose

4. Minimize: If a user does not want to work with a particular window. it can be
minimized in order to reduce the number of open windowi on the desktop.

5. Maximize: This option expands the window to fit the desktop area.

6. close: An application can be closed when execution is to be stopped.

Minimize, Maximize/ Restore, Close Buttons: This appear on the top right corner and
perform the same functions as those in the control box.

Scroll Bars: If the client/ user data is too large to fit in the window, scroll bars are
automatically provided for navigation. They can be

L Horizontal scroll bar

2. Vertical scroll bar.

Status Bar: This is at the bottom of the window and displays status and error messages for the
user.

Sizing Border: When the window is not maximi zed, itcan be resized by using sizing borders.
Positioning the mouse on the sizing border makes a small two-headed urroiu uppJur, using
which the window size can be changed.

tv.

v.

vl.

vu.



6.5 Menus

A menu is a Windows component which provides the user a list of
options - each for a specific purpose or task. Various types of menus

are provided in Window Applications. These are:

i. Menu Bar

ii. Pull Down Menu

iii. Cascade Menu

iv. Shortcut Menu

i. Menu Bar

Figure 6.10: Menu Bar

Pull-Down Menu

When any item or option on the Menu Bar is selected, a

displayed. Unless the menu-bar option is selected, this menu

Oct.2008- 5M
What do you mean by a
Menu? Explain different
ttpes of Menus.

This is a horizontal list of options which is provided in all applications. Each option in the
Menu Bar can be selected using the mouse, arrow key or by using Alt + Underlined character.

ll.

sub-menu or pull down menu
will not be displayed.

is

Figure 6.11: Pull down Menu
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Cascade Menu

For a selected pull-down menu option,
menu is displayed. The option which
( ) ) indicating a cascade menu.

if there are more options to be selected from, a cascade
has a cascade menu contains an arrowhead at its risht

tv.

Figure 6_12: Cascade Menu

Shortcut Menu
This is a menu which is displayed by right_clicking the
displays certain options related to that component.
The diagram shows the shortcut menu for the Windows
desktop).

mouse on a Windows component. It

desktop (right-click anywhere on the

g
s
v
m

$&!$

rff

Figure 6.13:
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6.6 Toolbar

The toolbar is a horizontal bar which contains a number of buttons
with icons. It is displayed below the menu bar. It contains buttons
for some standard tasks as well as some application-specific tasks.

The buttons on a toolbar represent some commonly required menu
commands. In order to find out what task the button represents, the
mouse pointer can be positioned on it. A small box appear below the
button displaying its name (tool{ip).

Toolbars can be hidden if not required (Toolbar option of View
menu and activated when needed).

BoH (ar[rB)1.

-F-TooltipFigure 6.14: Toolbar

7. Running Windows Applications

A windows application can be executecl infour dffirent ways.

1' Using its icon: If the application's icon is present on the desktop, the application can bedirectly executed by double-clicking the icon.

Using the Programs option in Start menu: The application can be executed by selecting itsoption from the menu as follows.

i. Click on the Start button
ii. Select the Programs option
iii. From the submenu, select the name of the Application to be opened.

Using the run option

The start menu has a Rzru option. on selecting this option, a diatog box appears.

apr.tO,Oe - Snl
Oct.l0- 544
Explain the following
terms: :

i. Desktop ii. Menus ,

l: ;fi,*' iv. raskbar

.,

3.
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Figure 6.15: Run Option

The name of the executable file of the application has to be typed here.

Example: To open the MS WORD application, its executable file is Winword .exe.

If the exact location of the file is not known, it can be searched using the Browse button.

Using the DOS prompt

Just as in the DOS O.S., an application can be executed from the DOS prompt.

i. Click the Start Button.

ii. From Programs submenu, select the MS-DOS Prompt option.

iii. This displays the DOS prompt.

iv. Type the name of the application's executable file (by giving the appropriate path).

8. Switching between Appllcations

Since Windows is a Multitasking Operating System, it allows multiple applications to be opened at a

time. Each application is represented as a window on the screen (desktop). Thus, at any given time,
there may be zero or more Windows displayed on the desktop as shown below.

4.
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Figure 6.16

A button for each open application is displayed on the taskbar. Even though many applications
open, only one of them is 'Active'. The active application has a highlighted title bar.

To switch betvveen applications, several methods are available.

i. Click on the corresponding applications button on the taskbar to make it active.
ii. Press the Alt key and use the tab key to select the desired application.
iii. Press the Alt key and then press the Esc key till the desired window is visible.
iv. Click anywhere on the required program window's visible part.

Oct.2009 * 4M .. , 
:,

8.{ Gontrol Panel Explain Control Panel in
Windows O.S. :

This is a very important utilities application that provides a set of applications for managing
peripheral devices, adding / removing applications, configuring the system date, time and other
settings etc. The icons appearing in the control panel depend upon the hardware and software
installed in the computer.

It can be opened from Start -+ Settings -+ Control Panel

ni_
os
3
c
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The commonly used oDtilns are

i.
u.

ill.

iv.
Y.

Yt.

YII.

VIII.

lx.
x.

xl.
xlt.
xlu.
xtv.

xv.

xvl.
xvrr.
xvrlr.
xix.

Accessibility options

Add/New Hardware
Add/Remove Programs

Date/Time

Display

Find fast

Fonts

Internet option

Keyboard

Mouse

Multimedia
Network
Passwords

Power Management

Printers
Regional Settings

Sounds
System
Users

Changes accessibility options for the system.

Allows user to instalV remove hardware devices.

Installs/ Removes software applications.

Allows a user to view / change system date, time and time zone.

To change the way items on the desktop look.

Microsoft Find Fast content indexer.

Allows adding, deleting and viewing fonts in the computer.

Changes lnternet Settings.

Changes settings for the keyboard.

Changes settings for the mouse.

Changes settings for multimedia devices.

Configures network hardware and software.

Changes passwords and sets security options.

Changes Power Management Settings.

Adds, removes and changes printer settings.

Changes how numbers, currencies, date and time are displayed.

Changes system and program sounds.
Provides system information and changes advancOd settings.
Sets up and manages multiple users on the computer.
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Windows Accessories

The Windows Accessories are a set of useful tools and are normally comes along with the Windows
os.

Following are well

i. Calculator

iii. Game

v. Word Pad

known windows - Accessories tools that are supporled by all the windows oS.

ii. Paint

iv. Notepad

vi. Windows Explorer

A windows Calculator works exactly like a handheld calculator which comes in two versions. a
Standard Calculator and a Scientific Calculator.

To start a calculator, we have two options:

i. Start ->Run-+ type- calc

ii. Start -+ Programs ->Accessories -+ Calculator.

A Standard Calculator is used for normal mathematical calculations. Whereas the scientific
calculator provides all the operations in the standard calculator along with include advanced features
such as number base conversions, statistical analysis and trigonometric operations on data in
different number svstems.

Figure 6.18

User can use the standard calculator to perform simple calculations or
advanced scientifi c and statistical calculations.

in scientific view to perform

Standard calculator Scientific calculator
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The paint application in Windows is used for creating/ viewing/ editing bitmap images.

Created images can be stored and insefied into document, reports, etc.

It can be opened by selecting Start -+ Programs -) Accessories -+ Paint.

The window that is opened is as shown infigure.

i. The File Menu provides options open to new, open existing. save, print bitmaps.

ii. The View Menu allorvs viewing the Tool Box, Color Box, Zooming the bitmap, etc.

iii. The Edit lvlenu allows standard options like Undo, Repeat, Cut, Copy, Paste, etc.

iv. The Image option allows the image to be rotated, flipped, color inversion, stretch and skew.

v. The colors menu allows creation of a new color palette, adding/ removing colors to the palette.

Control box

Drawing area

Current color Color palette

Figure 6.19: The Paint Window

The Toolbox provides the following buttons

I. Free Form Select (or dotted polygon): Selects part of the picture in a free-form manner to
copy, move or edit.

2. Select (or dotted rectangle): Selects a rectangular part of the picture to copy, move or edit.



3. Eraser'. Erases a portion of the picture, using the selected eraser.

4. Fill: Flll an area with current drawing color.

5. Pick Color: Picks up a color from the picture for drawing.

6. Magnffier: Changes the magnification.

7. Pencil.. Draws a free-form line, one pixel wide. This tool is useful for drawing freehand

drawings.

B. Brush: Draws using a brush with the selected shape and size.

g. Airbrush: Used for drawing by spraying color of a selected size (i.e., width). The color can be

chosen from the color palette.

10. Zer: lnserts text into the picture. The font size and type can be changed by clicking the text

toolbar from View menu.

11. Line:Draws a straight line with the selected line width.

12. Curve.. Draws a curved line with the selected line width. Five line width are available.

13. Rectangle: Draws a rectangle with the selected fill style.

14. Polygon: Draws a polygon with the selected fill style.

1 5. Ellipse: Draws an ellipse with the selected fill style.

16. Rounded Rectangle'. Draws a rounded rectangle (the corners are rounded) with the selected fill
style.

Free-form select

Eraser

Pick color

Pencil

Airbrush

Line

Rectangle

Eclipse

Paste opaquely

Select

Fillwith color

Magnifier

Brush

Text

Curve

Polygon

Rounded rectangle

Paste transparently

Figure 6.20: Toolbox
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The Windows O.S. provides a special Games group which contains simple games. The four standard
games provided are as follows:

Solitaire: The object of Solitaire is to use all the cards in the deck to build up the four suit
stacks in ascending order, beginning with the aces.

You will be building row stacks and suit stacks.
Row stacks.' Cards are stacked in descending order, alternating between red cards and black
cards. For example, you can play the two of hearts on the three of clubs.
Suit stacks: Cards are stacked in the four areas at the top right ofthe screen in ascending order,
beginning with aces. For example, you can play the two of hearts on the ace of hearts.
You build row stacks to free up cards that you need to build the suit stacks. To move a card or a
stack of cards from one row stack to another, drag the card or stack To move a card to a suit stack,

, double click it or drag it.

, 
tigure 6.21

FreeCell: The game area consists of four home cells, four free cells and a deck of cards,
which is arranged in eight columns at the beginning of the game. The object of FreeCell is to
move all the cards to the home cells, using the free cells as placeholders. To win, you make
four stacks of cards on the home cells, one for each suit, stacked in order of rank. from Ace to
King.

A card from the bottom of a column can move to a free cell. A card from a free cell or from
the bottom of a column can move to a home cell. Moves to a home cell must be made in order
of lowest to highest, same suit. Aces can move to an empty home cell. A card from a free cell
or from the bottom of a column can. move to the bottom of another column. Moves to a
column must be made in order of highest to lowest, alternating suit colors.

ll.
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Figure 6.22

Minesweeper: The object of Minesweeper is to find all the mines as quickly as possible
without uncovering any of them.

The game area consists of the playing field, a mine counter, and a timer.

You can uncover a square by clicking it. ff you uncover a mine, you lose the game. If a number
appears on a square, it indicates how many mines are in the eight squares that surround the
numbered one.

To mark a square you suspect contains a mine, right-click it.

Remaining
mines

Time
elapsed

Figure 6.23

Hearts: The object of Hearts is to have the lowest score at the end of the game. You must play
a card in the same suit. If you do not have one, you can play any card. The person who plays
the highest card of the same suit as the first card played takes the trick.
At the end of each hand (completion of all tricks), you get one point for each heart in your
hand and 13 points for the queen of spades. The game continues until one player gets 100

tv.



points or more, or until the dealer quits the game.
spades in one hand (called Shooting the Moon), then
penalized 26 points.

If you win all the hearts and the queen of
you get zero points and each other player is

Figure 6.24

Notepad is a simple text editor included with all versions of Microsoft Windows since Windows 1.0
in 1985.

Notepad is a common text-only editor. It writes just text. You can use it to write letters, short
memos, resumes and other documents. The resulting files - typically saved with the .txt extension -
have no format tags or styles, making the program suitable for editing system files that are to be used
in a DOS environment. Notepad is distinguished from a word processor packages in that it does not
have much more formatting features. But, it usually refers to source code editors that include many
special features for writing and editing source code mainly by programmers, website designers, and
computer system administrators.

Features of Notepad

i. Notepad is a basic text editor that can be used to enter the text.

ii. Notepad is very simple, fast, reliable and easy to use.

iii. It does not have much formatting capabilities.

iv. At a time only one file can be opened or edited.

v. Notepad can not handle very large files.

vi Notepad uses little memory.



vii It provides the facility of Word Wrap. It automatically begins a new line of text once the

current line is full. When Word Wrap is turned on, the entire text that the user types, is visible
on the screen.

It can be opened by selecting Start -+ Programs *+Accessories -+ Notepad.
The window that is opened is as shown.

Menu Bar Options

Figure 6.25: Notepad

FILE

NEW To ooen a new text file Ctrl+N
OPEN To open an ex:sting File Ctrl+O
SAVE To save the Curre,'tl File Ctrl+S
SAVE AS To save the Current File by specifying the

location and File name
PRINT Setuo To setup the paqe before printinq

PRINT To orint the Current File Ctrl+P
EXIT To exit Notepad

EDIT

UNDO To undo the previous action Ctrl+Z
CUT To cut the selected text Ctrl+X
COPY To coov the selected text Ctrl+C
PASTE To oaste the cut or cooied texl Ctrl+V
DELETE To delete the selected texl Del
FIND To search a soecific Dattern in the text file Ctrl+F
Find Next To search the next occurence of the pattern F3
REPLACE To find and replace specific characters or

words.
Ctrl+H

GO TO To reach the soecific number of line Ctrl+G
TIME/DATE To insert current date and time at the current

oosition
F5

Select All To select the entire text Ctrl+A
FORMAT WORD WRAP To begin a new line of text once the current line

is full
FONT To select font settinos for the next

HELP Help Topics To qet the help on the topics related to notepad F1

About Noteoad To displav the information about the notepad



WordPad is a basic word processor that is included with almost all versions of Microsoft Windows.
It is more advanced than Notepad, but not as advanced as Microsoft Word. A word processor is a
computer program that you can use to create, edit, view, and print text documents. You can also
change how the text looks, quickly move sentences and paragraphs around, and copy and paste text
within and between documents. But lacks intermediate features such as a spell checker, thesaurus,
mail merge, support for tables, etc.

Features of WordPad

i. WordPad is a very basic text editor that can perform so many editing tasks like cutting and
pasting text, change the colour of a given font, etc.

ii. It has facilities to format and print text, but lacks intermediate features such as a spell checker,
tables, and mail merge.

iii. It is capable for creating and editing documents of any length.

iv. It is capable for formatting characters, paragraphs and documents.

v. It also provides the facility of word wrap.

To open WordPad, click the Start button, click All Programs, click Accessories, and then click
WordPad.

'The window that is opened is as shown.

Figure 6.26: The WordPad window

There are four main parts of the WordPad window:

i. The toolbar: The toolbar contains buttons for basic commands, including saving and printing.
To find out what a button does, rest yDur mouse pointer on it. A box pops up showing the
function of the button.

ii. The format bar: The format bar contains buttons that you can use to format the text in your
document. For example, you can choose the font, color, and alignment of your text.



iii. The ruler: Use the ruler to check the layout and placement of text in your document.

iv. The document area: This is where you type your document, make changes to the text, and
apply your formatting.

Windows Explorer is an application that is part of modern versions of the Microsoft Windows
operating system that provides a graphical user interface for accessing the file systems. It is the
component of the operating system that presents the user interface on the monitor and enables the
user to control the computer. Windows Fxplorer offers the easiest way of viewing files and folders.
Moreover, we can see the hierarchy of folders in Windows Explorer.

The Windows Explorer program can be activated from the start menu. To open the Windows
Explorer click Start -+ All Programs -)Accessories -sWindows Explorer.

The followingfigure shows the Windows Explorer window:

Folders
pane

Contents
pane

Figure 6.27

Windows Explorer has a two-pane window.

Folders Pane ii. Contents Pane



The left pane called Folders Pane contains the name of items with a plus or minus sign preceding the
item. When we click on plus sign, it will expand to show other folders in the hierarchy and the plus
sign will turn into minus sign and the contents of that folder are displayed on the right pane window
which is called Contents Pane.The contents can be selected and viewed. More than one window of
Windows Explorer can be opened at a time.

In Windows Explorer we can also organize our files and folders in a desired manner, move the files
from one folder to other or copy them, files or folder can be deleted or renamed easily.

{ O. Difference between DOS and Windows Operating
System

11. Linux O.S.

A very popular and common form of the UND( operating system is an operating system called
Linux. Now, Linux is a free operating system- you can download it off the Internet for free! Of
course, if you really want, you can also buy it at stores.

This O.S. provides a command line
interface.

It provides a graphical user inter{ace.

The user has to remember commands
and their syntax to perform a task.

A user has to click the corresponding icon
select the menu option to perform a task.

It is a single-task system, i.e., only one
application can be executed at a time.

It is a multitasking O.S., i.e., multiple tasks
can be opened at a time.

It is not possible to transfer or share Data can be easily shared among Windows

Since only one application is loaded in
memory at a time, memory

Memory management is complex since the
O.S. has to handle multiple tasks in memory.

The application gets the entire usage of
CPU and peripheral devices.

Resourcds have to be shared by multiple
tasks.

The size of the O.S. is very small.
The size of the O.S. is very large about
(200-300 MB).



As you know, different operating systems have different ways of interacting with the user- they all

havl different interfaces. There are different types of Linux operating systems. Some operate using a

graphical user interface like Windows and Mac OS. This means that there are icons and images that

represent certain programs, applications, and files.

All you need to do is use your mouse, point to the application you want to access, and click. In

addilion, some Linux operating systems use a command-driven interface, like MS-DOS. h this type

of interface, the user has to type in commands that they want the computer to carry out.

As stated above, there are many different types of Linux operating systems. Many different

companies produce and distribute this type of operating system, and they all add on their own unique

features.

Some of the most popular distributors of Linux include RedHat, Caldera, Suse, Mandrake, and BSD'

of the LINUX O.S

i. Linux is a freeware, i.e., it is distributed freely zurd its source

code is available to all users.

ii. It is a very stable O.S.

iii. Linux is extremely reliable and Linux servers are up for
hundreds of days without requiring reboots.

iv. Linux has very powerful features for a variety of tasks.

v. It comes with a complete development environment, including C, C++, Fortran compilers,

toolkits such as Qt and scripting languages such as Perl, Awk and sed.

vi. Excellent networking facilities: allowing you to share CPUs, share modems, etc.

vii. A large number of interfaces have been designed for Linux which provide good GUI and are

extremely user friendlY.

viii. The ideal environment to run servers such as a web server (e.g. Apache), or an FTP server.

ix. A wide variety of commercial software is available if user needs aren't satisfied by the free

software.

x. Linux is easily upgradeable

xi. Linux supports multiple processors.

xii. It is a true multi-tasking O.S., i.e., it has the ability to run more than one program at the same time.

xiii. Linux provides programming facility. The shell provides all features of a programming
language.
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4.
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toct.2011- 4M l. What is Operating Sysrem? Give any two functions of Operating

System.

IOct.2O10 - 4lv\ 2. what are the different types of Menus available in windows?
Explain any one.

Explain Control Panel in Windows O.S.

Define operating system. Explain different types of operating
Systems.
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1.

2.

Explain in short different types of Operating System.

what is an operating system? State different services provided by
an Operating System.

What do you mean by a Menu? Explain different types of Menus.

Which files make-up the D.O.S. Operating System? Explain.

Explain features of Linux O.S.

Explain the following terms

3.

4.

5.

6.

i. GUI

iii. Menus

v. Tool Bar

ii. Desktop

iv. Task Bar
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1. Introduction

Communication, whether between human beings, animals or computers, involves the transfer of
information. Communication between computers can be discussed in terms of different levels or
layers - at the highest level is the user, wanting to transfer information from one location to another,
while at the lowest level is information, in the form of bits, moving between computers.

The merging of computers and communication has had a profound influence on the way computer
systems are organized. The old model of single computers serving all computing needs of an

organization has been replaced by an interconnection of a large number of autonomous computers.
These systems are called Computer Networks.

Due to the tremendous impact of computers and networks on society during the past decade, this
period has come to be called, "The Information Age".

The productivity and profitability have been significantly enhanced by these revolutionary tools.

They are being used on an increasing scale to conduct personal and professional business.



Gomputer Network

A computer network is a system of interconnected computers and other devices which can
communicate which each other and share applications and date.

Here, the word interconnected means that the computers are linked with each other via same media
(physical or wireless). Physical media includes copper wires and co axial or fiber optic cables,
whereas wireless communication can be through microwaves, radio communications or satellites.

Today computer networks are highly used concept in most of the organizations, big or small, around
the world. Computer networks allow people to access information from the remote computer without
physically going to that remote location.

2.1 Network Goals

i. Resource Sharing: Modern organizations are widely dispersed with offices located in diverse
parts of a country and the world. In order to extract, co-relate and share information about the
entire organization, it is essential to connect the computers at all these locations.
The goal of resource sharing is to make all programs, data and equipment available to anyone
on the network regardless of the physical location of the resource and the user.

ffit--El
I=E=Eil---r--

I

ffitr:
@--r-

I

Sharing

l-rB-ltwlr---cl€---T--
I

Figure 7.1 : Resource

Laser prlnter



ii. Provide High Reliability: This can be achieved by having alternative sources of supply.
For example, replication of files on more than one machine ensures availability of files from
at-least one source. The presence of multiple CPUs means that if one fails, the other can take
over its work. This is very critical in military, banking, air traffic control and similar
applications.

iii. Distribution of Workload: If one computer becomes saturated with too much load, the work
can be distributed through the network onto other computers in the network.

iv. Saving Money: Small computers have a much better price to performance ratio as compared
to large ones. Thus, it is economical to set up a network of a large number of small computers
than invest in a few large ones. The data on the network could be kept on one or more shared,
powerful file server machines.

y. Expandability: The size of the network and the performance could be enhanced by gradually
adding more processors.

vi. Powerful Communication Medium: Using a network, it is easy for two or more people to
communicate effectively. This enhances human-to-human communication because far-flung
groups of people can easily exchange and share information, ideas and technology.

vii. Protecting Information: A network provides a more secure environment for an
organization's important data" They provide an additional layer of security by way of user
accounts, logins and passwords. Different levels of access can be set in a network.

viii. Preserving Information: Information can be backed up to a central location. It is difficult to
maintain regular back-ups on a number of stand-alone computers.

2.2 Applications of Gomputer Networks

i. Business Applications

a. One of the most important applications of a computer network for business is resource
shuing. This enables all programs, equipment and data available to anyone on the
network regardless of the physical location of the resource and the user.

b. A computer network provides a powerful communication medium among employees.
Daily communication can be done using e-mail; reports and other such documents can

be written together; video-conferencing enables employees at distant locations to hold
virtual meetings which eliminates cost and time.
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c. Companies can do business electronically with other cotnpanies, suppliers and

customers. This not only saves time and cost but also reduces the need to hold large
inventories, resulting in enhanced efficiency.

d. One major emerging application of computer networks is e-commerce, i.e., doing
business with consumers over the Internet. Banks, Airlines, Bookstores, Retailers, etc

allow consumers to do business from home by providing on-line catalogs and taking
orders online.

Home Applications: Four most popular uses of a computer network for home users are as

follows:

a. Access to remote informntion: This includes surfing the World Wide Web for
information like science, spons, fiavel, entertainment, arts and a wide range of subjects,

accessing online libraries, reading newspapers, magazines and journals. Al1 these

involve interaction between a person and a remote database.

b. Person-to-person communication: This is by far, the most important reason for the

widespread use of computer networks. It includes e-mail and chatting or instant
messaging which are used on a daily basis by millions of people. Audio, video, text and

pictures can be exchanged in real time.

Newsgroups are commonplace, where discussions on any topic can be held among a
select group of people. Internet telephony enables users to talk over the Internet.
Another popular and growing area is e-learning.

c. Entertainmerer: This is a huge and growing industry. An emerging application is video
on demand where it is possible to select any movie or television program and have it
displayed on screen instantly. Interactive films and television programs will become

common place. Another important application is playing games which may be

multiperson real-time, three-dimensional which enables us to have a worldwide shared

virtual reality.

d. Electronic commerce: In recent times, more and more home users are doing home

shopping by accessing on-line catalogs. People access financial institutions, pay bills,
handle investments, manage bank accounts electronically. As networks grow more

secure, electronic commerce is sure to increase.

2.3 Basic Elements of a Gommunication System

Communication is the process of transferring messages from one point to another. The basic

elements of any communication system are given below:
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Sender: It is the computer that is the source of the message or information. It transmits data
on the Network for a particular node or a group of nodes.

Receiver: It is the computer on the network that receives the data sent by the sender. The
receiver may be a few meters away from the sender or it can be thousands of miles away.

Message: The message is the information (data) to be communicated. It can be text, numbers.
pictures, sound, video or any combination of these.

Medium: It is the channel or physical path through which the message is carried from sender
to the receiver. The medium can be wired like twisted pair wire, coaxial cable, fiber-optic
cable or wireless like laser, radio waves, and microwaves.

Protocol: It is a set of rules that govern the communication between the devices. Both sender
and receiver follow same protocols to communicate with each other.

Y.

Protocol
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Figure 7.2

3. Gommunication Modes

Computer communication means transfer of data from a source device to a receiver device across a
distance located in the same premises or at the other end of the world, via cables and/or satellites.
This data transmission takes place by means of electrical signals in digital or analog form.



3.{ Analog Signal

An Analog Signal is an electrical signal in the form of a continuous wave, known as camer wave.

These carrier waves are distinguished on the basis of two properties:

i. Amplitude: Amplitude is the height of the wave during a given time period. It is actually the

strength of the wave.

ii. Frequency: It is the number of times a wave repeats during a specific time interval.

Frequency is measured in cycles per second.

Figure 7.3: Analog Signal

3.2 Digital Signal

Digital signals are also electncal signals, but it uses only two states "ON" or "OFF" (Binary Form)

in discontinuous or discrete manner.

Digital describes electronic technology that generates, stores and process data in terms of two states:

i. Positive: It is expressed or represented by the number 1 and,

ii. Non-Positive: It is expressed or represented by number 0.

Thus data transmitted or stored witb digital technology is expressed as a string of 0's and I's.
Thus digital signals are more efficiently used to represent the binary data as used in

computers. Also digital signals are faster and more accurate than analog signals.

Figure 7.4: Digital Signal
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Data Transmission

Data transmission refers to the movement of data in the form of bits between two or more digital
devices. This transfer of data takes place via some form of transmission media (for example, coixial
cable, fiber optics, etc.).

Serial transmission: In serial mode of transmission, data bits are transmitted sequentially, one
after another. It is a slow but more economical data transfer method for large distances. It is
the method used in communication lines and modems.

Data transmission is of two types: ffi

W c#n
Parallel Serial

I

-

Asynchronous Synchronous

Figure 7.5
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Parallel/serial
convener

Serial/parallel
convener
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Figure 7.6

Parallel transmission: ln Parallel transmission, several bits are transmitted through separate
lines simultaneously, i.e., data bits are sent at the same time along multiple paths. This type of
transmission is not appropriate for long distance transmission. It is not economic because
when distance increases, the wire cost also increases. This is faster than its serial counterpart.
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Figure 7.7

4.1 Types of Serial Transmission

Direction of flow

1l 11111011 l0

I_ryT_?l_"..:i"l *,*" j Serial transmission occurs in one of rhe rwo ways:
IranSmlSSlOn ' ,;,ij ';
i. Asynchronous mode i. Asynchronous mode: In Asynchronous mode data is
ii. Synchronous mode transmitted one byte at a time. Bit synchronization between

two devices is made possible by using two additional bits with
each byte to indicate the beginning and the end of each byte.
These additional bits are called start and stop bits.

Addition of start and stop increase the number of data bits. Hence more bandwidth is
consumed in asynchronous transmission. There is a gap between each byte. It is a slow
method as compared to the synchronous transmission.

110001011110

data units

Figure 7.8: Asynchronous transmission
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ii. Synchronous mode: In synchronous mode , data is sent in blocks. Synchronous transmission
does not use start and stop bits. ln this method, bit stream is combined into longer frames that
may contain multiple bytes. There is no gap between the various bytes in the data stream. In
the absence of starl and stop bits, bit synchronization is established between sender and
receiver by 'timing' the transmission of each bit. Since the various bytes are placed on the link
without any gap, it is the responsibility of receiver to separate the bit stream into bytes so as to
reconstruct the original information. In order to receive the data error free, the receiver and
sender operates at the same clock frequency.

Figure 7.9: Synchronous transmission

5. Direction of Transmission

''*- " ,'-,Threetypesof : .,i
transmission , ' ,

i. simplex '

ii. Half duplex
iii. Full duplex

.1:.

When there is communication between two computers, it can be of three types

i. Simplex: Data can travel only in one direction in the simplex mode. Radio and TV broadcast
are the common examples of simplex transmission. In both the cases, the signals are

transmitted at only one end and our devices only receive them. There is no return signal and
we can not interact with the transmittins devices. This mode of flow of information is
Unidirectional.

Figure 7.10: Simplex transmission

Hatf-duplex: In half duplex transmission, data can travel in both directions at a time. This is
the most common method of data transmission and used in many applications, The

ll.

Direction of flow

(only in one direction)
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conversation on Walkie+alkie used in earlier days is an example of half duplex transmission.
Thus a half-duplex line can alternately send and receive data.

Figure 7.11: Half duplex transmission

Full Duplex: In full duplex transmission, data can travel in both directions at the same time.
A very familiar example of full duplex transmission is two persons talking on the telephone.
We can talk (send data) and listen (receive data) at the same time. Use of full-duplex line
improves the efficiency as the line turn-around time required in half-duplex arrangement is
eliminated.

Full duplex transmission

(in both directions at the same time)

Figure 7.12: Full duplex transmission

6. Data Transmission Media

..d

Transmission media is a pathway that carries the information from
sender to receiver. we use different types of transmission media
(cables or waves) to transmit data. Transmission media is also called
Communication channel.

Transmission media is broadly classified into two groups.

Twisted pair Coaxial cable Ootic fibers Radiowaves Microwave Infrared

Figure 7.13

Half duplex transmission

(in both directions but not simultaneously)



Wired or Guided Media: Guided media are the cables that are tangible or have physical existence
and are limited by the physical geography. Popular guided media in use are twisted pair cable,
co-axial cable and fiber optical cable. Each of them has its own characteristics like transmission
speed, effect of noise, physical appearance, cost, etc.

Twisted-pair is a type of cabling that is used for telephone communications and most modern
networks. A pair of wires forms a circuit that can transmit data. The pairs are twisted to provide
protection against crosstalk, the noise generated by adjacent pairs. When a wire is carrying a current,
the current creates a magnetic field around the wire. This field can interfere with signals on nearby
wires. To eliminate this, pairs of wires carry signals in opposite directions, so that the two magnetic
fields also occur in opposite directions and cancel each other out. This process is known as
cancellation.

Two Types of Twisted Pairs are Unshielded Twisted Pair (UTP) and Shielded Twisted Pair (STp).

i. Unshielded Twisted Pair (UTP): UTP is a very flexible, low cost media, and can be used for
either voice or data communications. Unshielded twisted-pair consists of four pairs of thin,
copper wires covered in color-coded plastic insulation that are twisted together. The wire pairs
are then covered with a plastic outer jacket. Its greatest disadvantage is the limited ban<lwidth,
which restricts long distance transmission with low error rates.

Jacket Twisted pair Bare wire

Figure 7.14: Unshielded Twisted Pair

Shielded Twisted Pair (STP): STP is heavier and more difficult to manufacture, but it can
greatly improve the signaling rate in a given transmission scheme. Twisting provides
cancellation of magnetically induced fields and currents on a pair of conductors. Shielded
twisted pair cable consists of one or more twisted pair of cables enclosed in a metal foil or
braided mesh to cover each pair of insulating conductors. This is known as metal shield. It
reduces the interference of the noise but makes the cable bulky and expensive.

|l.
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Twisted pair

Figure 7.15: Shielded Twisted Pair

Advantage

This is the cheapest form of wiring.

I)isadvantages

1. It is not efficient for very long distances.

2. The noise level is high because of electrical interference.

It is commonly known as "co-ax". Coaxial cable is an electrical cable consisting of an inner
conductor covered by an insulator and surrounded by a cylindrical conducting shield and usually
surrounded by a final insulating layer (acket). They are highly insensitive to EMI and support high
bandwidth. They can withstand harsh environment. They are bulky and expensive. The TV cable is a
coaxial cable. These cables are also used in LANs.

They can carry voice and data at a faster rate (up to 200 megabits per sec) as compared to that of
twisted pair wire (16-100 megabits per sec). Thus coaxial cables can be used for transmitting data to
longer distances at higher speeds.

Coaxial cables do not produce external electric and magnetic fields and are not affected by them.
This makes them ideally suited, although more expensive, for transmitting signals.

Jacket Shield Insulator Center
conductor

Figure 7.1 6: Coaxial Cable



There are two kinds of coaxial cables in use:

i. Baseband (50-ohm cables): These cables are used for digital transmission. Baseband is a

light and flexible cabling medium that is inexpensive and easy to install.

ii. Broadband (0.5 ohm cables): It is a cable used for analog transmission such as cable TV
networks. Since it is thick, it does not bend. It can carry more signals and at a larger distance.
This cable is more expensive.

Fiber optic cable is a thin flexible fiber made up of glass or fused silica which is an ideal cable for
data transmission. Fiber optic cable transmits light signals rather than electrical signals. This cable
has high bandwidth. It has no problem with EMI and cable runs over several kilometers. Each fiber
has an inner core of glass or plastic that conducts light. The inner core is surrounded by cladding, a

layer of glass that reflects the light back into the core. Each fiber is surrounded by a plastic sheath.
The sheath can be either tight or loose. Loose configuration leaves a space between the sheath and
the outer jacket, which is filled with a gel or other material. Tight configuration contains strength
wires between conductor and outer plastic encasement. In both cases, the plastic encasement must
supply the strength of the cable while gel or strength wires protect the delicate fiber from mechanical
damage.

Receiver

Figure 7.17: Optical fiber

Advantages

1. Transmission through optical fiber is fast.

2. Light pulses are not affected by random electromagnetic interference in the environment.

3. Rate of errors is minimized to a great extent.

4. A fiber optic cable is light in weight and more durable.

5. It provides better security measures because it cannot be easily wire tapped or listened into
like other cables.

6. More suitable for transmission of large volume of data at a high speed over long distances.



Disa.dvantages of Optical Fiber

l. It is more expensive as compared to twisted pair or coaxial cable.

2. It lacks flexibility so it is difficult to bend around corners.
a

Wireless or Unguided Media: Unguided media are the ways of transmitting data without using any
cables' These media are not bounded by physical geograptry. This type Jf transmission is called
Wireless communication. Nowadays wireless iommunication 

- is becoming popular.
This transmission uses Microwave, Radio wave, lnfra red are some of popular unguided media.-

It^ Yf9, electromagnetic radiation to transmit data. Radio waves have frequencies between
10 kilohertz and I gigahertz.rt does not require a direct physical connection beiween computers.
Radiowaves are omni directional, i.e., they travel in all thi directions from the source. Because of
this prope(y, transmitter and receiver need not be aligned. Radiowaves can penetrate buildings
easily, so they are widely used for communication both indoors outdoors.

The applications of Radiowaves include AM and FM radio, television, cordless telephone, cellular
phones, paging and wireless LAN.

Microwave communication refers to electromagnetic energy having a frequency higher than radio
frequencies to transmit data through space. It produces uetteithroughput and performince. These are
generally used to link metropolitan cities as data transmission speeds are about 16 Gbps.
Microwaves operate at high operating frequencies of 3 to l0 GHz. This allows them to carry large
quantities of data due to their large bandwidth.

There are two types of microwave data communication system:

i. Terrestrial Microwave: Terrestrial microwave svstems
typically use directional parabolic antennas to seni and
receive signals in the lower gigahertzrange.

-rrnii"tvpg. 
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Because they do not use cable, microwave links often connect separate buildings where
cabling would be too expensive, difficult to install, or prohibited. For exnmpti, if two
buildings are separated by a public road, you may not be able to get permission to install cable
over or under the road. Microwave links would be a good choicein tiris type of situation.

ii' Satellite: Satellite microwave systems transmit signals between directional parabolic
antennas. Like terrestrial microwave systems, they use low gigahertz frequencies and must be
in line-of-sight. The main difference with satelliti systems ii inat on, ant"nnu is on a satellite
in geosynchronous orbit about 36,000 km above the earth surface. Because of this, microwave
systems can reach the most remote places on earth and communicate with mobile devices.
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Infrared media use pure light, normally containing only electromagnetic waves or photons from a
small range of the electromagnetic spectrum. It is limited to a small area. Infrared media use infrared
light to transmit signals. LEDs transmit the signals, and photodiodes receive the signals. The
remote control we use for TV, VCR and CD players use infrared technology to send and receive
signals. Some common applications of infrared technology are Car locking systems, Environmental
control systems, Headphones, Home security systems, Telephones, TVs, VCRs, CD players,
stereos, etc.

Infrared light is transmitted either:

i. Point-to-Point: Infrared beams can be tightly focused and directed at a specific target.

Laser transmitters can transmit line-of-sight across several meters.

Using point-to-point infrared media reduces attenuation.

ii. Broadcast: Broadcast infrared systems spread the signal to cover a wider area and allow
reception of the signal by several receivers.

One of the major advantages is mobility; the workstations or other devices can be moved more
easily than with point-to-point infrared media.

Infrared light can be transmitted across relatively short distances. Remote control of TV uses
infrared transmission.

Figure 7.18: Satellite Communicaticn System



Advantages

1. It has low power requirements therefore ideal for laptops, telephones, personal digital
assistants.

2. No special or proprietary hardware is required, can be incorporated into the integrated circuit
of a product.

3. Directionality of the beam helps ensure that data isn't leaked or spilled to nearby devices as it's
transmitted.

Disadvantages

1. Transmitters and receivers must be almost directly aligned (i.e., able to see each other) to
communicate.

2. Common materials like people, walls, plants, etc. can block transmission.

3. Performance drops off with longer distances.

4. Direct sunlight, rain, fog, dust, pollution can affect transmission.

7. Network Structure

In this section, we shall try to understand the different types of
networks and how they cperate. To do so, we must understand how
networks are structured and what Transmission Technology is used.

Networks can be classified according to their scale, i.e^, the distance
or area they cover.

There can be three types of networks:

1. Local Area Network (LAN)

2. Metropolitan Area Network (MAN)

3. Wide Area Network (WAN)

The following table gives an idea about the scale of various networks.
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7,1 Local Area Network (LAN)

i. A LAN is a privately owned network within a single building or a campus, spanning a few
kilometers in area.

ii. Their communication speed ranges from 10 Mbps to 100 Mbps (Mega bits per second).

iii. The main use of LAN is in organizations to connect several PCs in order to share resources
like: Files, Applications, Hardware resources.

iv. LAN can be of two types

a. Server based.LAN: Here, a separate computer is set aside as the server which processes
requests from many clients or workstations.

b. Peer-to-Peer I'AN: All computers on the network act as resource providers and users.

Cable
end

Figure 7.19: Local Area Network



7.2 Metropolitan Area Network (MAN)

A Metropolitan Area Network (MAN) a relatively new class of network, it serves a role similar to
an Internet Service Provider, but for corporate users with large LANs. There are three important
features which discriminate MANs from LANs or WANs:

i. The network size falls intermediate between LANs and WANs. A MAN typically covers an
area of between 5 and 50 km diameter. Many MANs cover an area the size of a city.

ii. A MAN (like a WAI{) is not generally owned by a single organisation. The MAN, its
communication links and equipments are generally owned by either a consortium of users or by a
single network provider who sells the service to the users.

iii. A MAN often acts as a high speed network to allow sharing of regional resources (similar to a
large LAN). It is also frequently used to provide a shared connection to other networks using a
linkto a WAN.

Figure 7.20: Metropolitan Area Network

Public city Network



7.3 Wide Area Network (WAN)

They span a wide geographical area; often a country or continent. It is also called "Long Haul
Network".

Typically, a WAN is a connection of multiple LANs. In some cases, the WAN may not include any
LAN; it could also be a separate network.

For communicating over such long distances, the WAN uses high speed telephone lines or wireless
technologies such as satellites.

The machines on a WAN (called hosts) are connected to each other via a communication subnet.
These subnets consist of

i. Transmission lines

ii. Switching elements like routers, gateways, etc.

The subnets uses store-and-forward method to transfer data from one host to another.

Figure 7.21: Wide Area Network
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8. Network Topologies

8.{ Topology

There are different ways in which the computers are connected in a LAN. 'The term network
topology ref'ers to the manner in which nodes are geometrically arranged and connected with each
other in a network."

There are various topologies where each has its own particular advantages and limitations in terms of
reliability, expandability, cost and performance characteristics.

They are listed as follows:

1. Bus

2. Star

3. Ring

4. Mesh (Partially and fully connected)

5. Tree

The choice of a network topology depends upon the following:

1. Performance and reliability desired from the network.

2. Number of nodes and their geographical distribution in the network.

3. Cost of components and services required from them.

4. Expandability of the system.

5. Communication lines available.

6. Delays in routing information from one node to another.

The LAN topologies are discussed below:

8.2 Bus Topology

It is the simplest type of network with the lowest cost. In a bus topology, all the nodes are connected
to a single transmission line. This single communication line is called as a bus. In this arrangement,
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there is no central server. The cable runs from one end to another in a linear manner. Each
communication device transmits electronic messages to other devices.

In bus networks, each and every node is assigned a specific address. When any device transmits, the
data in the form of packet is received by all other devices. Each device in this arrangement
interrogates the address field for its own address. If the destination field does not match the device
address, the packet is discarded back to the bus by the device. Each device accepts the packets that
are addressed to itself.

Terminating
resistance

absorbs signal

Terminating
reststance
absorbs signal

Figure7.22

Advantages

1. The bus is simple, reliable and easy to use.

2. It is easy to add or remove the nodes.

3. The transmission medium is highly reliable because of failure of a computer.

4. It does not affect communication among other computer in the network.

5. Requires the least amount of cable to connect the computers and less expensive.

Disadvantages

1. If the communication line fails, the entire system breaks down.
2. If the number of devices increases, the speed of the network slows down.
3. Difficult to troubleshoot a bus.



8.3 Star Topology

A star network is one in which all computers and other communication devices are connected to
central server (also known as central node or Hub). In this topology, computers are connected in a
star manner. The server is placed at the centre of the star. That is, the computers in the network are
not linked directly to each other. All the messages are routed through the central hub to their
destinations.

Figure 7.23

Advantages

1. The concept of central node prevents collisions between the messages.

2. If.a connection is broken between any nodes with the hub or any computer fails, the rest of the
network will continue operating.

3. Requires minimal line cost because only n-1 lines are required for connecting n nodes.

Disadvantages

1. ff the hub goes down, the entire network will stop working.

2. More expensive than bus topologies due to the cost of the hubs and more cables.



l$sf, .qtti,.Q.n$iq$li]$t ti{itR$illih$

8.4 Ring Topology

In a ring topology, all computers and other communication devices are connected by a single cable
in a circular manner. Thus each node is connected to its adjacent node by point{o-point links
forming a physical ring. Data is transmitted in the form of data packets fiom node to node only in
one direction around the ring until they rich right destination. There is no central server. A node
receives data from one of its two adjacent nodes then it verifies. lf it is addressed to it, it utilizes it.
Otherwise, it merely passes it on to the next node.

Figure7.24

Advantage

l. There is no danger of data collisions as the messages flow only in one direction.

Disadvantages

l. If the connection is broken, the entire network goes down, as there is only one path
each pair of nodes.

2. Addition of nodes to the network increase its complexity and its cost.

3. Communication delay is directly proportional to the number of nodes in the network.

between



8.5 Mesh Topology
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In a mesh topology, each node is connected to two or more nodes.
connected and fully connected mesh.

Figure below shows both partially

(a) partially connected mesh (b) Fully connected mesh

Figure 7.25: Mesh Topology

It can be seen ftom Jigure that the mesh topology has a typical advantage. In the event if one link
between two nodes fails, there are alternate routes (links) auiilubl" for communication.

Even though this approach is an expensive undertaking, some users prefer the reliability of the mesh
network.

Advantages

1. Communication is very fast between any two nodes.

2' Very reliable because any link failure does not affect communication between any two nodes.

3. Basic system can cost less than true star svstems.

Disadvantages

l. The most expensive network as per the link cost.

2. Difficulty of installation and reconfiguration.

(b) Fully connected mesh
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8.6 Tree Topology

A tree network structure represents a complex bus. In this topology, the common point of
communication at the top is known as the headend.

From the headend, feeder cables radiate outward to nodes, which in turn provide workstations with
access to network. There may also be a feeder cable route to additional nodes.

Figure 7.26: Tree Topology

Advantages

l. Point-to-point wiring for individual segments.

2. Supporred by several hardware and software venders.

Disadvantages

1. overall length of each segment is limited by the type of cabring used.

2. If the backbone line breaks, the entire segment goes down.

3. More difficult to configure and wire than other topologies.
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9. Internet

The term Internet has been coined from two terms 'interconnection' and. 'network'. A network is
simply a group of computers that zre connected together for sharing information and resources.
Several such networks have been joined together across the world to form what is called as the
Internet. Thus, it is a network of networks.

Figure 7.27

The Internet comprises thousands of computers connected together by different means on any given
day. It is a global network which connects more than 30 rnillion users in over 100 countries. The
Intemet is widely used to connect universities, governrnent organizations, companies, etc. No body
owns the Internet. Although there are organizations that help manage different parts of the networks,
but there is no single governing body that controls what happens on the intemet.

9.{ History of Internet

In 1969, the American defense department wanted to connect ali the computers in the Department of
Defense (DOD) offices and military research contractors including a large number of universities
doing military founded research. That network was called Advanced Research Projects Agency
Network (ARPANET), was also called DARPANET, the D fcr defense. It started in a small way,
connecting few computers in California, but quickly grew to sprin the whole of America. It was very
successful and all the universities wanted ro get connected to ARPANET. The military officials
wanted to preserve the unity of the DOD, so they divided the network into two parts:

i. ARPANET

ii. MILNET (Military Network)

Server



These two parts remained connected with a technical scheme called Internet protocol (Ip). The
Protocol means "Set of rules which govern the data exchange on the Internet", if we want ro connect
a person on another network, we need a protocol. Netrvork designers have designed several protocols
now, and some of them are as follows:

i. Simple Mail Transfer Prorocol (SMTP)

ii. Point to Poinr (PPP)

iii. Hyper-Text Transfer Protocol (HTTP)

iv. Transfer Control Protocol/Internet protocol (TCp/Ip)

During 1994, Several Commercial organizations introduced networks across the globe. They also
designed protocols to communicate from one node of a network to another node in inother netwoik.
As a result of this we now have a network of so many different networks. This network of networks
is called the Internet.

9.2 Internet Applications

The Internet consists of thousands of networks worldwide, connecting research facilities,
universities, libraries and private companies. Many of these networks have hosi computers dedicated
to maintaining archives of information, which are accessible to the public. The applications of
Internet may be divided into several categories.

These include

i. E-mail (Electronic mail): The facility to compose, send and receive electronic mail has been
around since the early days of the ARpANET and is enormously popular.

Many people get dozens of messages a day and consider it their primary way of interaction
with outside world far outdistancing the telephone and the conventi-onal postal mail service. E-
mail programs are available on virtually every computer these days. E-mails reach the
destination in a near-real-time manner taking only a few seconds to several minutes as it
travels from one network to another, until it reaches its destination.



lt. Chat and video conferencing: The chat rooms provide a good resource of
intercommunication among groups of like-minded people.

One can open a 'chat' session and put forward the views on a specific topic and get others to
respond to the topic in much the same fashion, as some friend circle would discuss over the
leisure time. People do enjoy this facility.

Video conferencing has been made possible with availability of higher bandwidth
communication channels. With a Web camera connected to the computer and the video
conferencing software one can have a live, video assisted discussion for business, official,
informal purposes.

Newsgroups: Newsgroups are specialized forums in which users with a common interest can
exchange messages. Thousands of newsgroups exist on technical and non-technical topics,
including computers, science, recreation and politics. Each newsgroup has its own etiquette,
style and customs.

Web pages and animations: The World Wide Web (WWW) has made it possible for a site to
set up a number of pages of information containing text, pictures, sound and even video, with
embedded links to other pages. By clicking on a link, the user is transported to the page
pointed by that link. For example, many companies have a "HOME" page with entries
pointing to other pages for product information, price lists, sales, technical support,
communication with employees, stockholder information and much more.

Numerous other kinds of web pages have come into existence in a very short time, including
maps, stock market tables, library card catalogues, recorded radio programs and even a page
pointing to the complete text of articles of various journals and magazines as well as books.

Many people have personal information including photo albums, profiles, etc. available.

The vast amount of information available through such web pages, which is stored in the form
of Hyper Text Markup Language (HTML), is accessible just at a mouse click.

It includes information on IT, legal, financial, aft, sports, entertainment, technology, science
and many more topics.

v. Datatrases for information storage and retrieval: Extensive databases stored all across the
globe are accessible. The advantage of WWW is that the information being searched for is
available to the user irrespective of its physical location of storage.

Every piece of infonnation stored in the Internet, has a unique address known as Uniform
Resource Locator (URL). Several search engines are available for the service of Internet users.
These include msn, infoseek, altavista, /ahoo, google, and many more. The search engines
provide mechanisms for locating the information. All you have to do is type in the keywords
for the information being searched and let the search engine do the rest of the job. Within
fraction of a second, the search engines present before you a list of web pages, which might
contain some information about the key words, along with a summary and hyperlink to the

ut.
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conesponding web page. One may also directly access the information by keyins in the URL
address.

vi. E - commerce and inventory system: The Internet has proven to be a good means for
marketing, a medium through which one can conduct businesi. Through the dJvelopment of e-
commerce, the Internet has established an electronic global worldwide market for various
goods that operates 24 hours a day.

Organizations and individuals are able to market goods and services through the
e-commerce' One can advertise, declare the stock status, handle purchase orders and inventory
transactions through the Internet. The purchasing is support"d by facilities such as digitil
signature and encryption. For the physical supply of goods of course one has to rely on the
appropriate back-end logistics support network.

vii. File Transfer Protocol (FTP): Using FTP program, it is possible ro copy files from one
machine on Internet to another. Vast number of articles, databases and other information is
available this way.

A user needs access rights for a remote computer to transfer files to/frorn it. There is also a
concept of an anonymous FTP site tbat allows a user to log in with a username of anonymous
and a password that is user's e-mail address. The user can then download files that have been
stored on it for sharing. Such sites are called publicly accessible siles because any user on the
Intemet can access them.

A user needs access rights for a remote computer to transfer files to/from it. There is also a
concept of an anonymous FTP site that allows a user to log in with a username of anonymous
and a password that is user's e-mail address.

The user can then download files that have been stored on it for sharing. Such sites are called
publicly accessible siles because any user on the Intemet can access them.

viii. Remote login: Using Telnet, Rlogin or other programs, users anywhere on the Internet can
log into any other machines on which they have an account.

Even if you do not have a machine, agencies like hotmail, rediffmail, mail excite, yahoo, msn
host user accounts on their machines and support various services. Through the netcafes or
cybercafes'one can access these remotely situated accounts and do net surfing or web
browsing.

Several Web browsers are available. Internet Explorer and Netscape Navigator are among the
popular browser.

Uses of telnet
a. Allows access to a remote computer. Hence, the user can use the computing power of

the remote machine.

b' Software located on the remote computer can be used by a user if it is not available on
his local machine.
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c. The user can access a remote computer's database or archive which may be of interest
to a user.

d. If the user is away from his personal computer, he can log on to it using this facility
from another location to access some stored information or read his own rnails.

Usenet groups: Usenet Groups are a system of "Bulletin Boards", each dedicated to a
particular topic, where users can post messages themselves and read messages posted by
others. Usenet Groups exist for almost every conceivable topic on eafth, including topics
associated with business, leisure, physical health, mental health, celebrities, hobbies, etc. In
fact, the author doubts there could be any topic an average person could ask about that does
not have a Usenet Group dedicated to it.

LISTSERV: LISTSERV functions like a Usenet group, except that there is no "Bulletin
Board". Instead, all subscribers receive messages posted by any other subscriber through e-
mail. Thus, a LISTSERV application necessitates that one must first be a subscriber to the
service, after which he/she receives messages posted by other users through e-mail. Similarly,
any message posted by this subscriber would automatically be posted to all other subscribers.

l
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5.
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8.
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11.

WExerctse
What are the applications of computer networks?

Differentiate between analog and digital transmission.

Write a shoft note on WAN.

What do you know about Computer Communication?

Describe the types of communication.

What are communication Networks? Describe each briefly.

what do you understand by Network ropologies? Describe each of them briefly.

Write in detail about LAN.

What is Internet? Why is it gaining popularity?

Differentiate between asynchronous and synchronous transmi ssion.

why is digital transmission preferred over analog transmission of digital data?
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1. Introduction

MS Office (Microsoft Office) is a suite of products developed by Microsoft Corporation that

includes Microsoft Word, Excei, Access, Publisher, PowerPoint, and Outlook. Each program serves

a different purpose and is compatible with other programs included in the package. The suite of
programs is compatible with both Windows and Macintosh operating system.

Microsoft Office is an office suite of desktop applications, servers and services for the Microsoft

Windows and Mac OS X operating systems, introduced by Microsoft on August 1, 1989.

Various versions of MS Office are:

i. MS Office 97

ii. MS Office 2000

iii. MS Office 2003

iv. MS Office 2007

v. MS Office 2010

vi. MS Office 2013

Initially, a marketing term for a bundled set of applications, the first version of Office contained

Microsoft Word. Microsoft Excel, and Microsoft PowerPoint. Over the years, Office applications



have grown substantially closer with shared features such as a common spell checker, OLE data
integration and Microsoft visual Basic for Applications scripting language.

Microsoft also positions Office as a development platform for line-of-business software under the
Office Business Applications brand. Office is reported to now be used by over a billion people
worldwide.

1,1 Features of MS-Off i ce 2OOT

i. File Menu: The user interface has been significantly redesigned in the 2007 Microsoft office
programs. The File menu has been replaced with the Microsoft Office Button. When you click
the Microsoft Office Button you see the same basic commands that were found under the File
menu in previous versions of Microsoft Office to open, save, and print your file.

However, in 2007, more commands are now available, such as Prepare and publish.
For example, in Word, Excel, and PowerPoint, by pointing to Prepare, and then clicking
Inspect Document, you can check a file for hidden metadata or personal information. The
program's Options are also found under the Microsoft office Button. This command used to be
under Tools and Options in previous versions.

The
button
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in Windows? Explain
any one.
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ii. Office Assistant: The online Help feature in 2007 has been completely redesigned, and the
new design does not include the Microsoft Office Assistant. To access Help click the

Microsoft Office Help icon located in the top right corner of the program.

Each program has its own Help home page where you can find product information, Help and

how-to articles, training coulses, templates, and more.

Office help icon

Figure 8.1

Ribbon: When you first start some of the programs in 20O1 you see the ribbon. The menus
and toolbars in some programs have been replaced with the Ribbon. The Ribbon is designed to
help you quickly find the commands that you need to complete a task.

Commands are organized in logical groups, which are collected together under Tabs. Each

Tab relates to a type of activity, such as writing or laying out a page.

There are three basic components to the Ribbon:

a. Tabs sit across the top of the Ribbon. Each one represents the tasks you do in a given
program.

b. Groups are sets of related commands, displayed on Tabs. They pull together all the
commands you're likely to need for a type of task, and they remain on display and
readily available, giving you rich visual aids.

c. Commands are arranged in groups. A command can be a buiton, a menu, or a box
where you enter information.

Figure 8.2



tv. Galleries: Galleries are at the heart of the redesigned programs. Galleries provide users with a
set of clear results to choose from when working on f document, spreadshlet, presentation, or
Access database.

By presenting a simple set of potential results, rather than a complex dialog box with
numerous options, Galleriessimplify the process of producing professionalJookin! work. The
traditional dialog box interfaces are still available for those who want a gr"ut"", degree of
control over the result ofthe operation.

For example, Word 2007 provides the following designs when working with tables:
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Figure 9.3

Live Preview: Live Preview is a new technology that shows the results of applying an editing
or formatting change as the user moves the pointer over the results presented in a Gallery.
This new, dynamic capability streamlines the process of laying out, editing, and formatting, so
users can create prof'essional results with less time and effort.

To use Live Preview' rest the mouse pointer on an option. Your document changes to show
you what that option would look like before you actuaily make the selection. Afteiyou see the
preview of what you want, then click the option to make your selection.

Enhanced ToolTips: The new Microsoft Office system user interface dramatically
streamlines access to information about commands and tools. Enhanced ToolTips provide
links to auxiliary information, sltch as training or help topics, directly from the command.
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PowerPoint 2007 is Microsoft's presentation software, used for creating slide show presentations.
Users can impon graphs and charts from Excel or text from Word, or use PowerPoint's own tools fbr
creating slide text and graphics. The program also has the capacity to add special effects like fade-ins
or t'ade-outs between slides, as well as audio and video. PowerPoint is included in every edition of
Microsoft Office 2007.

Outlook 2001 is Microsoft's e-mail client, and it also includes a calendaring program, address book
and contact organizer, and task list. With Outlook, you can manage any number of e-mail addresses
and create personal mailing lists. Outlook is included in the Small Business, Professional,
Professional Plus, Ultimate and Enterprise editions of Office 2007.

Publisher 2007 is Microsoft's solution for home and business users who want to create posters,
flyers, letterhead, brochures or other marketing materials. Publisher simplifies the design process by
including a number of predefined color schemes, page borders, as well as clip art and templates for
popular types of publications like bake sale flyers, calendars, and personal stationery. Publisher is
included with the Small Business, Professional, Professional Plus, Ultimate and Entemrise editions
of Office 2007.

Access 2007 lets users work with data by creating databases, data entry forms and queries. Access
can be used as a standalone database program or to interface with Microsoft SQL server databases.
Access is included with Microsoft Office Professional, Professional Plus, Ultimate and Enterprise.

Some of the targeted versions of Microsoft Office include extra programs designed to help customers
with specific needs, like small business owners. These programs include:

i. Accounting Express, which is a financial accounting package aimed at small business owners.

ii. Groove 2007, a collaboration tool for users who work collaboratively from different physical
locations or offline.

iii. InfoPath 2007, a forms-creation tool for business users and developers.

iv. Communicator 2007, which is a communications client used for Intemet-based audio and
video conferencing.

v. OneNote, which serves as a virtual notebook to store text, graphics, Web links or other
information organized by topic, subject or project.



lntroduction to MS-Word 2OOT

Microsoft Word is the world's leading word processing application. It can be used to work with a
wide range of documents from simple letters, memos to complex documents like newsletters, forms
and now with blogs too with Word 2007.

Microsoft Word is a component of the Microsoft Office suite of productivity software, but can also
be purchased as a stand-alone product.

It was initially launched in 1983 and has since been revised numerous times. Microsoft Word is
available on both Windows and Macintosh operating systems.

Microsoft Word is often called simply Word or MS Word.

In 1981, Microsoft hired Charles Simonyi to develop a word-processing application. The first
version was released in 1983. It was not initially popular owing to its radically different look
compared to WordPerfect, the leading word processor at that time. However, Microsoft improved
Word continually over the years, including a 1985 version that could run on a Mac. 1987 brought
about the second major release of Word, which included an upgrade of major features in addition to
new functionalities such as suppoft for the rich text format.

In 1995, with the release of Windows 95 and Office 95, which offered a bundled set of office
productivity software, sales of Microsoft Word increased significantly.

Microsoft Word offers several features to ease document
creation and editing, including:

i. WYSIWYG (what-you-see-is-what-you-ger) display: It
ensures that everything you see on screen will appear the
same way when printed or moved to another format or
program.

ii. Spell Check: Word comes with an built-in dictionary for spell
checking; misspelled words are marked with a red squiggly
underline. Sometimes, Word auto-corrects an obviouslv
misspelled word or phrase.

iii. Text-level features such as bold, underline, italic and strike-through.
1

iv. Page-level features such as indentation, paragraphing andjustification.

v. External support: Word is compatible with many other programs, the most common being the
other members of the Office suite.

The default file format was .doc prior to the Microsoft Word 2007 version: in 2007,.docx became
the default file format.

Oct.l1, 10,09,08 -;i;
State any four features
of MS- Word.

Apr.?OO9- 4M
Explain features of MS-



2.1 Getting Familiar with Microsoft Word
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2OO7 Window

Open Microsoft Word 2007 by clicking on start menu and then Programs -+ Microsoft
Office -+Microsoft Office Word 2007. The Microsoft Word window appears and your screen looks
similar to the one shown here:

APr2010-4M,'.,' "''
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Word in detail,

Figure 8.4

In the upper-left corner of the Word 2007, window is the Microsoft Office button. When you click
the button, a menu appears. You can use the menu to create a new file, open an existing tile, save a

file, and perform many other tasks.

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar provides
you with access to commands you frequently use. By default Save, Undo, and Redo appear on the

tt"";
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Quick Access toolbar. You can use Save to save your file, Undo to rollback an action you have
taken, and Redo to reapply an action you have rolled back.

Next to the Quick Access toolbar is the Title bar. The Title bar displays the title of the document on
which you are currently working. Word names the tirst new document you open Documentl. As
you open additional new documents, Word names them sequentially. When you save your
document, you assign the document a new name.

You use commands to tell Microsoft Word what to do. In Microsoft Word 2007, you use the Ribbon
to issue commands. The Ribbon is located near the top of the screen, below the euick Access
toolbar. At the top of the Ribbon are several tabs; clicking a tab displays several related command
groups. Within each group are related command buttons. You click buttons to issue commands or to
access menus and dialog boxes. You may also find a dialog box launcher in the bottom-right corner
of a group. Clicking the dialog box launcher gives you access to additional commands vii a dialog
box.

The ruler is found below the Ribbon.

You can use the ruler to change the format of your document quickly.
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Just below the ruler is a large area called the text area. You type your document in the text area. The

blinking vertical line in the upper-left corner of the text area is the cursor. It marks the insertion

point. As you type, your text displays at the cursor location. The horizontal line next to the cursor

marks the end of the document.

Figure 8.5

The vertical and horizontal scroll bars enable you to move up, down, and across your window simply

by dragging the icon located on the scroll bar. The vertical scroll bar is located along the right side of

the screen. The horizontal scroll bar is locatedjust above the status bar.

The Status bar appears at the very bottom of your window and provides such information as the

current pug" and ihe number of words in your document. You can change what displays on the

Status bar by right-clicking on the Status bar and selecting the options you want from the Customize

Status Bar menu. You click a menu item to select it. You click it again to deselect it. A check mark

next to an item means it is selected.
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2.2 Dealing with Document/Letter

There are several ways to create new documents,
documents in Word:

open existing documents, and save

ilji-
o,
I
E

oct.2009 - 4M

Explain ditterent
operations for MS-Word.

i. Click the Microsoft Office Button W-O Click New or

ii. Press CTRL+N (Depress the CTRL key while pressing rhe "N") on the keyboard

You will notice that when you click on the Microsoft Office Button and Click New, you have many
choices about the types of documents you can create. If you wish to start from a blank document,
click Blank. If you wish to start from a template you can browse through your choices on the left,
see the choices on center screen, and preview the selection on the right screen.
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i.

ii.

iii.

Opening an Existing Document

Click the Microsoft Office Button W*O Click Open, or

Press CTRL+O (Depress the CTRL key while pressing the "O") on the keyboard, or

If you have recently used the document you can click the Microsoft Office Button and click
the name of the document in the Recent Documents section of the window Insert picture of
recent docs.

osoft Office Button ffi*O Click Save or Save As (remember, if you're
sending the document to someo4e who does not have Office 2007, you will need to click the
Office Button, click Save As, and Click Word 97 -2OO3 Document), or

ii. Press CTRL+S (Depress the CTRL key while pressing the "S") on the keyboard, or

iii. Click the File icon on the Quick Access Toolbar.
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Figure 8.7



Figure 8.8

To rename a Word document while using the program

i. Click the Office Button ffi""d find the file you want to rename.

ii. Right-click the document name with the mouse and select Rename from the shortcut menu.

iii. Type the new name for the file and press the ENTER key.

X Scen f or ',rir us*s

Figure 8.9
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Several documents can be opened simultaneously if you are typing or editing multiple documents at
once. All open documents will be listed in the View Tab of the Ribbon when you click on Switch
Windows. The current document has a checkmark beside the file name. Select another open
document to view it.

Figure 8.10

There are many ways to view a document in Word.

i. Print Layout: This is a view of the document as it would appear when printed. It includes all
tables, text, graphics, and images.

ii. Full Screen Reading: This is a full view length view of a document. Good for viewing two
pages at a time.

iii" Web Layout; This is a view of the document as it would appear in a web browser.

iv. OutLine: This is an outline form of the document in the form of bullets.

v" Draft: This view does not display pictures or layouts, just text.

To view a document in different forms, click the document views shor-tcuts at the bottom of the

i.i Wscreen

i.

ii.

or:

Click the View Tab on the Ribbon

Click on the appropriate document view.
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To close a document:

i. Click the Office Button

ii. Click Close

2.3 Formatting Text

Following figure shows various text formatting options on the ribbon:
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Figure 8.11

To make the text bold/italic/underline, you can:

i. Select the required text

ii. Press Ctrl+B for bold. Ctrl+I for italic and Ctrl+U for underline Or

iii. Click on B/I/U button on the ribbon for Bold/ItalicAjnderline
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To change the font typeface click the arrow next to the font name and choose a font.
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You can preview how the new font will look by highrighting the text,
typeface.

To change the font size:

i. click the arrow next to the font size and choose the appropriate
ii. Click the increase or decrease font size buttons.

and hovering over the new font

slze, or

Highlighting text allows you to use emphasize text as you would if you had a marker.

To highlight text:

i. Select the text
ii. click the Highlight Butron on the Font Group of the Ribbon, or
iii. Select the rext and right click and selecr the highlight tool
iv. To change the color of the highlighter click on down arrow next to the highlight button.

To change the text color:

i. Select the text and click the Colors button included on the Font Group of the Ribbon, or

iS t' .S,- iffi
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ii. Highlight the text and right click and choose the colors tool.

iii. Select the color by clicking the down arrow next to the font color button.

To clear text formatting:

i. Select the text you wish to clear the formatting

ii. Click the Styles dialogue box on the Styles Group on the Home Tab

iii. Click Clear All

Figure 8.12



If you have already formatted text the way you want it and would like another portion of the
document to have the same formatting, you can copy the formatting. To copy the formatting, do the
following:

i. Select the text with the formatting you want to copy.

ii. Copy the format of the text selected by clicking the Format Painter button on the Clipboard
Group of the Home Tab

iii. Apply the copied format by selecting the text and clicking on it.

2.4 Handling Paragraphs

Formatting paragraphs allows you to change the look of the overall document. You can access many
of the tools of paragraph formatting by clicking the Page Layout Tab of the Ribbon or the
Paragraph Group on the Home Tab of the Ribbon.

Figure 8.13



The paragraph alignment allows you to set how you want text to appear. To change the alignment:

i. Click the Home Tab

ii. Choose the appropriate button for alignment on the Paragraph Group.

a. Align lcfi: The text is aligned with your left margin'

b. Center: The text is centered within your margins'

c. Atign Right: Aligns text with the right margin.

d. Justfu: Aligns text to both the left and right margins'

Figure 8.14

Indenting paragraphs allows you set text within a paragraph at different margins'

options for indenting:

i. First Line: Controls the left boundary for the first line of a paragraph.

ii. Hanging: Controls the left boundary of every line in a paragraph except the

iit: Left: Controls the left boundary for every line in a paragraph'

iv. Right: controls the right boundary for every line in a paragraph.

To indent paragraphs, you can do the following:

i. Click the Indent buttons to control the indent.

ii. click the Indent button repeated times to increase the size of the indent.

There are several

first one.



Figure 8.15

You can add borders and shading to paragraphs and entire pages. To create
paragraph or paragraphs:

i. Select the area of text where you want the border or shading.

ii. Click the Borders Button on the Paragraph Group on the Home Tab.

iii. Choose the Border and Shading.

iv. Choose the appropriate options.
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You can change the space between lines and paragraphs by doing the following:

i. Select the paragraph or paragraphs you wish to change.

ii. On the Home Tab, click the Paragraph Dialog Box.

iii. Click the Indents and Spacing Tab.

iv. In the Spacing section, adjust your spacing accordingly.

Figure 8.17

2.5 Editing a Document
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:Explain different :

,feAtures of Editing Textlrin:MS-Word..;': 
,

Text can be inserted in a document at any point using any of the following methods:

i. Type Text: Put your cursor where you want to add the text and begin typing.

ii. Copy and Paste Text: Highlight the text you wish to copy and right click and click Copy, put
your cursor where you want the text in the document and right click and click Paste.
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iii. Cut and Paste Text: Highlight the text you wish to copy, right click, and click Cut, put your
cursor where you want the text in the document, right click, and click Paste.

iv. Drag Text: Highlight the text you wish to move, click on it and drag it to the place where you

want the text in the document.

Figure 8.18

To rearrange text within a document, you can utilize the Clipboard Group on the Home Tab of the

Ribbon. Insert picture of clipboard group labeled

i. Move text: Cut and Paste or Drag as shown above.

ii. Copy Text: Copy and Paste as above or use the Clipboard group on the Ribbon.

iii. Paste Text: Ctrl + V (hold down the CTRL and the "V" key at the same time) or use the

Clipboard group to Paste, Paste Special, or Paste as Hyperlink.
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To find a parlicular word or phrase in a document:

i. Click Find on the Editing Group on the Ribbon.

ii. To find and replace a word or phrase in the document, click
the Ribbon.

W
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Replace on the Editing Group of

To undo changes: Click the Undo Button on the Quick Access Toolbar

Figure 8.19



2.6 Working with Tables

A table is a grid of cells arranged in rows and columns. Tables can be customized and are useful for
various tasks such as presenting text intbrmation and numerical data.

A table is made up of rows and columns. The intersection of a row and column is called a cell.

Tables are often used to organize and present information, but they have a variety of uses as well.

You can use tables to align numbers and create interesting page layouts.

i. Click the Insert tab on the Ribbon

ii. Click the Table button

iii. Select Insert Table

iv. Click the affows to select the desired number of columns

v. Click the arrows to select the desired number of rows

vi. Click Ok

Ar*o

Figure 8.20
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Insert a Row

i. Position the cursor in the table where you would like to insen a row
ii. Select the Layout tab on the Ribbon
iii. click either the Insert Row Above or the Insert Row Below button in the

group

Insert a Column

i. Positron the cursor in the table where you would like to insert a column
ii. Select the Layout tab on the Ribbon
iii. Click either the Insert Columns to Left button or the Inserl Columns to

Rows and Columns group

Delete a Row

i. Position your cursor in the row that you would like to delete
ii. Select the Layout tab on the Ribbon
iii. Click the Delete button in the Rows and Column group
iv. Select Delete Rows

Delete a Column

i. Position your cursor in the column that vou would like to delete
ii. Select the Layout tab on the Ribbon
iii. Click the Delete button in the Rows & Column group
iv. Select Delete Columns

Using Microsoft Word you are able to
tables, adjusting row and column size as

formaf a table by changing
well as alignment.

", '* .i)- .[{F-oJfibq

Rows and Columns

Right button in the

table lines and colors, shadins



Kffi
To Shade the Cells/Table:

i. Position your cursor in the table

ii. Click the Layour rab on rhe Ribbon

iii. Click the Select button in the Table goup

iv. Choose the item you wish to format

v. Click the Design tab on the Ribbon

vi. Click the Shading bunon

vii. Select a shading color

To Adjust the Line Style of a Cell/Table:

l.

ii.

iii.

iv.

vi.

vii.

viii.

ix.

Position your cursor in the table

Click the Layout rab on rhe Ribbon

Click the Select button in rhe Table group

Choose the item you wish to format

Click the Design tab on rhe Ribbon

Select the Line Style drop-Down Arrow

Select a style

click your mouse in the table where you want to apply the line style to
Press ESC key on the keyboard when you are finished applying the style

i. Select the cells that you would like to merge in the table

ii. Click on the Layout rab on the ribbon

iii. Click the Merge Cells buton in the Merge group

2.7 Page Layout and Document Formatting

The Page Layout Tab lets you control the look and feel of your document in Microsoft Word 2007.
You can apply a global design to your document by using one of the available themes and color
schemes. You can also change the document orientatio.t, pug" size, margins, indentation, line
spacing and paragraph settings.



when you click on the Page Layout tab, this is similar to what you would see.

Themes is a great feature if you are typing an elaborate document and want to use a variety of fon
and colors and then duplicating those fonts and colors on another document or throughout a lor
document. A document theme is a set of formatting choices that include a set of theme colors, a s
of theme fonts that you can specify a heading and body text font, and a set of theme effects you ci
choose lines and fill effects.

To apply a theme to document:

i. Click the down arrow under themes.

ii' You will get a list of pre-designed themes you can apply to your docurnent. Each theme wi
include font colors, font styles, font sizes and effects including lines, fill effects, and color
Select the required theme from this list.
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Page Setup

Page setup section under the Page Layout tab is used to set the margins and orientation of the page. It
is also used to specify the page size, page breaks, line numbers and dividing page in columns.

The page margins can be modified through the following steps:

i. Click the Page Layout Tab on the Ribbon

ii. On the Page Setup Group, Click Margins

iii. Click a Default Margin, or

iv. Click Custom Margins and complete the dialog box
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To change the Orientation, Size of the Page, or Columns:

i. Click the Page Layout Tab on the Ribbon
ii. On the Page Setup Group, Click the Orientation, Size, or Columns drop down menus
iii. Click the appropriate choice

Apply a Page Border and Color To appty a page border or color:

i. Click the Page Layout Tab on the Ribbon.
ii. On the Page Background Group, click the Page Colors or Page Borders drop down menus.

Insert Common Header and Footer Information To insert Header and Footer information such as
page numbers, date, or title, first, decide if you want the information in the header (at the top of the
page) or in the Footer (at the bottom of the page), then:

i. Click the Insert Tab on the Ribbon
ii. Click Header or Footer
iii. Choose a stvle

lv. The Header/Footer Design Tab will display on the Ribbon



Choose the information that you would like
numbers, etc.) or type in the information you

to have in the header or footer (date, time, page

would like to have in the header or footer.

Create a Page Break To insert a page break:

i. Click the Page Layout Tab on the Ribbon

ii. On the Page Setup Group, click the Breaks Drop Down Menu

iii. Click Page Break
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2.a Spel I Gheck

Spell check is a feature that checks for spelling errors in a document, Spell check can be useful in
preventing embarrassing mistakes, but Spell checkis not always right.

Spelling can be checked simultaneously with granrmar. Word checks the spelling and grammar as

you type. A red squiggly line under a word denotes that Word thinks it has been spelt incorrectly; if
the line is green then the grammar may be incorrect. You can check the whole or part of the text for
mistakes using the [Spelling and Grammar] button.

Although options and instructions vary slightly by program, the Spell check feature is available in all

Office programs.

I Activating Automatic Spell Check

By default, Spell check is automatically on whenever an Office program is open. When you turn this

feature off, Spell check will not run as you work on your document. The feature can be easily

activated using the Review command tab. You can also check the spelling in a document after you

are finished typing.

From the Review command tab, in the Proofing group, click Spelling and Grammar. The Spelling
and Grammar dialog box appears.
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Figure 8.24

In the Spelling and Grammar dialog box, click Options, the Options dialog box appears.,lt



$a{gr. ope iati 1g[ nvi q0"11 m ent.,

ii. In the Categories pane, select Proofing.

iii. To activate Automatic spell check, in the when correcting spelling and
section, select Check spelling as you type.

Note: The option is selected if a checkmark appears in front of it.

iv. Click Ok.

v. To exit the Spelling and Grammar dialog box, click Cancel.

i *$\iiil$$i$i*\Ks,rpl{iR$

grammar in Word

2.9 Gorrecting Spelling

When the dictionary recognizes a word as misspelled, the word is underlined with a wavy red line.
You can conect misspelled text through the Quick menu or through a dialog box. For words that are
often misspelled or mistyped, you may use AutoCorrect to automatically correct the mistakes as they
are typed.

Using the Quick menu to modify misspelled text allows you to manage your misspelled word(s)
quickly and easily.

Right click the misspelled word >> select the appropriate option:

i. Spelling Suggestions: Gives suggestions for correcting the misspelled word

ii. Ignore: Ignores that instance of the word

iii. Ignore All: Ignores that word and every other instance of that word

iv. Add to Dicrionary: Adds the word to the custom dictionary

v. AutoCorrect: Provides word choices for the automatic correction of the misspelled word

vi' Language: Allows the misspelled word to be corrected according to the selected language

vii. Spelling...: Opens the Spelling dialog box, which allows you to change the misspelled word

viii. Look Up...: Opens the Research task pane, which allows you to search an online reference site

Using the dialog box option is a little more time-consuming, but you have more options for
correcting misspelled words.
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From the Review command tab, in the Proofing group, click SpELLING & GRAMMAR.
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ii. Make the desired selection for each misspelling. The dialog box options include all euick
menu options in addition to the following options:

a. Ignore Once: Ignores that particular occurrence of that word
b. Change: Changes the word to the selected suggestion

c. Change AII: Changes all identical misspellings to the selected suggestion

2.1O Print Preview

Once you complete your document, you may want to print it for various reasons. When you want to
print your document, you can use Print Preview, under the file menu, to see how your document will
be printed. When you are ready to print, you can print directly from the Print Preview screen, or use
the Print menu option. You can also change the default printer for future documents.

iu :1+rt r$ni:



To Preview the Document Before Printing:

i. Click the Microsoft Office Button

ii. Select Print

iii. Select Print Preview

The document opens in Print Preview format.

Figure 8.26

In Print Preview format, you can do many tasks including:

i. Modify the margins

ii. Change page orientation

iii. Change the page size

iv. Tnom in and out to view various parts of the document

v. View multiple pages

vi. Access Word Options to change many Word settings

To Print:

i. Click the Microsoft Office Button.



ii. Select Print.
iii. Again select Print. The Print dialog box appears.

iv. Select the pages you would like to print -- either all pages or a range of pages.

v. Select the number of copies.

vi. Check the Collate box if you are printing multiple copies of a multi-page document.

vii. Select a printer from the drop-down list.

viii. Click Ok.
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Figure 8.27

2.11 Templates

A template is a document type that creates a copy of itself when you open it. In Microsoft Office
Word 2007, you can create a template saving a document as a .dotx file, .dot file, or a .dotm file (a

.dotm file type allows you to enable macros in the file).

For example, a business plan is a common document that is written in Word. Instead of creating the

structure of the business plan from scratch, you can use a template with predefined page layout,
fonts, margins, and styles. All you have to do is open a template and fill in the text and the
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information that is specific to your document. When you save the document as a .docx or .docm file.
you save your document separately from the template on which it is based.

You can find word templates for most kinds of documents on Microsoft office online. ff you have
an Internet connection, click the Microsoft Office Button, click New, and then click the template
category that you want. Alternatively, you can create your own templates.

i..

ii.

iii.

Start with a blank template

Click the Microsoft Oftice Button, and then click New.

Click Blank document, and then click Create.

Make the changes that you want to the margin settings, page size and orientation, styles, and
other formats.

Click the Microsoft Office Button, and then click Save As.

In the Save As dialog box, do one of the following:

a. On a computer that is running Windows Vista, under Favorite Links, click Templates.
b. On a computer that is running Windows XP, under Save in, click Trusted Templates.

Give the new template a file name, select Word Template in the Save as type list, and then
click Save.

Close the template.

Create a template based on an existing document
Click the Microsoft Office Button, and then click Open.

Open the document that you want.

Make the changes that you want to appear in all new documents that you base on the template.

Click the Microsoft Office Button, and then click Save As.

In the Save As dialog box, do one of the following:

a. On a computer that is running Windows Vista, under Favorite Links, click Templates.
b. On a computer that is running Windows XP, under Save in, click Trusted Templates.

Give the new template a file name, select Word Template in the Save as type list, and then
click Save.

Close the template.

iv.

vl.

vll.

vi.

vll.
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i.

ii.

iii.

iv.

$ffi '-*;:.:Iti,!!S"ffi

Create a new template based on an existing template

Click the Microsoft Office Button, and then click New.

Under Templates, click New from existing.

Click a template that is similar to the one that you want to create, and then click Create New.

Make the changes you want to the margin settings, page size and orientation, styles, and other
formats.

v. Click the Microsoft Office Button, and then click Save As.

vi. In the Save As dialog box, do one of the following:

a. On a computer that is running Windows Vista, under Favorite Links, click Templates.

b. On a computer that is running Windows XP, under Save in, click Trusted Templates.

vii. Give the new template a file name, click Word Template in the Save as type box, and then
click Save.

viii. Close the template.

2.12 Mai I Merge

Mail Merge is a way of placing content from a spreadsheet, database, or table into a Microsoft Word
document. Mail merge is ideal for creating personalized form letters or labels instead of editing the
original letter several times to input different personalized information. As you can imagine, this can
save a lot of time as well as worry about not changing all of the information for the new recipient.

In order to create a mail merge, two documents are needed: a Word document and a file with the data
or records. This file can take many forms, such as an Excel spreadsheet, a database, or even another
Word document that has a table in it.

Creating Merged Mailing Labels

i. Open a blank Word document

ii. From the Ribbon, select the Mailings tab

iii. Inthe Start Mail Merge group, click Start Mail Merge >> select lnbels...
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The lnbel Options dialog box appears.
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i. From the Inbel products pull-down list, select the brand name of your labels

ii. From the Product number scroll box, select the product number of your labels

iii. To specify the paper source for printing, from the Tray pull-down list, make the appropriate
selection

iv. Click Ok

v. Inthe Start Mail Merge group, click Select Recipients >> select Use Existing List...
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Figure 8.30

.The Select Data Source dialog box appears.

i. From the Inokin pull-down list, locate and select the file you will use for your list

ii. Click Open

iii. To select the recipient(s) you want to include in your mail merge,

a. Inthe Start Mail Merge group, click Edit Recipient List
b. Select the recipients

c. Click Ok

iv. To insert merge fields,

a. Position the insertion point in the top left label

b. lnthe Write and Insert Fields group, click Insert Merge Field > select the desired field

vll.

Figure 8.31

To use the same fields and layout for each record, in the Write and Insert Fields group, click
Update Labels

When finished, click Preview Results. A preview of your label(s) appears



viii. To print the labels,

a. Click Finish and Merge >> select Print Documents... The Merge to Pinter dialog box
appears

Figure 8.32

b. To print labels for all of your records, select All
To print a label for only the record displayed, select Cunent record
To print labels for only certain records, enter a range in the text boxes.

c. Click Ok
d. The Print dialog box appears

e. Make any necessary adjustment

f. Click Ok

ix. To make changes to the labels,

a. Click Finish and Merge >> select Edit Individual Documents...

The Merge to New Document dialog box appears

b. Make the appropriate selection

c. Click Ok
d. Make the appropriate changes in the new document that appears

e. Save the documents

2.13 Auto Text

AutoText is useful for saving keystrokes while typing in your document. An AutoTexl entry is
composed of an abbreviation and an associated phrase.
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This is an excellent way to reduce the number ofkeystrokes for frequently used phrases such as your
department name, the University's address, and a signature block on a letter.

AutoText entries can include both text and graphics. AutoText allows you to retain the formatting(e'g., font, size, justification) used when you created the entry or maich the entry to the current
document's formatting. once an entry is created, it can be used throughout the.urr"nt document and
other documents associated with the same template.

Creating an Auto Text Entry
In your word document, type the desired phrase and/or insert the graphic.

Select the phrase and/or graphic.

From the Office Button, click Word Options > select proofing.

Tn the AutoCorrect options section, click Autocorrect Options...

The Auto C o r r e ct diaTo g box appears.
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v. In the Replace text as you type section, inthe Replace text box, type the keyword or phrase

you want replaced.

vi. In the Withtext box, type the word or phrase you want to replace the keyword when it is typed

in a document.

vii. Click Add.

viii. Click Ok.

2.14 Inserting Picture

i. Place your cursor in the document where you want the illustration/picture.

ii." Click the Insert Tab on the Ribbon.

iii. Click the Picture Button.

iv. Browse to the picture you wish to include.

v. Click the Picture.

vi. Click Insert.

Figure 8.34



2.15 Word Art

You can use WordArt to make display text (e.g., the heading of your document) more eye-
catching. WordArt can be resized, moved, and edited to fit your needs.

To insert word art, follow the following steps:

i. From the Insert command tab, in the Text group, click Wordart. The WordArt Gatlery dialog
box appears.
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From the WordArt Gallery, select the desired style

The Edit WordArt Text dialogbox appears.

Figure 8.36

iii. In the Text text box, type your text.

iv. To format your text, from the Font or Size pull-down lists, make the desired selections.

v. To change the font style, click Bold or Italic.

vi. Click Ok.

ll.
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3, MS-Excel 2OO7

Microsoft Office Excel is a powerful tool used to create and format
spreadsheets. Spreadsheets allow information to be organized in
rows and tables and analyzed with automatic mathematics.

Spreadsheets are commonly be used to pedorm many different types

of calculations.

Excel is all about numbers. There is almost no limit to what you can

do with numbers in Excel, including sorting, advanced calculations,

and graphing.

Data files created with Excel are called workbooks (in the same way as Word files are called

documents). But where Word starts up with a single blank page, Excel files by default contain three

blank worksheets. This gives you the flexibility to store related data in different locations within the

same file. More worksheets can be added, and others deleted, as required.

Definitions

When you open Excel, a new file is created called Book 1 (until you name it differently). It is called

"Book" because it is a Workbook that is initially made up of three worksheets (accessible from the

tabs in the lower left corner of your excel window).

Think of a three ring bindefwith three sheets of paper in it. As with a binder, you can:

i. Insert worksheet: Click on the new worksheet tab to the right of the tabs for your existing

worksheets.

ii. Delete worksheets: By righrclicking on the tab of the worksheet you wish to delete, then

select "delete".

iii. Re-arrange them: By clicking on the worksheet tab and dtaggtttg it to the location you desire.

iv. Rename worksheets: By double-clicking on the worksheet title.

Cells are the basic rectangular building blocks of a spreadsheet. They are assigned an address,

generally referred to as a cell reference, according to their column and row (e.g., the cell in column B
at row 3 is referenced as cell B3).

Rows travel horizontallv and are numbered.

Apt.20O9 - 4M

Whatis Spreadsheet?
Explain usages of
Spreadsheet.



Columns travel vertically and are assigned letters.

A mathematical formula can be used to calculate a result based on data from one or more other cells.
Often they consist of some combination of the standard mathematical operators (+, -, *, /)
(e.g.: =(A1+A5)/B13), but they may also include functions. When you type a formula into a cell, that
cell will generally display the result obtained by the formula, rather than the formula itself.

Pre-written formulae perform common calculations, such as summation and averaging. You can
combine many functions and operators in a single formula to obtain more complex results
(e.g.: =SUM(A1:A13)).

3.1 The Excel 2OO7 window

As in Word 2007, the old menu system has been replaced by the Ribbon and the Office button. The
title bar displays the name of your current workbook. Tabs at the bottom of the screen identify the
different worksheets available to you.
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Notice how the working area of the screen is divided into rows (1, 2, 3, 4, ...) and columns

(A,8, C, D, ...). Together these provide an address, such a C10 or G21 that uniquely identifies each

cell in the worksheet.

A range of cells extends in a rectangle from one cell to another, and is referred to by using the first
and last cell addresses separated by a colon. For example, the group of cells from ,{3 to G4 would be

written as A3:G4.

In the example above, the current or active cell is 87. It is surrounded by a heavy black border, and

its address is displayed in the name box above column A. Its row and column numbers are also

highlighted.

On the right of the name box is the formula bar. This displays the value stored in the active cell, and

is also the place where you would enter a new data value or formula into that cell.

3.2 Overview of data types

Excel allows you to enter different sorts of data into the cells on a worksheet, such as dates, text, and

numbers. If you understand how Excel treats the different types of data, you'll be able to structure

your worksheet as efficiently as possible.

i. Numbers lie at the heart of Excel's functionality. They can be formatted in a variety of
different ways. You should generally avoid mixing text and numbers in a single cell, since

Excel will regard the cell contents as text, and won't include the embedded number in
calculations. If you type any spaces within a number, it will also be regarded as text.
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Dates and times are stored as numbers in Excel, so that you can calculate the difference

between two dates. However, they are usually displayed as if they are text. If a number is too

large to be displayed in the current cell, it will be displayed as "#####'.

Text consists mainly of alphabetic characters, but can also include numbers, punctuation

marks and special characters. Text fields are not included in numeric calculations. If you want

Excel to treat an apparent number as text, then you should precede the number with a single
quotation mark ('). This can be useful when entering, for example, a phone number that starts

with 0, since leading zeros are not usually displayed for Excel numbers.



Formulas are the most powerful elements of an Excel spreadsheet. Every formula starts with
an "=" sign, and contains at least one logical or mathemitical operation (o, special function),
combined with numbers and/or cell references.

3.3 Handling Gell and Gell Data

To enter either numbers or text:

i' Click on the cell where you want the data to be stored, so that the cell becomes active.
ii. Typb the number or text.

ii' Press [Enter] to move to the next row, or [Tab] to move to the next column. until you,ve
pressed [Enter] or [Tab], you can cancel the data entry by pressing [Esc]. To enter a date, use a
slash or hyphen between the day, month and year, for example l4l0zl200g. Use a colon
between hours, minutes and seconds, for exampl e t3r+S,ZO.

i. Select the cell or cells containing data to be deleted.

ii. Press the IDELI key on your keyboard.

iii. The cells remain in the same position as before, but their contents are deleted.

i. select the cells you want to move (they will become highlighted).

ii. Move the cursor to the border of the highlighted cells. When the cursor changes from a white
cross to a four-headed arrow (the move pointer), hold down the left mouse bution.

ii. Drag the selected cells to a new area of the worksheet, then release the mouse button. you can
also cut the selected data using the ribbon icon or [Ctrl] +- [X], then click in rhe top left cell of
the destination area and paste the data with the ribbon icon or [ctrl] + [v].

To copy the contents of one cell to a set of adjacent cells, select the initial cell and then move the
cursor over the small square in the bottom righrhand comer (thertU handle).The cursor will change
from a white cross to a black cross. Hold down the mouse button and drag to a range of adjacent
cells. The initial cell contents will be copied to the other cells.

Note that if the original cell contents end with a number, then the number will be incremented in the
copied cells.



i. Enter the start ofthe series into a few adjacent cells (enough to show the underlying pattern).

ii. Select the cells that contain series data.

iii. Move the cursor over the small square in the bottom righrhand corner of the selection (thefill
handle). Hold down the mouse button and drag to a range of adjacent cells.

iv. The target cells will be filled based on the pattern of the original series cells.

T'here are two different ways to enter edit mode: either double-click on the cell whose contents you
want to edit, or else click to select the cell you want to edit, and then click anywhere in the formula
bar.

You can insert a new cell above the current active cell, in which case the active cell and those below
it will each move down one row. You can also insert a new cell to the left of the current active cell,
in which case the active cell and those on its right will each move one column to the right.

To insert a cell:

i. Select the cell next to which you want to insert a new cell.

ii. On the Home ribbon, find the Cells group and click Insert followed by Insert Cells.
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To delete a cell, do as follows:

i. Select the cell that you want to delete.

ii. On the Home ribbon, find the Cells group and click Delete followed by Delete Cells.
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iii. A dialog box will open. Click the direction in which you want the surrounding cells to shift.

The icons on the Home ribbon provide you with a variety of formatting options. To apply any of
these, just select the cell or cells that you want to format, and then click the desired icon. Commonly
used formattine attributes include:
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Font and size

Bold, ltalic, Underline

Cell border

Background and Font Colour

Alignment: Left, Centre or Right

Merge text across multiple cells

Wrap text within a cell

Rotate angle of text

Format number as Currency, Percentage or Decimal

Increase or Decrease number of decimal places

Figure 8.38



The Format Painter allows you to copy formatting attributes from one cell to a range of cells.

i. Select the cell whose formatting attributes you want to copy.

ii. Click on the Format Painter icon.

iii. Select the cell or range of cells that you want to have the same formatting attributes.

The cell values will remain as before, but their format will change

3.4 Sorting

Sorting list is a common spreadsheet task that allows you to easily reorder your data. Excel's sort
feature is a quick and easy way to sort data in a spreadsheet. The options for sorting your data
include:

i. Sort in ascending order - Ato Z alphabetically or smallest to largest for number data.

ii. Sort in descending order - Zto A alphabetically or largest to smallest for number data.

iii. Custom sort - includes sorting by the cell background color or the font color ofthe data.

To Sort in Alphabetical Order

Select a cell in the column you want to sort.

Click the Sort and Filter command in the Editing group on the Home tab.

Select Sort A to Z. Now the information in the Category column is organized in alphabetical
order.

You can Sort in reverse alphabetical order by choosing Sort Z to A in the list.lv.

Figure 8.39



i. Select a cell in the column you want to sort (a column with numbers).

ii. Click the Sort and Filter command in the Editing group on the Home tab'

iii. Select From Smallest to Largest. Now the information is organized from the smallest to

largest amount.

iv. You can sort in reverse numerical order by choosing From Largest to Smallest in the list.

To Sort Multiple Levels

Click the Sort and Filter command in the Bditing group on the Home tab.

Select Custom Sort from the list to open the dialog box' OR Select the Data tab.

Locate the Sort and Filter group.

Click the Sort command to open the Custom Sort dialog box. From here, you can sort by one

item, or multiple items.

Figure 8.40

Click the drop-down arrow in the Column Sort by field, and choose one of the options.
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Figure 8.41
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i. choose what to sort on. In this example, we'll leave the default as value.
ii. Choose how to order the results. Leave it as A to Z so it is organized alphabetically.
iii. Click Add Level to add another item to sort by.
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Figure 8.42

iv. Select an option in the Column Then by field. In this example, we chose Unit Cost.
v. choose what to sort on. In this example, we'll leave the default as value.
vi. Choose how to order the results. Leave it as smallest to larsest.
vii. Click OK.

i,bqopylcvd lll *

The spreadsheet has been sorred. All the "",Lt#i:rtlt organized in alphabetical order, and within
each category, the unit cost is arranged from smallest to largest.

CitEgory

E Waatrho6q"4rc



3.5 Formula in Excel 2OO7

Formulas are the key to Excel's amazing power and versatility. By using a formula, you can find the
answer to virtually any calculation you can think of.

A formula always starts with an equals sign ("="). This lets Excel know that it's going to have to
work something out. In the body of the formula, you're going to tell Excel what you want it to
calculate. You can use all the standard math's operations, like addition and multiplication, and you
can include numbers, cell references, or built in functions.

For example, suppose you have a retail business. You buy stock at cost price, and add a25Vo markup
to calculate your selling price. VAT must be added to that at 147a. You give a 5Vo discount to long-
standing customers who pay their accounts promptly. Let's look at how formulas can make the
calculations simple for you:
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In column A, the Stock Item labels have just been typed in.

In column B, the Cost Price values have just been typed in.

In column C, a formula is used. Cell C2 contains "=82 * 25Vo". This works out 25Vo of the
value in cell 82 (cost price), and displays the result in cell C2 (markup).

ln column D, a formula is used. Cell D2 contains "=82 + C2". This adds the values in cells 82
(cost price) andCZ (markup), and displays the result in cell D2 (rerail price).

In column E, a formula is used. Cell E2 contains "=D2 * l4%a". This works out l4%o of the
value in cell D2 (retail price), and displays the result in cell E2 (VAT).

In column F, a formula is used. Cell F2 contains "=D2 + E2". This adds the values in cells D2
(retail price) and E2 (VAT), and displays the result in cell F2 (selling price).



vii. In column G. a formula is used. Cell G2 contains "=F2 * 957o". This works out 95Vo of the
value in cellF} (selling price), and displays the result in cell G2 (discounted price).

The great thing about using formulas in Excel, is that you can copy them just as you do values. So

once you've entered all the formulas in row 2 and checked that they are colrect, you just need to

i.

ii.

iii.

Select the cells in row 2 that contain your formulas (cells C2 to GZ).

Move the cursor over the fill handle in the bottom risht corner of the selected cells. It will
change shape to a black cross.

Hold down the mouse button and drag the selected cells over rows 3 to 5. The values in cells
C3 to G5 are automatically calculated for you.

3.6 Functions

Excel provides a wide range of built-in functions that can be included in your formulas to save you
the effort of having to specify detailed calculations step-by-step. Each function is referred to by a
specific name, which acts as a kind of shorthand for the underlying calculation. Because a function is

used inside a formula, you'll still need to start off with an equals sign to show Excel that a

calculation is required.

Using AutoSum

Because addition is the most frequently used Excel function, a shortcut has been provided to quickly
add a set of numbers:

Select the cell where you want the total to appear.

Click on the Sum button on the Home ribbon.

Check that the correct set of numbers has been selected (indicated by a dotted line). ff not,
then drag to select a different set of numbers.

Press [Enter] and the total will be calculated.

Basic functions

Some of the most commonly used functions include:

i. SUM0 to calculate the total of a set of numbers

ii. AVERAGE0 to calculate the average of a set of numbers

iii. MAXQ to calculate the riaximum value within a set of numbers



iv. MN$ to calculate the minimum value within a set of numbers

v. ROLIND0 to round a set a values to a specified number of decimal places

vi. TODAYQ to show the current date

vii. IF0 to calculate a result depending on one or more conditions

A function makes use of values or cell references, just like a simple formula does. The numbers or
cell references that it needs for its calculations are placed in brackets after the name of the function.
To give a simple illustration:

Several popular functions are available to you directly from the Home ribbon.

i. Select the cell where you want the result of the calculation to be displayed.

ii. Click the drop-down arrow next to the Sum button.

iii. Click on the function that you want.

iv. Confum the range of cells that the function should use in its calculation. (Excel will try to
guess this for you. ff you don't like what it shows inside the dotted line, then click and drag to
make your own selection.)

v. Press [Enter]. The result of the calculation will be shown in the active cell.

As an example, to calculate the average for the following set of tutorial results, you would:

i. Click on cell F3 to make it active.

ii. Click on the arrow next to the Sum button, and select Average.

iii. Press [Enter] to accept the range of cells that is suggested (83:83).
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=12+195+67-43 = SUM (12, 195, 67. -43)

=(B3+84+85+86)
= (83 + 84 + 85 + 86)/4 = AVERAHE (83:86)



ff you want to use a function that isn't directly available from the drop-down list, then you can clickon More Functions to open the Insert Function dialog box. Another way to open this dialog box is toclick the Insert Function icon on the immediate lefiof the formula bar. The Insert Function dialogbox displays a list of functions within a selected function catelory. If you select a function it willbriefly describe the purpose and structure of the function.
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button at the bottom of the window, you'll be taken to a second dialogue box
the function arguments (usually the range of cells that the function should
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some iunctions use more than one argument. For example, the RouND0 function needs to knownot only which cells to use, but also how many decimal places those cells should be rounded to. sothe expression = RoUND(GS:G8, 0) will round the values in cells G5 to Gg to the nearest wholenumber (i.e., no decimal places).
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The IFO function is getting a section all of its own, because for many people it,s not as intuitive tounderstand as the common maths and stats functions. The IFg funition checks for a specificcondition' If the condition is met, then one action is taken; if the condition is not met, then a different
action is taken.

For example, you may be reviewing a set of tutorial marks. If a student's average mark is below 50,then the cell value should be FAIL; so the condition you are checking is whethir or not the average
result is below 50. If this condition is not met (that is, the average result is 50 or more), then the cell
value should be PASS.

Let's see this in action:

The structure of an IFO function is: =IF (condition, result if true, result if false)

Using English to describe our example as an IF statement.' IF the average mark is less than

50, then display the word "FAIL", else display the wortl ,,PA,SS,,.

Now for a real worksheet example, look at the formula bar in the screenshot below:

The formula is so constructed because the average mark is stored in cell F4, we need to check
whether the value in F4 is less than 50. If it is, thenlhe active cell (G4) must display the word ,,Fail,,.
If the value in F4 is not less than 50, then the active cell must display the word ,.pass,,.

3.7 Querying in Excel 2OOT

Microsoft Query lets you link to data held in a database and extract a subset of the data to a sheet
Excel' By providing a value in a cell or picking one from a drop - down list, the matching data
automatically passed back from the database to Excel.
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Data can be imported from an Access (or other) database into Excel via the Import External Data

command. You can also import data stored in another Excel file.

i. Start up Excel to get a new spreadsheet

ii. Move to the Data tab on the Ribbon then click on [From Other Sources] in the Get External

Data group (you may have a [Get External Data] button on the far left then choose From Other

Sources)

iii. Select From Microsoft QuerY

Figure 8.48

iv. The Choose Data Source dialog box appears - select MS Access Database* then press <Enter>

for [OK].

Select the required.

The Query Wizard now starts up:

a. Select the required table and click on the + to display the fields - move across the fields

and include required fields then click on [Nex>].
b. Set up a filter - click on [Nex>].

vii. Set up any sorting required - click on [Nex>].

viii. Choose Return Data to Microsoft Office Excel to simply paste in the data - click on [Finish].

ix. Finally, state where you would like your imported data to appear - which cell on which sheet -

click on [OK] to finish.

The data appears in Excel as a table. Filters are automatically provided in the cells on the header

row; these also give you soning options.

vi.
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3.8 Graphs / Gharts

often it's much easier to understand data when it,s presentedgraphicaly, and Excer provides the perfect toors to do this caredgraphs or charts.
OctZO,it * zrtt.

What is Chart

charts are an important part to being able to create a visual for spreadsheet data. In order to create achart within Excel the data that. iJgoing to be used for it neids to be entereo alreaoy into thespreadsheet document' once the datals eritered, the cells trrut a.. going to be used for the chart need
[J.tl'fLt-",:f ii,lf:*Hortware 

knows what to include. Next, crick on the rnsert rab that is

Figure 8.49

You may choose the chart that is desired by clicking the category of the chart you will use. once thecategory is chosen the charls will appear as small graphics wiitrin a drop down menu.
To choose a particular chan just click on its^icon and it will be placed within the spreadsheet you areworking on' To move, the chart to a page of its own, ,"1."t th"'border of tt 

" 
ct art und Right click.This will bring up a drop down menu, 

"navigate 
ro rhe 

"pii""',rr" says Move chart. This will bringup a dialog box that says chart Location. Fiom here yd ;iil n"ed to select the circle nexr ro As ANew sheet and name the sheet that will hold your chart. The chart witt pop up larger in a separatesheet, but in the same workbook as your entered data.

It's very easy to create a basic chart in Excel:

t 
ff*":r'*rdata 

that you want to include in the chart (together with column headings if you

ii. Find the Cherts .rtAc^^' na +1.^ r-^^, -:r,rFind the charts category on the Insert ribbon, and select your preterred chart type.
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The chart appears in the current
new position.

lll.

Figure 8.50

window. Move the cursor over the Chart Area to drag it to a
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Figure 8.51

Hiilffi:lick 
on a chart, a chart Tools section appears on your Ribbon, with Design, Layout and

i' use the Design tab to quickly change the chart type, or to swap data rows and coiumns.
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Figure 8.52

ii. use the Layout tab to add a title, and to provide axis and data labels.
iii. Use the Format tab to add border and fill eff'ects.

Sometimes you may want to add graphics, for example a corporate logo, to a worksheet. ClipAft and
WordArt are available in Excel, along with a host of call-out shapes that you can use to label your
charts. You'll find them all on the Insert ribbon.

Figure 8.53
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4. MS-PowerPoint 2OO7

Microsoft PowerPoint is widely used for making professional quality
presentations in a variety of formats, including on screen computer
slide shows, black and white or color overheads, and 35mm slides.
You can also use it for speaker's notes and audience hand outs.

In addition, PowerPoint can be used as a drawing package for
preparing pictures, forms, posters and leaflets.

PowerPoint is a presentation graphics package that lets you create formatted presentations which can
be used in a number of ways. You can produce projects such as overheads for a team briefing, slides
for a business meeting or interactive on-screen presentations on your company's products.

It allows you to produce:

Animated Presentations shown on a monitor or overhead screen

Overhead Projector Transparencies

Paper Printouts of your slides

Notes for the Speaker

Handouts for the Audience

35 mm slides

4.1 Greating New Presentation

You can start a new presentation from a blank slide, a template, existing
outline.

To create a new presentation from a blank slide:

i. Click the Microsoft Office Button

ii. Click New

iii. Click Blank Presentation

presentations, or a Word



Figure 8.54

To create a new presentation from a template:

i. Click the Microsoft Office Button

ii. Click New

iii. Click Installed Templates or Browse through Microsoft Office Online Templates

iv. Click the template you choose
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To create a new presentation from an existing presentation:

l.

ii.

iii.

iv.

Click the Microsoft Office Button

Click New

Click New from Existing

Browse to and click the presentation

Figure 8.56
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To create a new presentation from a Word oufline:

i. click tlre slide where you would like the outrine to besin

ii. Click New Slide on the Home tab

iii. Ciick Slides from Oufline

iv. Browse and click the word Document that contains the outline

lN$*$W

filc Slidc fril. i*d Cont.nt

4.2 Add/Greate Slides

There are several choices when you want to add a
Duplicate Seiected Slide, or Reuse Slides.

To create a new slide from Office Thernes:

i. Select the slide immediately Before where you

ii. Click the New Slide butron on the Home tab

Figure 8.57

new slide to the presentation: Office Themes.

want the new slide
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1ll. Click the slide choice that fits your material
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Figure 8.58

To create a slide as a duplicate of a slide in the presentation:

i. Select the slide to duplicate

ii. Click the New Slide button on the Home tab

iii. Click Duplicate Selected Slides
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Figure 8.59

To create a new slide from anoth€r presentation:

i. Select the slide imrnecliately Before where you want the new slide

ii. Click the New Slide burron on the Flome tab

iii. Click Reuse Slides

iv. Click Browse

v. Click Browse File
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vi. Locate the slide show and click on the slide to import
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4,3 Inserting Picture

To add a picture:

i. Click the Insert Tab
ii. Click the Picture Button
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iii. Browse to the picture from your files

iv. Click the name of the picture

v. Click insert
vi. To move the graphic, click it and drag it to where you want it.
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4.4 Preparing Slide Shows with Animation

Presentations are greatly improved by adding animation. PowerPoint gives you a wide selection of
built-in animations, both when movins between one slide and the next and within each slide.

Instead of simply moving abruptly from one slide to another during a presentation, slide transitions
allow slides to dissolve into each other, using a variety of different special effects. These can make
your on-screen presentation look even better and more professional.
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Check you are in Normal view and that the first slide is selected.

Move to the Animations tab at the top to show the following ribbon:

Figure 8.62

Across the middle of the ribbon, you'll see certain transition effects. As you move over each
one, you'll see the transition effect on the slide. Just to the right ofthese is a vertical scroll bar
- use the up and down arrows on the scroll bar to chanqe the set of transition effects that are
showing.

iii. Choose one of the transition effects for the first slide.

iv. Set the Transition Speed of the transition effect to medium or slow to see the effect more
clearly.

v. Under Advance Slide, set the next slide to appear Automatically after a set number of seconds.

vi. Move to the next slide and repeat steps 3 to 5, choosing different effects.

vii. Finally save your presentation (press <Ctrl s>) then run it (<F5>) to see the effects.

PowerPoint allows information on yorr slides to appear one
from reading ahead of you, rnaking them concentrate on each

item at a time. This stops your audience
point individually. Try the following to

animate your bullet points:

i. Click on a slide with a bulleted list on it and
showing on the Ribbon.

ii' Click within the bullet point area on the slide and then click on the list arrow next to No
Animation inthe Animations group:

make sure that the Animations tab is still
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iv.

Figure 8.63

Only a few animation schemes are listed. Some bring in all the bullet points together, eg Fade
All At Once' whtle others bring them in one by one, e.g., Fade By lit Level Faragraphs. As
you move the mouse over the list, you are shown what each animation looks like oi the slitte.
Try setting up various animations for your slides.

From the list of animations choose one of them, e.g., FIy In By t st Level paragraphs.

Repeat steps 2 and 3 for another slide with bullet points, choosing a different animation.

Choose one of the slides with bullet points that you've already animated and click on the slide
title (or a picture if there's one on the slide).

On the righrhand side of your PowerPoint window , the Custom Animation Task pane should
be showing (this can always be displayed by clicking on rhe [Custom Animation] button in
the Animations group):



Figure 8.64

vi. Click on the [Add Effectl button followed by Entrance from the submerru and then S'{*l"r:

Effects...

vii. Choose an entrance effect (they range from Basic to Subtle to Moderate to Exciting!) then
click [Ok].

viii. Click the [Play] button to check that the changes you have made look coffect.

To change the animation order:

ix. Click on the object you want to change then use the [Re-Order] buttons to move it up or
down the list - click on [Play] again to check the animation is now correct.

x. Finally, save your presentation (press <Ctrl s>) then run it from the first slide (press <F5>).

xi. End by closing the Custom Animation Task Pnne.

5. MS-Access 2OO7
+o*o-\21 Access 2O07 is a program that allows you to create and manage

databases. A database is a place where you can store information
related to a specific topic. How you intend to use the information
will determine whether you need an Access database or a different
program to create and manage your data.
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A databasc allows you to store information related to a specific topic in an organized way. In
addition to storing data, you can also sort, extract, and summarize information related to the data.
one of the software programs that allow you to do this is Microsoft office Access 2007. which is a
databasc creation and management program.

5.1 Database Terms

) Table

A table is a collection of information arranged in rows and columns. Information about an item is
displayed in a row. Columns contain the same type of information for each item. The table has a
header row that tells you what data is contained in the columns.

Figure 8.65

'fo view data in a table:
i. Click the arrow to open the navigation pane

ii. Double-click on the table name to open the table
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Query

Queries select records from one or more tables in a database so they can be viewed, analyzed, and

sorted on a common datasheet. A query can also perform calculations and display the results. The
resulting collection of records, called a dynaset (short for dy4amic subset), is saved as a database
object and can therefore be easily used in the future. The query will be updated whenever the
original tables are updated. Types of queries are select queries that extract data from tables based on
specified values, find duplicate queries that display records with duplicate values for one or more of
the specified fields, and find unmatched queries display records from one table that do not have
corresponding values in a second table.

To run a query:

i. Click the arrow to open the navigation pane

ii. Double-click on the query name

Figure 8.67

A recordset is a table that displays groups of records from a base table or as a query result.



A form is a graphical interface that is used to display and edit data. Forms can be developed from a
table or a query. Forms can include calculations, graphics and objects.

To view data using a forrn:

i. Click the arrow to open the navigation pane

ii. Double-click on the form name
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Figure 8.68

A report is an output of data arranged in the order you specify. Reports can perform calculations and
display the results. Reports can be used to print data.

To view data using a form:

i. Click the arrow to open the navigation pane
ii. Double-click on the report name

Faculty by Department
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5.2 Greation and Manipulation of Files and Tables

You can create a new database from scratch or vou can create a database from the database wizard.

To create a new database from scratch:

i. Click the Microsoft Office Button
ii. Click New

iii. Click the New Blank Database icon
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Figure 8.70

iv. Type in a name for the database

v. Click Create
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Figure 8.71

To create a new database from the database templates:

i. Click the Microsoft Office Button

ii. Click New

iii. Choose the type of database you wish to create

Figure 8.72



iv. Type in the name for the database

v. Click Create
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Figure 8.73

There are two ways to view a table in Access to add data to the table: Design View and Datasheet View.

In Design View, you can view all the fields with the data types and descriptions. The records of
information that has been added to the database is not viewable.

Figure 8.74
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To go to Design View:

i. Click the down iurow on the View button

ii. Click Design View

Figure 8.75

In Datasheet View, you can display the records in a table, where
headers are the fields you have defined for the database.

Figure 8.76

one row is one record. The column



To go to Datasheet View:

i. Click the down zrrrow on the View button
ii. Click Datasheet View

Figure 8.77

There are many ways to enter new fields into a database. New fields can be added in the Datasheet
View or in the Design View.

There are two ways to add a new field in Datasheet View: Add A New Field or the New Field
Button.

To add a New Field within the Datasheet:

r Click the Add New Field column
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To add a new field by using the New Field Button

i. Click the Datasheet tab on the Ribbon

ii. Click the New Field Buton

iii. Choose the type of field you wish to add from the Field remplates window

Figure 8.79

To add a new field in Design View:

i. Click the Design View button

ii. Click on the next available field

iii. Type in the Name of the field
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Figure 8.80

There are many types a data that a field can be predefined to hold. When you create a new field in a
database you should closely match the data type to what will be entered into the field.

Editing Data Types in Fields

When creating tables, you should define the data types of the tables to rnost closely match the type of
data that will be entered in the field.

To edit the Data Type in Datasheet View:

i. Click the field you wish to define

ii. Click the Datasheet tab on the Ribbon

iii. Click the down arrow next to Data Type

iv. Choose the type of data that will be entered into the field



Figure 8.81

To edit the Data Type in the Design View:

Click Design View
Click the field name you wish to define or create a new field
Click the Data Type

Choose the appropriate Data Type
Format the field in the Field Properties Dialog box

Figure 8.82
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1. Write a note on MS-Access.

2. State any four features of MS-Word.

3. What are the different types of Menus available in
Windows? Explain any one.

4. Write a note on Power Point.

5. Explain elements of MS-Word in detail.

6. Explain different operations for MS-Word.

7. Explain features of MS-Windows.

8. What is Spreadsheet? Explain usages of Spreadsheet.

9. Explain different features of Editing Text in MS-Word.
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